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Preface

Profile

Prerequisites

• R11i Navigating Oracle Applications

How This Course Is Organized

This course is an instructor-led course featuring lecture and hands-on exercises.
Online demonstrations and written practice sessions reinforce the concepts and
skills introduced.
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Related Publications

Oracle Publications

Additional Publications

• System release bulletins

• Installation and user’s guides

• read.me files

• Oracle Magazine
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Typographic Conventions

Typographic Conventions in Text

Convention Element Example
Bold italic Glossary term (if

there is a glossary)
The algorithm inserts the new key.

Caps and
lowercase

Buttons,
check boxes,
triggers,
windows

Click the Executable button.
Select the Can’t Delete Card check box.
Assign a When-Validate-Item trigger to the
ORD block.
Open the Master Schedule window.

Courier new,
case sensitive
(default is
lowercase)

Code output,
directory names,
filenames,
passwords,
pathnames,
URLs,
user input,
usernames

Code output: debug.set (‘I”, 300);
Directory: bin (DOS), $FMHOME (UNIX)
Filename: Locate the init.ora file.
Password: User tiger as your password.
Pathname: Open c:\my_docs\projects
URL: Go to http://www.oracle.com
User input: Enter 300
Username: Log on as scott

Initial cap Graphics labels
(unless the term is a
proper noun)

Customer address (but Oracle Payables)

Italic Emphasized words
and phrases,
titles of books and
courses,
variables

Do not save changes to the database.
For further information, see Oracle7 Server
SQL Language Reference Manual.
Enter user_id@us.oracle.com,
where user_id is the name of the user.

Quotation
marks

Interface elements
with long names
that have only
initial caps;
lesson and chapter
titles in cross-
references

Select “Include a reusable module component”
and click Finish.

This subject is covered in Unit II, Lesson 3,
“Working with Objects.”

Uppercase SQL column
names, commands,
functions, schemas,
table names

Use the SELECT command to view
information stored in the LAST_NAME
column of the EMP table.

Convention Element Example
Arrow Menu paths Select File—> Save.
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Brackets Key names Press [Enter].

Commas Key sequences Press and release keys one at a time:
[Alternate], [F], [D]

Plus signs Key combinations Press and hold these keys simultaneously:
[Ctrl]+[Alt]+[Del]

Typographic Conventions in Code

Convention Element Example
Caps and
lowercase

Oracle Forms
triggers

When-Validate-Item

Lowercase Column names,
table names

SELECT last_name
FROM s_emp;

Passwords DROP USER scott
IDENTIFIED BY tiger;

PL/SQL objects OG_ACTIVATE_LAYER
(OG_GET_LAYER

(‘prod_pie_layer’))

Lowercase
italic

Syntax variables CREATE ROLE role

Uppercase SQL commands and
functions

SELECT userid
FROM emp;

Typographic Conventions in Navigation Paths

This course uses simplified navigation paths, such as the following example, to
direct you through Oracle Applications.

(N) Invoice > Entry > Invoice Batches Summary (M) Query > Find (B) Approve

This simplified path translates to the following:

1. (N) From the Navigator window, select Invoice > Entry > Invoice Batches
Summary.

2. (M) From the menu, select Query > Find.

3. (B) Click the Approve button.

Notations :

(N) = Navigator

(M) = Menu

(T) = Tab
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(I) = Icon

(H) = Hyperlink

(B) = Button

Typographical Conventions in Help System Paths

This course uses a “navigation path” convention to represent actions you perform
to find pertinent information in the Oracle Applications Help System.

The following help navigation path, for example—

(Help) General Ledger > Journals > Enter Journals

—represents the following sequence of actions:

1. In the navigation frame of the help system window, expand the General
Ledger entry.

2. Under the General Ledger entry, expand Journals.

3. Under Journals, select Enter Journals.

4. Review the Enter Journals topic that appears in the document frame of the
help system window.

Getting Help

Oracle Applications provides you with a complete online help facility.

Whenever you need assistance, simply choose an item from the Help menu to
pinpoint the type of information you want.

To display help for a current window:

1. Choose Window Help from the Help menu, click the Help button on the
toolbar, or hold down the Control key and type 'h'.

A web browser window appears, containing search and navigation frames on
the left, and a frame that displays help documents on the right.

The document frame provides information on the window containing the
cursor. The navigation frame displays the top-level topics for your
responsibility, arranged in a tree control.

2. If the document frame contains a list of topics associated with the window,
click on a topic of interest to display more detailed information.
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3. You can navigate to other topics of interest in the help system, or choose
Close from your web browser's File menu to close help.

Searching for Help

You can perform a search to find the Oracle Applications help information you
want. Simply enter your query in the text field located in the top-left frame of the
browser window when viewing help, then click the adjacent Find button.

A list of titles, ranked by relevance and linked to the documents in question, is
returned from your search in the right-hand document frame. Click on whichever
title seems to best answer your needs to display the complete document in this
frame. If the document doesn't fully answer your questions, use your browser's
Back button to return to the list of titles and try another.
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R11i Run Financial Reports with ADI
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R11i Run Financial Reports with ADIR11i Run Financial Reports with ADI

Applications Desktop Integrator, Release 7.0Applications Desktop Integrator, Release 7.0

Notations:
(N) = Navigator
(T) = Tab
(I) = Icon
(H) = Hyperlink
(B) = Button
(Help) = Oracle Applications Help System
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Online HelpOnline Help

You can use online Help  to assist you in Oracle
Application Desktop Integrator.
Use Help to:
• See an explanation of the toolbar icons
• See an explanation of each region of the Navigator
• See detailed information about each Oracle ADI

window

You can use online Help  to assist you in Oracle
Application Desktop Integrator.
Use Help to:
• See an explanation of the toolbar icons
• See an explanation of each region of the Navigator
• See detailed information about each Oracle ADI

window
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Using Online Help
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Using Online HelpUsing Online Help

To access Help paths in this course, start with
(Help) Oracle Financial Applications > Applications
Desktop Integrator.

To access Help paths in this course, start with
(Help) Oracle Financial Applications > Applications
Desktop Integrator.
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ObjectivesObjectives

After this module, you should be able
to:
• Identify the icons on the ADI toolbar
• Demonstrate customizing  the toolbar
• Explain the Tip Wizard
• List the report creation options
• Identify the functions of the Define Report toolbar
• Modify an existing report or report components
• Describe the different methods for creating or

modifying report components
• Use the Content Set Generator to create and

modify content sets

After this module, you should be able
to:
• Identify the icons on the ADI toolbar
• Demonstrate customizing  the toolbar
• Explain the Tip Wizard
• List the report creation options
• Identify the functions of the Define Report toolbar
• Modify an existing report or report components
• Describe the different methods for creating or

modifying report components
• Use the Content Set Generator to create and

modify content sets
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Agenda
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AgendaAgenda

• Getting Started with ADI
• Defining Financial Reports
• Getting Started with ADI
• Defining Financial Reports
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Signing On to ADI
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Signing On to ADISigning On to ADI

Use the ADI icon or the start menu to sign on to ADI
1. Start ADI directly from Microsoft Windows by

double-clicking the ADI icon or using the start
menu.

2. Click the sign-on button and select a database and
enter username and password.

3. Select a responsibility from the same list of
responsibilities that you use to access Oracle
Applications.

4. Click the OK button to sign on. Upon connection,
the toolbar will expand to include additional
buttons.

Use the ADI icon or the start menu to sign on to ADI
1. Start ADI directly from Microsoft Windows by

double-clicking the ADI icon or using the start
menu.

2. Click the sign-on button and select a database and
enter username and password.

3. Select a responsibility from the same list of
responsibilities that you use to access Oracle
Applications.

4. Click the OK button to sign on. Upon connection,
the toolbar will expand to include additional
buttons.

(Help) Oracle Financial Applications > Applications Desktop
Integrator > Getting Started with ADI > Signing On to ADI



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Run Financial Reports with Oracle Applications Desktop Integrator
Chapter 21 - Page 8

ADI Toolbar Icons
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ADI Toolbar IconsADI Toolbar Icons

ADI Toolbar Icon Descriptions
• Sign On: Enter your username, password, and

responsibility
• Change Responsibility: Select a different

responsibility after signing on to the database
• Ledger: Select from the Ledger options
• Assets: Select from the Assets options
• Applications: Select either Request Center, Oracle

Applications, or Microsoft Excel
• ADI Options: Define options for your toolbar,

worksheet colors, defaults, and settings

ADI Toolbar Icon Descriptions
• Sign On: Enter your username, password, and

responsibility
• Change Responsibility: Select a different

responsibility after signing on to the database
• Ledger: Select from the Ledger options
• Assets: Select from the Assets options
• Applications: Select either Request Center, Oracle

Applications, or Microsoft Excel
• ADI Options: Define options for your toolbar,

worksheet colors, defaults, and settings

(Help) Oracle Financial Applications > Applications Desktop
Integrator > Getting Started with ADI > ADI Toolbar
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ADI Toolbar Icons
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ADI Toolbar IconsADI Toolbar Icons

ADI Toolbar Icon Descriptions
• Tip Wizard: Enable Tip Wizard and select options
• Help: Access the online Help features of ADI
• Minimize: Minimize the toolbar
• Exit: Close and exit ADI

ADI Toolbar Icon Descriptions
• Tip Wizard: Enable Tip Wizard and select options
• Help: Access the online Help features of ADI
• Minimize: Minimize the toolbar
• Exit: Close and exit ADI
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The Ledger Poplist
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The Ledger PoplistThe Ledger Poplist

Ledger Options
• Enter Budgets: Create budget worksheets, refresh

values, or edit the budget criteria for the current
budget worksheet

• Enter Journals: Create a worksheet for entering
journals

• Define Report: Start the Define Report, which can
be used to define Financial Statement Generator
(FSG) reports, download existing report definition,
or create content sets

• Analyze Report: Start the Analyze Report, which
can be used to drill into and analyze the complete
range of accounts that support a particular
reported amount.

Ledger Options
• Enter Budgets: Create budget worksheets, refresh

values, or edit the budget criteria for the current
budget worksheet

• Enter Journals: Create a worksheet for entering
journals

• Define Report: Start the Define Report, which can
be used to define Financial Statement Generator
(FSG) reports, download existing report definition,
or create content sets

• Analyze Report: Start the Analyze Report, which
can be used to drill into and analyze the complete
range of accounts that support a particular
reported amount.

(Help) Oracle Financial Applications > Applications Desktop
Integrator > Getting Started with ADI > ADI Options > General Ledger
Options
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The Ledger Poplist
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The Ledger PoplistThe Ledger Poplist

Ledger Options
• View Account Hierarchy: View and create segment

values and hierarchies
• List of Values: Select from a list of valid values for

a particular item, such as currency or journal
category

Ledger Options
• View Account Hierarchy: View and create segment

values and hierarchies
• List of Values: Select from a list of valid values for

a particular item, such as currency or journal
category



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Run Financial Reports with Oracle Applications Desktop Integrator
Chapter 21 - Page 12

The Ledger Poplist
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The Ledger PoplistThe Ledger Poplist
Ledger Options
• Upload to Interface: Upload your budget values or

journal entries to the Oracle General Ledger interface
tables and start the Submit process

• Submit Process: Start the Budget Import, Journal
Import and Report Submission process

• Insert Budget Account: Insert a new account row into a
budget worksheet

• Apply Budget Rule: Use budget rules, such as Repeat
per Cell or Divide Evenly by Row, to update your
budgets

• Add Budget Note: Append notes to an entire budget, to
an account, or to individual amounts in a budget
worksheet

• Create Graph: View your budget balances in graph form

Ledger Options
• Upload to Interface: Upload your budget values or

journal entries to the Oracle General Ledger interface
tables and start the Submit process

• Submit Process: Start the Budget Import, Journal
Import and Report Submission process

• Insert Budget Account: Insert a new account row into a
budget worksheet

• Apply Budget Rule: Use budget rules, such as Repeat
per Cell or Divide Evenly by Row, to update your
budgets

• Add Budget Note: Append notes to an entire budget, to
an account, or to individual amounts in a budget
worksheet

• Create Graph: View your budget balances in graph form
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The Application Poplist
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The Application PoplistThe Application Poplist

Application Options
• Request Center: Submit and monitor requests,

publish reports
• Applications: Start Oracle Applications
• Excel: Start Microsoft Excel

Application Options
• Request Center: Submit and monitor requests,

publish reports
• Applications: Start Oracle Applications
• Excel: Start Microsoft Excel

(Help) Oracle Financial Applications > Applications Desktop
Integrator > Getting Started with ADI > ADI Toolbar
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The ADI Options Poplist
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The ADI Options PoplistThe ADI Options Poplist

Using the ADI Options Poplist
• From the ADI Options poplist, you can modify your

toolbar, set other options, and view information
about ADI. The options listed under the toolbar are
covered in the following pages.

Using the ADI Options Poplist
• From the ADI Options poplist, you can modify your

toolbar, set other options, and view information
about ADI. The options listed under the toolbar are
covered in the following pages.

(Help) Oracle Financial Applications > Applications Desktop
Integrator > Getting Started with ADI > ADI Options
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The ADI Options Poplist
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The ADI Options PoplistThe ADI Options Poplist

Using  the Toolbar Poplist
• Toolbar Options: You can use Toolbar Options to

add, delete, or arrange icons on the ADI toolbar.
• Switch Orientation: Selecting this option switches

your toolbar from horizontal to vertical display (or
vertical to horizontal).

• Reset Icons: Select this option to reset your
toolbar to the default ADI toolbar.

Using  the Toolbar Poplist
• Toolbar Options: You can use Toolbar Options to

add, delete, or arrange icons on the ADI toolbar.
• Switch Orientation: Selecting this option switches

your toolbar from horizontal to vertical display (or
vertical to horizontal).

• Reset Icons: Select this option to reset your
toolbar to the default ADI toolbar.
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ADI Key Equivalents
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ADI Key EquivalentsADI Key Equivalents

See the ADI User’s Guide for a list of key
equivalents that you can use instead of using the
toolbar. Make sure that the Enable Hot Keys check
box in the Settings tab of the General Option
window is selected.

See the ADI User’s Guide for a list of key
equivalents that you can use instead of using the
toolbar. Make sure that the Enable Hot Keys check
box in the Settings tab of the General Option
window is selected.

(Help) Oracle Financial Applications > Applications Desktop
Integrator > Getting Started with ADI > ADI Options > General Ledger
Options
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Customizing Your Toolbar
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Customizing Your ToolbarCustomizing Your Toolbar

You can add Icons to your toolbar to invoke
Programs and processes external to ADI. From the
Toolbar  Options window, select the Add Icons tab.
You must specify the following:
• Description: Name of the button that appears

when you place the cursor over the button on the
toolbar

• Command Line: Name of the program that you
want to launch when you select the button

• Working Directory: Pathname to the program that
is specified in the Command Line

You can add Icons to your toolbar to invoke
Programs and processes external to ADI. From the
Toolbar  Options window, select the Add Icons tab.
You must specify the following:
• Description: Name of the button that appears

when you place the cursor over the button on the
toolbar

• Command Line: Name of the program that you
want to launch when you select the button

• Working Directory: Pathname to the program that
is specified in the Command Line

(Help) Oracle Financial Applications > Applications Desktop
Integrator > Getting Started with ADI > ADI Options > Toolbar
Options
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Moving Icons
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Moving IconsMoving Icons

You can use the Move Icons tab to add and delete
icons from your toolbar. You can also group and
arrange icons on your toolbar.

•  + or – sign: Use these to see the contents of
poplists related to icons on the main toolbar. You
can move these icons to the main toolbar by using
the left and right arrows.

• Toolbar Icons: Is the list of icons as they appear
on the main ADI toolbar. If you select a poplist,
such as Ledger, you will have a drop-down list
instead of icons.

• Separator button: Use this to create groups of
icons. Use the up and down arrows to change the
order in which the icons appear on the toolbar.

You can use the Move Icons tab to add and delete
icons from your toolbar. You can also group and
arrange icons on your toolbar.

•  + or – sign: Use these to see the contents of
poplists related to icons on the main toolbar. You
can move these icons to the main toolbar by using
the left and right arrows.

• Toolbar Icons: Is the list of icons as they appear
on the main ADI toolbar. If you select a poplist,
such as Ledger, you will have a drop-down list
instead of icons.

• Separator button: Use this to create groups of
icons. Use the up and down arrows to change the
order in which the icons appear on the toolbar.
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Practice 1 OverviewPractice 1 Overview

This practice covers the following topics:
• Signing on to ADI
• Customizing your toolbar

This practice covers the following topics:
• Signing on to ADI
• Customizing your toolbar

Practice 1
Instructions

In this practice, you will sign on to Applications Desktop Integrator (ADI) and
customize your toolbar.

Step 1: Sign On to ADI
Sign on to ADI using the username, password, and database given to you by
your instructor. Make sure to select General Ledger, Vision Operations (USA)
responsibility.
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Practice 1 Overview
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Practice 1 OverviewPractice 1 Overview

This practice covers the following topics:
• Signing on to ADI
• Customizing your toolbar

This practice covers the following topics:
• Signing on to ADI
• Customizing your toolbar

Step 2: Customize Your Toolbar
1. Using the Toolbar Options icon in your toolbar, add the following icons

to your toolbar:
• Enter Budgets
• Enter Journals
• Define Report
• Analyze Report
• View Account Hierarchy
• List of Values
• Upload to Interface

2. Move these icons to the center of your toolbar and create separators before
Enter Budgets and after Upload to Interface.

• Remove the Assets icon from your toolbar
• When you are finished, click OK.
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Practice 1 Solution
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Practice 1 SolutionPractice 1 Solution

This practice covers the following topics:
• Signing on to ADI
• Customizing your toolbar

This practice covers the following topics:
• Signing on to ADI
• Customizing your toolbar

Practice 1 Solutions
Step 1: Sign On to ADI

1. Double-click the ADI icon on your desktop to start ADI.
2. Click the Sign on icon. The Signon window appears.
3. Select the database.
4. Enter the username and password given to you by the instructor.
5. Do not select Use Last Responsibility.
6. Click the green check mark (OK button) to sign on.
7. When the list of responsibilities appears, select General Ledger, Vision 

Operations (USA).
Step 2: Customize Your Toolbar
1. Click the Toolbar Options icon on the ADI toolbar.

Select Toolbar>Toolbar Options from the drop-down menu.
2. Click the Move Icons tab in the Toolbar Options window.
3. Place your cursor on the Ledger icon and click the plus sign (+) to see all

available icons.
4. Place your cursor on the Enter Budgets icon in the Available Icons region so

that it is highlighted. Click the right arrow in the center of the window to add
the icon to the Toolbar Icons region.

5. 5. Repeat step 4 for the Enter Journals, Define Report, Analyze Report, View
Account Hierarchy, List of Values, and Upload to Interface icons.
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6. Place your cursor on the Assets icon in the Toolbar Icons region. Click the left
arrow to remove it from the Toolbar Icons region.

7. Place your cursor on the Applications icon in the Toolbar Icons region. Click
the separator button (-) on the right side of the window to create a separator
following the Applications icon.

8. Place your cursor on the Enter Budgets icon. Click the up arrow and move the
icon between the separator that you just created and the Applications icon.

9. Repeat step 8 for the icons you added in step 5.
10. Place your cursor on the Applications icon in the Toolbar Icons region. Click

the separator button (-) on the right side of the window to create a separator
after this icon.

11. When you are finished, Click the OK button. ADI will build your new toolbar.
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Overview

 Define report with
ADI

Oracle
General LedgerSave report

Download existing 
report objects

 Use Request Center to
submit from database

Publish report to PC
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Overview
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OverviewOverview

• ADI Define Report is a graphical front-end
alternative used to define new Financial Statement
Generator (FSG) reports or create them from
existing report components. The same
terminology and logic is used for both Define
Report and Oracle General Ledger FSG.

• After defining your report components, you must
save them to Oracle General Ledger (GL) as FSG
report objects in order to publish reports.

• ADI Define Report is a graphical front-end
alternative used to define new Financial Statement
Generator (FSG) reports or create them from
existing report components. The same
terminology and logic is used for both Define
Report and Oracle General Ledger FSG.

• After defining your report components, you must
save them to Oracle General Ledger (GL) as FSG
report objects in order to publish reports.
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Overview
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OverviewOverview

• You can download existing FSG reports or report
components, modify them in Define Report, and
then save the modified definition back to the
database.

• When you are ready to publish your report, use the
Request Center to submit and publish your report.
You can choose to publish your report output as a
spreadsheet, Web (HTML), or text file. The Request
Center is discussed in the lesson on submitting
and publishing reports.

• You can download existing FSG reports or report
components, modify them in Define Report, and
then save the modified definition back to the
database.

• When you are ready to publish your report, use the
Request Center to submit and publish your report.
You can choose to publish your report output as a
spreadsheet, Web (HTML), or text file. The Request
Center is discussed in the lesson on submitting
and publishing reports.
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Define Report Features
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Define Report FeaturesDefine Report Features

• Provides a spreadsheet-based interface to the GL
financial reporting engine, FSG

• Includes a wizard-driven interface that decreases
the number of keystrokes required to define a
report

• Expands upon the familiar spreadsheet interface
by adding menu choices, including right mouse
button support to quickly invoke a special Define
Report menu

• Supports report definitions for all user levels;
which method you choose depends on how
comfortable you are with writing financial reports

• Provides a spreadsheet-based interface to the GL
financial reporting engine, FSG

• Includes a wizard-driven interface that decreases
the number of keystrokes required to define a
report

• Expands upon the familiar spreadsheet interface
by adding menu choices, including right mouse
button support to quickly invoke a special Define
Report menu

• Supports report definitions for all user levels;
which method you choose depends on how
comfortable you are with writing financial reports
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Define Report Features
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Define Report FeaturesDefine Report Features

• Includes a Report Navigator that gives you a clear
understanding of the structure of even the most
complex report

• Includes a new Content Set Generator that enables
you to easily create new content sets or modify
existing ones

• Includes a Report Navigator that gives you a clear
understanding of the structure of even the most
complex report

• Includes a new Content Set Generator that enables
you to easily create new content sets or modify
existing ones
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Integrating with Oracle GLIntegrating with Oracle GL

In Oracle GL, a report is made up of a row set and a column
set. A financial report is the intersection of a row set and
column set.
• Defining a Row Set: Generally, when you define a row

set you define the account assignments. You also
define the format of the rows, such as descriptions,
indentations, and lines. A row can be a descriptive row
or text only, composed of account assignments, or a
calculation.

• Defining a Column Set: Generally, when you define a
column set you define attributes of your report such as
the format mask, factor, balance type, and relative
period. You can define calculations, exceptions, and
control values (for budgets and currency). You must
also define column headings.

In Oracle GL, a report is made up of a row set and a column
set. A financial report is the intersection of a row set and
column set.
• Defining a Row Set: Generally, when you define a row

set you define the account assignments. You also
define the format of the rows, such as descriptions,
indentations, and lines. A row can be a descriptive row
or text only, composed of account assignments, or a
calculation.

• Defining a Column Set: Generally, when you define a
column set you define attributes of your report such as
the format mask, factor, balance type, and relative
period. You can define calculations, exceptions, and
control values (for budgets and currency). You must
also define column headings.

(Help) Oracle Financial Applications > Applications Desktop
Integrator > Getting Started with ADI >
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Creating ReportsCreating Reports

With Define Report, you can create three types of
reports:
• A new report for which you define the report

components
• A new report using existing FSG report objects
• An existing report already defined in Oracle

General Ledger

With Define Report, you can create three types of
reports:
• A new report for which you define the report

components
• A new report using existing FSG report objects
• An existing report already defined in Oracle

General Ledger

(Help) Oracle Financial Applications > Applications Desktop
Integrator > Report Wizard > Report Toolbar
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Define Report Toolbar IconsDefine Report Toolbar Icons

Define Report Toolbar Icon Descriptions
• Report Objects: Display all active report and

object properties, such as the Report, Row,
Column, Content, and Row Order properties

• Row Properties: Display the Row Properties
window, and display Row Account Assignments
and Row Calculations

• Column Properties: Display the Column Properties
window and display Account Assignments,
Calculations, and Exceptions for Columns

• Insert/Delete Row Object: Insert and delete a line
item (row) into your row set, or, for an existing line
item, insert account assignments

Define Report Toolbar Icon Descriptions
• Report Objects: Display all active report and

object properties, such as the Report, Row,
Column, Content, and Row Order properties

• Row Properties: Display the Row Properties
window, and display Row Account Assignments
and Row Calculations

• Column Properties: Display the Column Properties
window and display Account Assignments,
Calculations, and Exceptions for Columns

• Insert/Delete Row Object: Insert and delete a line
item (row) into your row set, or, for an existing line
item, insert account assignments
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Define Report Toolbar Icons
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Define Report Toolbar IconsDefine Report Toolbar Icons

Define Report Toolbar Icon Descriptions
• Insert/Delete Column Object: Insert and delete a

column or column heading row into your report
worksheet

• Move Column Left: Move a column to the left
• Move Column Right: Move a column to the right
• Save Report to Database: Save your report back to

Oracle General Ledger
• Refresh Report from Database: Restore your

report from the Oracle General Ledger database to
your currently open report worksheet

• Hide Tools: Close the Define Report toolbar

Define Report Toolbar Icon Descriptions
• Insert/Delete Column Object: Insert and delete a

column or column heading row into your report
worksheet

• Move Column Left: Move a column to the left
• Move Column Right: Move a column to the right
• Save Report to Database: Save your report back to

Oracle General Ledger
• Refresh Report from Database: Restore your

report from the Oracle General Ledger database to
your currently open report worksheet

• Hide Tools: Close the Define Report toolbar



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Run Financial Reports with Oracle Applications Desktop Integrator
Chapter 21 - Page 32

Report Indicator
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Report IndicatorReport Indicator

The report worksheet displays the following report
indicators:
• Collapse/Expand button (upper left) collapses and

button (upper right) expands all related vertical and
horizontal regions.

• Collapse/Expand button collapses or expands various
regions of the worksheet. The plus button changes to a
minus button to indicate that the region can be
collapsed.

• Number: This number indicates how many ranges of
accounts are entered for each row.

• Letter: The letter C indicates that there is a calculation.
The letter E indicates that there is an exception.

The report worksheet displays the following report
indicators:
• Collapse/Expand button (upper left) collapses and

button (upper right) expands all related vertical and
horizontal regions.

• Collapse/Expand button collapses or expands various
regions of the worksheet. The plus button changes to a
minus button to indicate that the region can be
collapsed.

• Number: This number indicates how many ranges of
accounts are entered for each row.

• Letter: The letter C indicates that there is a calculation.
The letter E indicates that there is an exception.

(Help) Oracle Financial Applications > Applications Desktop
Integrator > Report Wizard > Collapsible/Expandable Regions
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Creating a Report Using Existing Report
Objects

Creating a Report Using Existing Report
Objects

Creating a Report Using Existing Report Objects
• When you choose to create a new report with

existing objects, you must select a row set and
column set from the list. You can optionally select
a content set or row order. If you want to maintain
the integrity of any of the original components,
you can choose to make a copy.

• Note: You can set up security to force a user to
make a copy. You can also choose to make a copy
as a default.

Creating a Report Using Existing Report Objects
• When you choose to create a new report with

existing objects, you must select a row set and
column set from the list. You can optionally select
a content set or row order. If you want to maintain
the integrity of any of the original components,
you can choose to make a copy.

• Note: You can set up security to force a user to
make a copy. You can also choose to make a copy
as a default.

(Help) Oracle Financial Applications > Applications Desktop
Integrator > Report Wizard > Creating a Report Using Report Wizard
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Using Existing Report Objects to Create a Report
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Using Existing Report Objects to Create a
Report

Using Existing Report Objects to Create a
Report

• Select Define Report, then select Report
Components, then click Next.

• Select a row set and column set.
• (Optional) Select a content set or row order or

create new ones.
• (Optional) Copy existing components instead of

using the original.
• Enter a report name and create the report in a new

or current workbook and click finish to create the
report worksheet.

• Select Define Report, then select Report
Components, then click Next.

• Select a row set and column set.
• (Optional) Select a content set or row order or

create new ones.
• (Optional) Copy existing components instead of

using the original.
• Enter a report name and create the report in a new

or current workbook and click finish to create the
report worksheet.
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Open an Existing ReportOpen an Existing Report

How to Open an Existing Report from General Ledger
• Select Define Report then Load Existing Report

and the report to load
• (Optional) Make a copy of the existing report.
• Create the report in either a new or current

workbook.

How to Open an Existing Report from General Ledger
• Select Define Report then Load Existing Report

and the report to load
• (Optional) Make a copy of the existing report.
• Create the report in either a new or current

workbook.
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Practice 2 OverviewPractice 2 Overview

This practice covers the following topics:
• Downloading existing report objects
• Copying report objects

This practice covers the following topics:
• Downloading existing report objects
• Copying report objects

Instructions
In this practice, you will download existing report objects to create a new
report that will be used in another practice. You will match the Report toolbar
icons to descriptions.

Step 1: Use Existing Report Objects to Create a Report
1. Create a new report using the following components:

Row Set: Balance Sheet
Column Set: Consolidated B/S Column

2. Make sure to use a copy of each object instead of using the originals.
3. Name your report XX-Consolidated Balance Sheet, where XX = your 

unique identifier.
4. Open the report in a new Microsoft Excel worksheet.

Step 2: Use the Report Indicators
1. Choose to expand all vertical and horizontal regions.
2. Review the report definitions.
3. Choose to collapse all vertical and horizontal regions.

Step 3: Identify the Report Toolbar
Match each toolbar icon with a definition.
1 _____Save report to the database
2 _____Move a column to the left
3 _____Refresh the report from Oracle GL
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4 _____Display the properties for the row
5 _____Do not display the toolbar
6 _____Add or delete a column
7 _____Position a column to the right
8 _____Display the properties for the report
9 _____Add or delete a row
10 _____Display the column information

A BCDEFGHIJ
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Practice 2 SolutionPractice 2 Solution

This practice covers the following topics:
• Downloading existing report objects
• Copying report objects

This practice covers the following topics:
• Downloading existing report objects
• Copying report objects

Practice 2 Solutions
Step 1: Use Existing Report Objects to Create a Report

1. Click the Define Report icon on the toolbar.
2. Select Define Report.
3. Click the Next button to open the Report Wizard Step 2 window.
4. Select the Report Components Option.
5. Click the Next button to open the Report Wizard Step 3 window.
6. In the Row Set field, select Balance Sheet from the list.
7. Select the Make Copy check box next to the Row Set field.
8. In the Column Set field, select Consolidated B\S Column from the list.
9. Click the Make Copy? check box next to the Column Set field.
10. Click the Next button to open the Report Wizard Step 4 window.
11. In the Report Name field, enter XX-Consolidated Balance Sheet.
12. Click the Finish button to open your report in Microsoft Excel

Step 2: Use the Report Indicators
1. Click Button 2 to expand all vertical and horizontal regions.
2. Review the report.
3. Click Button 1 to collapse all vertical and horizontal regions.

Step 3: Identify the Report Toolbar
Match each toolbar icon with a definition.
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1 H___Save report to the database
2 F___Move a column to the left
3 I___ Refresh the report from Oracle GL
4 B___Display the properties for the row
5 J___ Do not display the toolbar
6 E___Add or delete a column
7 G___Position a column to the right
8 A___Display the properties for the report
9 D___Add or delete a row
10 C___Display the column information A BCDEFGHIJ
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Updating Report ObjectsUpdating Report Objects

After you have created a report worksheet, you have
options for either editing the existing definitions or
creating new ones.
• Microsoft Excel: You can type directly in a cell or

use the Report Wizard Menu.
• Row and Column Properties: You can use these

two windows to enter report information.
• Report Objects: You can use one window with

many tabs to enter report data. These windows are
very similar to the report definition windows in
Oracle GL.

After you have created a report worksheet, you have
options for either editing the existing definitions or
creating new ones.
• Microsoft Excel: You can type directly in a cell or

use the Report Wizard Menu.
• Row and Column Properties: You can use these

two windows to enter report information.
• Report Objects: You can use one window with

many tabs to enter report data. These windows are
very similar to the report definition windows in
Oracle GL.
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Using Microsoft Excel Menu Options
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Using Microsoft Excel Menu OptionsUsing Microsoft Excel Menu Options

Define Report adds a number of options to your
standard Microsoft Excel menu to give you another
way of accessing many of the Define Report features.
Microsoft Excel Menu Path and Description:
• Edit >Delete Report Object - Deletes the currently

selected report object, whether a line item, line
account assignment, column, or column heading
row

• View >Summary Report Layout: Changes the view
to summary layout

• View >Detail Report Layout: Changes the view to a
detail layout

Define Report adds a number of options to your
standard Microsoft Excel menu to give you another
way of accessing many of the Define Report features.
Microsoft Excel Menu Path and Description:
• Edit >Delete Report Object - Deletes the currently

selected report object, whether a line item, line
account assignment, column, or column heading
row

• View >Summary Report Layout: Changes the view
to summary layout

• View >Detail Report Layout: Changes the view to a
detail layout

(Help) Oracle Financial Applications > Applications Desktop
Integrator > Report Wizard > Excel-based Menu Options
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Using Microsoft Excel Menu Options
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Using Microsoft Excel Menu OptionsUsing Microsoft Excel Menu Options

• Insert >Insert Object: Inserts a new row, account
assignment, column, or column heading

• ReportWizard: Displays the toolbar, displays row
and column properties, inserts items, moves
columns, saves reports, and runs reports

• Insert >Insert Object: Inserts a new row, account
assignment, column, or column heading

• ReportWizard: Displays the toolbar, displays row
and column properties, inserts items, moves
columns, saves reports, and runs reports
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How to Use Row and Column PropertiesHow to Use Row and Column Properties

• Click the Row Properties or the Column Properties
icon to bring up the appropriate Row Properties or
Column Properties window.

• For rows, select Properties, Account Assignments,
or Calculations.

• For columns, select Properties, Account
Assignments, Calculations, or Exceptions.

• Make the necessary changes and  Apply to view
your changes.

• Click the Row Properties or the Column Properties
icon to bring up the appropriate Row Properties or
Column Properties window.

• For rows, select Properties, Account Assignments,
or Calculations.

• For columns, select Properties, Account
Assignments, Calculations, or Exceptions.

• Make the necessary changes and  Apply to view
your changes.

(Help) Oracle Financial Applications > Applications Desktop
Integrator > Report Wizard > Excel-based Menu Options
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Using the Report Objects WindowUsing the Report Objects Window

You can use the advanced features of Define Report
by using the Report Objects window. To access the
Report Objects window, click the Report Objects
icon.
The following table explains the five tabs on the
window:
• Report: Defines an FSG report, including the

report name, description, required components,
and optional components

• Row: Defines rows and row sets; can be used to
enter format, display, and advanced options; can
also be used for assigning accounts and creating
row calculations

You can use the advanced features of Define Report
by using the Report Objects window. To access the
Report Objects window, click the Report Objects
icon.
The following table explains the five tabs on the
window:
• Report: Defines an FSG report, including the

report name, description, required components,
and optional components

• Row: Defines rows and row sets; can be used to
enter format, display, and advanced options; can
also be used for assigning accounts and creating
row calculations
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Using the Report Objects Window
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Using the Report Objects WindowUsing the Report Objects Window

• Column: Defines columns and column sets, and
can be used to assign accounts, enter
calculations, and enter column exceptions for
columns

• Content: Defines a content set for your report
Note: You can also use the Content Set Generator.

• Row Order Defines a row order in your report

• Column: Defines columns and column sets, and
can be used to assign accounts, enter
calculations, and enter column exceptions for
columns

• Content: Defines a content set for your report
Note: You can also use the Content Set Generator.

• Row Order Defines a row order in your report
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How to Use the Report Navigator
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How to Use the Report NavigatorHow to Use the Report Navigator

The Report Navigator provides instant access to any
report object in the currently open report worksheet.
• Click the Display Report Navigator icon in the

Report Objects window and select the report and
expand or collapse to show the detail items.

• Select a detail item to immediately move to the
appropriate tab and item in the Report Object
properties window.

• (Optional) Click the Display Tip Window icon to
display context-sensitive tips for defining report
objects.

The Report Navigator provides instant access to any
report object in the currently open report worksheet.
• Click the Display Report Navigator icon in the

Report Objects window and select the report and
expand or collapse to show the detail items.

• Select a detail item to immediately move to the
appropriate tab and item in the Report Object
properties window.

• (Optional) Click the Display Tip Window icon to
display context-sensitive tips for defining report
objects.
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Practice 3 OverviewPractice 3 Overview

This practice cover the following topics:
• Using different data entry methods to change

properties
• Entering column headings
• Assigning accounts to line items

This practice cover the following topics:
• Using different data entry methods to change

properties
• Entering column headings
• Assigning accounts to line items

Practice 3 Instructions
In this practice, you will use different entry methods to change report
definition properties. Use the report from Practice 2.

Step 1: Make Changes by Typing Directly
1. Change the name of the report to Balance Sheet by typing directly into the

field.
2. Change the name of the line item ASSETS to COMPANY ASSETS.

Step 2: Change Account Assignments
1. Use the ReportWizard menu to display the detail layout of your report.
2. Find the account assignment for row 15, Cash and Short Term Investments.
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Practice 3 Overview
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Practice 3 OverviewPractice 3 Overview

This practice cover the following topics:
• Using different data entry methods to change

properties
• Entering column headings
• Assigning accounts to line items

This practice cover the following topics:
• Using different data entry methods to change

properties
• Entering column headings
• Assigning accounts to line items

3. Change the account assignment for department from 000-850 to 000-480.
4. Using the Row Properties icon, select Display Account Assignments.
5. Find row 20, Accounts Receivable - Net of Allowance and change the

account assignment for department from 000-850 to 000-480.
6. Using the Report Objects window, find row 25, Other Current Assets.
7. Change the account assignment for department from 000-850 to 000-480.

Step 3: Update Report Definitions
1. Using the Report Objects window, change the row set name to XX Balance

Sheet, where XX = your unique identifier.
2. Using the Report Objects window, change the column set name to XX

Consolidated B/S, where XX = your unique identifier.
3. Use the ReportWizard menu to display the summary layout of your report.
4. Using the Report toolbar, switch the order of the two columns.
5. Change the column headings by clicking the Build button.
6. In the first column heading, change the Title 1 field to This Year.
7. In the second column heading, change the Title 2 field to Last Year.
8. Create a new line item between rows 75 and 85 (TOTAL ASSETS and

LIABILITIES), using the ReportWizard menu in Microsoft Excel.
9. Number this row as 80 and leave the description blank.
Note: This is just an example of how to insert a row. Typically, you would use the
Skip Lines Before or Skip Lines After feature to insert blank rows.
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10. Do not close this report; you will use it later in another practice.
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Practice 3 SolutionPractice 3 Solution

This practice cover the following topics:
• Using different data entry methods to change

properties
• Entering column headings
• Assigning accounts to line items

This practice cover the following topics:
• Using different data entry methods to change

properties
• Entering column headings
• Assigning accounts to line items

Step 1: Make Changes by Typing Directly
1. Use the report you created in Practice 6-1.
2. Put your cursor in the field below Report Title.
3. Change the name of the report to Balance Sheet by typing directly into 

the field.
4. Put your cursor in the field ASSETS.
5. Change the name of the line item ASSETS to COMPANY ASSETS.

Step 2: Change Account Assignments
1. From the ReportWizard menu, select Display Detail Layout.
2. Find the account assignment for row 15, Cash and Short Term

Investments.
3. Change the account assignment for department from 000-850 to 000-480.
4. Using the Row Properties-Display Row Account Assignments window,

find row 20, Accounts Receivable - Net of Allowance.
5. Put your cursor in the Low Assignment field.
6. In the Select Account Segment Ranges window, change the account

assignment for department from 000-850 to 000-480.
7. Click the green check mark to close the Select Account Segment Ranges

and Row Account Assignments windows.
8. Click the Report Objects icon on the Reports toolbar.
9. Click the Row tab.
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10. Put your cursor in the Line field. Use the down arrow to find row 25,
Other Current Assets.

11. Click the Account Assignments window.
12. Change the account assignment for department from 000-850 to 000-480.
13. Click the green check mark to close the Select Account Segment Ranges

window.
Step 3: Update Report Definitions
1. Click the Row tab in the Report Objects window.
2. In the Row Set Name field, enter XX Balance Sheet, where XX = your unique

identifier.
3. Select the Column tab in the Report Objects window.
4. In the Column Set Name field, enter XX Consolidated B/S, where XX = your

unique identifier.
5. Click the green check mark to close the Report Objects window.
6. Using the ReportWizard menu, display the summary layout of your report.
7. Place your cursor in the first column, Balance as of &POI-13.
8. Click the Move Right icon on the Report toolbar to switch the order of the two

columns.
9. Click the Build button to reset the column headings.
10. In the first column heading, change the Title 1 field to This Year.
11. In the second column heading, change the Title 2 field to Last Year.
12. Place your cursor on Line 85, LIABILITIES.
13. From the ReportWizard menu, select Insert Object-Line Item.

Note: Do not use the Insert Row feature of Microsoft Excel.
14. Number this row as 80 and leave the description blank.
15. Do not close this report; you will use it later in another practice.
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Creating a New Report
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Creating a New ReportCreating a New Report

Creating a New Report
• When you want to create a new report, you must

select certain attributes, such as default number of
rows and column size. ADI will build your report
worksheet to your specifications. Regardless of
your choices in these windows, you can always
add, modify, or delete rows and columns.

• You can choose to create a trend report that sets
up your columns in ascending or descending
order of period.

• Hint: Before you define a new report, create a draft
of the report on paper.

Creating a New Report
• When you want to create a new report, you must

select certain attributes, such as default number of
rows and column size. ADI will build your report
worksheet to your specifications. Regardless of
your choices in these windows, you can always
add, modify, or delete rows and columns.

• You can choose to create a trend report that sets
up your columns in ascending or descending
order of period.

• Hint: Before you define a new report, create a draft
of the report on paper.

(Help) Oracle Financial Applications > Applications Desktop
Integrator > Report Wizard > Creating a Report Using Report Wizard
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How to Create a New Report
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How to Create a New ReportHow to Create a New Report

• Click the Define Report icon and select Blank
Report.

• Enter a report name, then enter values for each of
the fields Number of Rows, Number of Columns,
Default Column Width, Line Item Width.

• Select New Workbook or Current Workbook, then
select a default format mask and factor to use in
your report worksheet.

• Click the Define Report icon and select Blank
Report.

• Enter a report name, then enter values for each of
the fields Number of Rows, Number of Columns,
Default Column Width, Line Item Width.

• Select New Workbook or Current Workbook, then
select a default format mask and factor to use in
your report worksheet.
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How to Create a New Report
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How to Create a New ReportHow to Create a New Report

• (Optional) Select Yes to create a trend report.
• Select Actual, Budget, or Encumbrance as your

trend report’s balance type.
• Select Forward or Backward as the trend options

roll to create a report in which the columns
successively move forward or backward in time.

• Select Daily, Monthly, or Quarterly as the time
increment for the trend report.

• Use the Define Report tools to change the row and
column properties, enter column headings, assign
accounts, and create row and column calculations.

• (Optional) Select Yes to create a trend report.
• Select Actual, Budget, or Encumbrance as your

trend report’s balance type.
• Select Forward or Backward as the trend options

roll to create a report in which the columns
successively move forward or backward in time.

• Select Daily, Monthly, or Quarterly as the time
increment for the trend report.

• Use the Define Report tools to change the row and
column properties, enter column headings, assign
accounts, and create row and column calculations.
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This practice covers creating a trend report.This practice covers creating a trend report.

Instructions
Your supervisor has asked you to create a new trend report. The report should
display the actual balances for the current and previous three months. It should
also display six rows. Name your report XX Trend Report.
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This practice covers creating a trend report.This practice covers creating a trend report.

Practice 4 Solutions
1. Click the Define Report icon on the toolbar.
2. Select the Define Report option.
3. Click the Next button to open the Report Wizard Step 2 window.
4. Select the Blank Report option.
5. Click the Next button to open the Report Wizard Step 3 window.
6. In the Report Name field enter XX - Trend Report.
7. In the Number of Rows field, enter 6.
8. In the Number of Columns field, enter 4. Accept the remaining default 

values.
9. Click the Next button to open the Report Wizard Step 4 window.
10. Accept the default values for the Format and Factor fields, and select 

Yes to create a trend report.
11. Click the Next button to open the Report Wizard Step 5 window.
12. For the Balance Type, select Actual.
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Practice 4 Solution (Overview)Practice 4 Solution (Overview)

This practice covers creating a trend report.This practice covers creating a trend report.

Practice 4 Solutions
13. Select Backward as the trend option with the Monthly increment.
14. Click the Finish button to open your report.
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Saving and Submitting Reports
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Saving and Submitting ReportsSaving and Submitting Reports

After creating or modifying a report in Define Report,
you can save it directly to Oracle GL by using Define
Report, the Reports toolbar, or the Define Report
menu on the Microsoft Excel menu bar.
• If it is not already displayed, open the Reports

toolbar and select Save Report to Database.
• When the option window appears, click Yes to

save the report.

After creating or modifying a report in Define Report,
you can save it directly to Oracle GL by using Define
Report, the Reports toolbar, or the Define Report
menu on the Microsoft Excel menu bar.
• If it is not already displayed, open the Reports

toolbar and select Save Report to Database.
• When the option window appears, click Yes to

save the report.

(Help) Oracle Financial Applications > Applications Desktop
Integrator > Report Wizard > Saving a Report Using Report Wizard
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How to Submit ReportsHow to Submit Reports

• Select Submit Process >Report from the toolbar.
Your report will default in the Existing Report field.

• The Report Submission and Publishing window
appears and you can enter values for the
submission parameters, publishing options, and
report submission options.

• Submit your request, or Cancel to abort.

• Select Submit Process >Report from the toolbar.
Your report will default in the Existing Report field.

• The Report Submission and Publishing window
appears and you can enter values for the
submission parameters, publishing options, and
report submission options.

• Submit your request, or Cancel to abort.
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Practice 5 OverviewPractice 5 Overview

This practice covers the following topics:
• Creating a new report
• Defining a new row set
• Defining a new column set
• Saving your report
• Submitting your report

This practice covers the following topics:
• Creating a new report
• Defining a new row set
• Defining a new column set
• Saving your report
• Submitting your report

Practice 5 Instructions
In this practice, you will define a new financial report.

Step 1: Define a New Report
1. Define a blank report called XX Bud/Act/Var.
2. Change the number of rows to 4 and the number of columns to 4.

Accept the remaining default settings for the Step 3 and Step 4
windows. This is not a trend report.

Step 2: Define a Row Set
1. Using the Report Objects window, define a new row set called XX

RW Row Set.
Note: Using the Report Objects window is a suggestion. There is more
than one way to enter the report definition. You can use any of the
methods that you have learned in prior practices.
2. Change the report title to Gross Profit Summary.
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Practice 5 OverviewPractice 5 Overview

This practice covers the following topics:
• Creating a new report
• Defining a new row set
• Defining a new column set
• Saving your report
• Submitting your report

This practice covers the following topics:
• Creating a new report
• Defining a new row set
• Defining a new column set
• Saving your report
• Submitting your report

3. Enter the following values for each line:

LINE LINE INDENT SKIP ROW CHANGE CHANGE SIGN
ITEM AFTER NAME SIGN ON VARIANCE

10 CC- 1 Label      N N
410-
430

20 Revenue       5 1 Revenue       Y   Y
Accounts

30 Expenses      5 1 Expense       N N
Accounts

40 Gross Profit  Gross      Y Y
Profit
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Practice 5 OverviewPractice 5 Overview

This practice covers the following topics:
• Creating a new report
• Defining a new row set
• Defining a new column set
• Saving your report
• Submitting your report

This practice covers the following topics:
• Creating a new report
• Defining a new row set
• Defining a new column set
• Saving your report
• Submitting your report

SEQUENCE ACCOUNT ASSIGNMENT DISPLAY TYPE
20 + 400.4150 to 400.4150 T for all segments

Note: Do not enter the Company,
Sub-account or Product segments.

30 + 400.5800 to 400.5800  T for all segments 
Note: Do not enter the Company,
Sub-account or Product segments.

4.  On line 40, in the Underline Character Before field, type an underscore 
(_). In the Underline Character After field, type an equal sign (=).

Step 3: Enter Calculations
Define a calculation for row 40 to add ranges 10 through 39.
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Practice 5 OverviewPractice 5 Overview

This practice covers the following topics:
• Creating a new report
• Defining a new row set
• Defining a new column set
• Saving your report
• Submitting your report

This practice covers the following topics:
• Creating a new report
• Defining a new row set
• Defining a new column set
• Saving your report
• Submitting your report

Step 4: Define a Column Set
1. Create a new column set called XX RW Column Set.
2. Add the following columns using the values shown:

SEQUENCE NAME AMOUNT TYPE CONTROL
VALUE

10 PTD Actuals PTD Actuals
20 PTD Budget PTD Budget 1
30 PTD Variance PTD Variance 1
40 PTD Variance% PTD Variance% 1
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Practice 5 OverviewPractice 5 Overview

This practice covers the following topics:
• Creating a new report
• Defining a new row set
• Defining a new column set
• Saving your report
• Submitting your report

This practice covers the following topics:
• Creating a new report
• Defining a new row set
• Defining a new column set
• Saving your report
• Submitting your report

Step 5: Associate Control Values
1. Click the Report tab and associate your control value to 1999 BUDGET.
2. Close the Report Objects window when done.
3. Collapse all expanded rows and columns in your worksheet.
4. Create default column headings by clicking the Build button. Edit your 

column headings as desired.
Step 6: Save and Submit

1. Save your report worksheet by clicking the Save Report to Database 
icon on the Report toolbar.

2. Click on the Ledger icon on the ADI toolbar.
3. Select Submit Process >Report.
4. Click the Publishing button and select Spreadsheet as the output type. 

Select Current Workbook as the spreadsheet option. Accept all other 
defaults.
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Practice 5 OverviewPractice 5 Overview

This practice covers the following topics:
• Creating a new report
• Defining a new row set
• Defining a new column set
• Saving your report
• Submitting your report

This practice covers the following topics:
• Creating a new report
• Defining a new row set
• Defining a new column set
• Saving your report
• Submitting your report

5. Submit the report and wait for your report to complete. When the 
Request Center window appears, click Yes to publish your report.

Step 7: Save Other Reports
1. After you have viewed your report, find the report you created in 

Practice 3 XX Consolidated Balance Sheet.
2. Save this report to the database. You will use this report in the next 

lesson.
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Practice 5 SolutionPractice 5 Solution

This practice covers the following topics:
• Creating a new report
• Defining a new row set
• Defining a new column set
• Saving your report
• Submitting your report

This practice covers the following topics:
• Creating a new report
• Defining a new row set
• Defining a new column set
• Saving your report
• Submitting your report

Practice 5 Solutions
Step 1: Define a New Report

1. Click the Define Report icon on the ADI toolbar.
2. Select the Define Report option, then click the Next button.
3. Select Blank Report, then click Next.
4. Name your report XX Bud/Act/Var.
5. Change the number of rows to 4 and the number of columns to 4. Accept 

the remaining default settings and click Next.
6. From the Step 4 window, accept all default settings for the Format and 

Factor. This is not a trend report. Click Finish.
Step 2: Define a Row Set

1. Select Report Objects from the Reports toolbar.
2. Click the Row tab in the Report Objects window.
3. Highlight the default row set name and change it to XX RW Row Set.
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Practice 5 SolutionPractice 5 Solution

This practice covers the following topics:
• Creating a new report
• Defining a new row set
• Defining a new column set
• Saving your report
• Submitting your report

This practice covers the following topics:
• Creating a new report
• Defining a new row set
• Defining a new column set
• Saving your report
• Submitting your report

4. Highlight the default report title name and change it to Gross Profit 
Summary.

5. Change the Line Item field for line 10 to CC 410 - 430.
6. To skip one line after this row, enter 1 in the Lines to Skip After field.
7.  In the Row Name field, enter Label.
8. Place your cursor in the Line field and press the down arrow key to enter 

line 20.
9. Change line item 20 to the values shown in the following table:

SEQUENCE NAME AMOUNT TYPE CONTROL VALUE
30 PTD Variance  PTD Variance 1
40 PTD variance %  PTD variance % 1
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Practice 5 SolutionPractice 5 Solution

This practice covers the following topics:
• Creating a new report
• Defining a new row set
• Defining a new column set
• Saving your report
• Submitting your report

This practice covers the following topics:
• Creating a new report
• Defining a new row set
• Defining a new column set
• Saving your report
• Submitting your report

LINE LINE INDENT SKIP ROW CHANGE CHANGE SIGN
ITEM AFTER NAME SIGN ON VARIANCE

10 CC- 1 Label      N N
410-
430

20 Revenue       5 1 Revenue       Y   Y
Accounts

30 Expenses      5 1 Expense       N N
Accounts

40 Gross Profit  Gross      Y Y
Profit
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Practice 5 SolutionPractice 5 Solution

This practice covers the following topics:
• Creating a new report
• Defining a new row set
• Defining a new column set
• Saving your report
• Submitting your report

This practice covers the following topics:
• Creating a new report
• Defining a new row set
• Defining a new column set
• Saving your report
• Submitting your report

10. Click the Account Assignments button to open the Row Account
Assignments window.

11. Put your cursor in the Segment Low field.
12. Enter the values shown on the table above.
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Practice 5 SolutionPractice 5 Solution

This practice covers the following topics:
• Creating a new report
• Defining a new row set
• Defining a new column set
• Saving your report
• Submitting your report

This practice covers the following topics:
• Creating a new report
• Defining a new row set
• Defining a new column set
• Saving your report
• Submitting your report

13. Click the green check mark to close the windows.
14. After you enter the account assignments, if the hourglass continues to be

displayed, click the Report toolbar to display the Report Objects window.
15. Place your cursor in the Line field and press the down arrow key to enter 

line 30.
16. Change line item 30 to the following values, including the following account

assignments.

LINE ACCOUNT ASSIGNMENT DISPLAY TYPE
20 + 400.4150 to 400.4150 T for all segments

Note: Do not enter the Company,
Sub-account or Product segments.

30 + 400.5800 to 400.5800 T for all segments
Note: Do not enter the Company,
Sub-account or Product segments.



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Run Financial Reports with Oracle Applications Desktop Integrator
Chapter 21 - Page 71

Practice 5 Solution

Copyright © Oracle Corporation, 2001. All rights reserved.
®

Practice 5 SolutionPractice 5 Solution

This practice covers the following topics:
• Creating a new report
• Defining a new row set
• Defining a new column set
• Saving your report
• Submitting your report

This practice covers the following topics:
• Creating a new report
• Defining a new row set
• Defining a new column set
• Saving your report
• Submitting your report

17. Click the green check mark to close the Select Account Segment Ranges and
Row Account Assignments window.

18. Place your cursor in the Line field and press the down arrow key to enter line
40.

19. Change the line item to Gross Profit.
20. In the Underline Character Before field, type an underscore (_)In the

Underline Character After field, type an equal sign (=).
21. Name the row Gross Profit.
22. Set Change Sign and Change Sign on Variance to Yes.
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Practice 5 SolutionPractice 5 Solution

This practice covers the following topics:
• Creating a new report
• Defining a new row set
• Defining a new column set
• Saving your report
• Submitting your report

This practice covers the following topics:
• Creating a new report
• Defining a new row set
• Defining a new column set
• Saving your report
• Submitting your report

Step 3: Enter Calculations
1. Define a calculation for this row (line 40) by clicking the Calculations 

button.
2. Enter 10 for the sequence number.
3. Accept the default (+) operator and tab to the Low field.
4. Enter 10 for the low range row and 39 for the high range row. This 

indicates which rows to add up when calculating amounts for the row. 
Defining your calculation this way enables you to insert rows in the 
future without having to redefine your calculation. When finished, click 
the green check mark to close the Row Calculations window.

Step 4: Define a Column Set
1. Click the Column tab and name your column set XX RW Column Set.
2. Name the first column (Sequence 10) PTD Actuals and select PTD-

Actual as the amount type.
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Practice 5 SolutionPractice 5 Solution

This practice covers the following topics:
• Creating a new report
• Defining a new row set
• Defining a new column set
• Saving your report
• Submitting your report

This practice covers the following topics:
• Creating a new report
• Defining a new row set
• Defining a new column set
• Saving your report
• Submitting your report

3. Place your cursor in the Sequence field and press the down arrow key to 
enter column 20.

4. Name the second column PTD Budget.
5. In the Amount Type field, select PTD-Budget.
6. In the Control Value field, enter 1.
7. Repeat step 3 for the next two columns, using the following values:

SEQUENCE NAME AMOUNT TYPE CONTROL VALUE
30 PTD Variance  PTD Variance 1
40 PTD variance %  PTD variance % 1
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Practice 5 SolutionPractice 5 Solution

This practice covers the following topics:
• Creating a new report
• Defining a new row set
• Defining a new column set
• Saving your report
• Submitting your report

This practice covers the following topics:
• Creating a new report
• Defining a new row set
• Defining a new column set
• Saving your report
• Submitting your report

Step 5: Associate Control Values
1. Click the Report tab and associate your control value to 1999 BUDGET.
2. Close the Report Objects window by clicking the green check mark.
3. Collapse all expanded rows and columns in your worksheet by clicking 

the small number 1 in the upper left corner of your worksheet for each 
axis.

4. Create default column headings by clicking the Build button. Click Yes 
when the message window appears asking if you want to continue with 
Build. Edit your column headings as desired.

Step 6: Save and Submit
1. Save your report worksheet by clicking the Save Report to Database 

icon on the Reports toolbar.
2. When the decision window appears, click Yes to save your report.
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Practice 5 SolutionPractice 5 Solution

This practice covers the following topics:
• Creating a new report
• Defining a new row set
• Defining a new column set
• Saving your report
• Submitting your report

This practice covers the following topics:
• Creating a new report
• Defining a new row set
• Defining a new column set
• Saving your report
• Submitting your report

Column Headings
3. Click the Ledger icon on the ADI toolbar. Select Submit Process 

>Report to submit your report. Your report will default into the Report 
Submission and Publishing window.

4. Click the Publishing button and select Spreadsheet as the output type. 
Select Current Workbook as the spreadsheet option.

5. Click the green check mark to submit the report. When the Request 
Center window appears, click the OK button.

6. When the Request Center decision window appears, click Yes to publish 
your report.
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Practice 5 SolutionPractice 5 Solution

This practice covers the following topics:
• Creating a new report
• Defining a new row set
• Defining a new column set
• Saving your report
• Submitting your report

This practice covers the following topics:
• Creating a new report
• Defining a new row set
• Defining a new column set
• Saving your report
• Submitting your report

Step 7: Save Other Reports
1. Find the report that you created in Practice 6-2, XX Consolidated 

Balance Sheet.
2. Save this report to the database by clicking the Save Report to Database 

icon on the Reports toolbar.
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Using Content Set GeneratorUsing Content Set Generator

• About Content Set Generator
• You can use the graphical Content Set Generator

to create or modify content sets.
• The Content Set Generator automatically creates

complex content sets for advanced hierarchical
reporting.

• You can quickly create point-in-time snapshots of
any hierarchy.

• Over time, you can build up a collection of these
date-effective hierarchies, which are encapsulated
as content sets, and submit them at report run
time.

• About Content Set Generator
• You can use the graphical Content Set Generator

to create or modify content sets.
• The Content Set Generator automatically creates

complex content sets for advanced hierarchical
reporting.

• You can quickly create point-in-time snapshots of
any hierarchy.

• Over time, you can build up a collection of these
date-effective hierarchies, which are encapsulated
as content sets, and submit them at report run
time.

(Help) Oracle Financial Applications > Applications Desktop
Integrator > Report Wizard > Generating Content Sets
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How to Create a Content SetHow to Create a Content Set

• Click the Define Report icon from the ADI toolbar
and select Generate Content Set.

• Enter a name for the content set or select an
existing content set from the list of values.

• Enter your Content Set Generator primary options,
then enter secondary options.

• Click the Define Report icon from the ADI toolbar
and select Generate Content Set.

• Enter a name for the content set or select an
existing content set from the list of values.

• Enter your Content Set Generator primary options,
then enter secondary options.
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How to Create a Content SetHow to Create a Content Set

• When the Generate Content Set window opens,
you can either create a new content set or edit an
existing one.

• You must choose the segment of your accounting
flexfield for which you want to create the content
set.

• Examples might be company, department, or
account. You must also select a parent value.
When you are ready, click the Next button.

• When the Generate Content Set window opens,
you can either create a new content set or edit an
existing one.

• You must choose the segment of your accounting
flexfield for which you want to create the content
set.

• Examples might be company, department, or
account. You must also select a parent value.
When you are ready, click the Next button.
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How to Create a Content SetHow to Create a Content Set

• For each hierarchy you add to a content set
definition, select the hierarchy attributes that
control how the hierarchy is expanded. You must
choose the Primary Options, Include, Sort By,
Display Type, Run Reports and In Parallel

• For each hierarchy you add to a content set
definition, select the hierarchy attributes that
control how the hierarchy is expanded. You must
choose the Primary Options, Include, Sort By,
Display Type, Run Reports and In Parallel
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Content Set Secondary OptionsContent Set Secondary Options

• Secondary options apply additional filtering to
your primary options.

• You can set different display types for each
segment of the account range that you specify,
including, Low, High, Display, Filter Balances,
Detail Only and Summary Only.

• Secondary options apply additional filtering to
your primary options.

• You can set different display types for each
segment of the account range that you specify,
including, Low, High, Display, Filter Balances,
Detail Only and Summary Only.
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Practice 6 OverviewPractice 6 Overview

This practice covers the following topics:
• Creating a content set to expand rows
• Viewing the hierarchy
• Applying the content set to an existing report
• Defining another content set to expand reports

This practice covers the following topics:
• Creating a content set to expand rows
• Viewing the hierarchy
• Applying the content set to an existing report
• Defining another content set to expand reports

Practice 6 Instructions
In this practice, you will create two content sets: one to expand rows within
a report and one to create separate reports by department. You will export
the hierarchy to a file and view the hierarchy.

Step 1: Create a Content Set
1. Using the Content Set Generator, create a new content set called XX

Content Set.
2. Enter the following primary options:

SEGMENT PARENT INCLUDE SORT BY     DISPLAY         RUN 
VALUE       TYPE REPORTS

Department 400 Parents Branch          Row Expand Sequentially
Children

3. Select Export in the Report Wizard - Step 5 Generate Content Set window.
4. Click Yes to create a tab-delimited file.
5. Make a note of the name and location of the file:______________________.
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Practice 6 OverviewPractice 6 Overview

This practice covers the following topics:
• Creating a content set to expand rows
• Viewing the hierarchy
• Applying the content set to an existing report
• Defining another content set to expand reports

This practice covers the following topics:
• Creating a content set to expand rows
• Viewing the hierarchy
• Applying the content set to an existing report
• Defining another content set to expand reports

6. Finish the content set.
Step 2: View the Hierarchy in a File Using Windows Explorer, find,
open, and view the file.
Step 3: Apply the Content Set to a Report

1. Using the Report Objects window, apply the content set to your report 
called XX Bud/Act/Var.

2. Use the Content tab to view the details of the content set for this report.
Step 4: Save the Report

Save your report to the database.
Step 5: Create Another Content Set

1. Using the Content Set Generator, create another content set called XX 
Web Content Set.
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Practice 6 OverviewPractice 6 Overview

This practice covers the following topics:
• Creating a content set to expand rows
• Viewing the hierarchy
• Applying the content set to an existing report
• Defining another content set to expand reports

This practice covers the following topics:
• Creating a content set to expand rows
• Viewing the hierarchy
• Applying the content set to an existing report
• Defining another content set to expand reports

2. Use the Content tab to view the details of the content set for this report.
Step 4: Save the Report

Save your report to the database.
Step 5: Create Another Content Set

1. Using the Content Set Generator, create another content set called XX 
Web Content Set.

2. Enter the following primary options:

SEGMENT PARENT INCLUDE SORT BY     DISPLAY         RUN REPORTS
VALUE       TYPE REPORTS

Department 400 Parents Branch          Report Sequentially
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Practice 6 OverviewPractice 6 Overview

This practice covers the following topics:
• Creating a content set to expand rows
• Viewing the hierarchy
• Applying the content set to an existing report
• Defining another content set to expand reports

This practice covers the following topics:
• Creating a content set to expand rows
• Viewing the hierarchy
• Applying the content set to an existing report
• Defining another content set to expand reports
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Practice 6 SolutionPractice 6 Solution

This practice covers the following topics:
• Creating a content set to expand rows
• Viewing the hierarchy
• Applying the content set to an existing report
• Defining another content set to expand reports

This practice covers the following topics:
• Creating a content set to expand rows
• Viewing the hierarchy
• Applying the content set to an existing report
• Defining another content set to expand reports

Practice 6-5 Solutions
Step 1: Create a Content Set

1. Click the Define Report icon on the ADI toolbar.
2. Select Generate Content Set, then click Next.
3. In the Name field, enter XX Content Set and enter the primary options.
4. Click the Next button to go to the next window.
5. The following Step 5 window should appear:
6. Click Export.
7. Click Yes to create a tab-delimited file.
8. Make a note of the name and location of the 

file:______________________.
9. Finish the content set.



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Run Financial Reports with Oracle Applications Desktop Integrator
Chapter 21 - Page 87

Practice 6 Solution

Copyright © Oracle Corporation, 2001. All rights reserved.
®

Practice 6 SolutionPractice 6 Solution

This practice covers the following topics:
• Creating a content set to expand rows
• Viewing the hierarchy
• Applying the content set to an existing report
• Defining another content set to expand reports

This practice covers the following topics:
• Creating a content set to expand rows
• Viewing the hierarchy
• Applying the content set to an existing report
• Defining another content set to expand reports

Step 2: View the Hierarchy in a File
1. Open Windows Explorer.
2. Find the file using the location that you noted in the prior step.
3. Open and view the file.

Step 3: Apply the Content Set to a Report
1. Find the worksheet with the report that you created in Practice 5
2.  Click the Report Objects icon. The Report Objects window appears 

with the Report tab displayed.
3. Your report XX Bud/Act/Var should appear in the Name field.
4. In the Optional Components region, click inside the Content Set field. 

The Find window appears. Enter your XX as the reduction criteria to 
find your content set.
Click OK to close the window.
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Practice 6 SolutionPractice 6 Solution

This practice covers the following topics:
• Creating a content set to expand rows
• Viewing the hierarchy
• Applying the content set to an existing report
• Defining another content set to expand reports

This practice covers the following topics:
• Creating a content set to expand rows
• Viewing the hierarchy
• Applying the content set to an existing report
• Defining another content set to expand reports

5. Click the Content tab to view the details.
6. Click the green check mark to close the Report Objects window.

Step 4: Save the Report
1. Save your report by clicking the Save Report to Database icon on the 

Report toolbar.
2. When the decision window appears, click Yes.

Step 5: Create Another Content Set
1. Click the Define Report icon on the ADI toolbar.
2. Select Generate Content Set, then click Next.
3. In the Name field, enter XX Web Content Set and enter the primary 

options.
4. Click the Next button to go to the next window.
5. Click Finish in the next window, then Finish again to complete the content

set.
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Setting Up Define ReportSetting Up Define Report

You can set the following defaults when setting up
Report Definition in the Ledger Options window.
• Defaults: Set the formatting options for rows,

columns, column width, line item width, format,
and factor.

• Indicator: Specify which colors to use to display
Account Assignments, Calculations, and
Exceptions report indicators on your report
worksheet.

• Copy Options include Make Copy Default,
Enforcement Level and Prompt.
Note: These options are overriden if the ADI
security-related profile options are defined in GL.

You can set the following defaults when setting up
Report Definition in the Ledger Options window.
• Defaults: Set the formatting options for rows,

columns, column width, line item width, format,
and factor.

• Indicator: Specify which colors to use to display
Account Assignments, Calculations, and
Exceptions report indicators on your report
worksheet.

• Copy Options include Make Copy Default,
Enforcement Level and Prompt.
Note: These options are overriden if the ADI
security-related profile options are defined in GL.

(Help) Oracle Financial Applications > Applications Desktop
Integrator > Getting Started with ADI > ADI Options > General Ledger
Options > Report Definition Tab
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Using Profile OptionsUsing Profile Options

Using Profile Options: You can set the following
profile options for Define Report
• GLDI: Report Wizard Privileges: You may have one

of four security levels assigned named None,
Submit, Define, Define and Submit.

• GLDI: AutoCopy Enforcement Level: When
working with existing reports or report objects,
you can assign the profile options Enforce Copy,
Enforce Original and None.

Using Profile Options: You can set the following
profile options for Define Report
• GLDI: Report Wizard Privileges: You may have one

of four security levels assigned named None,
Submit, Define, Define and Submit.

• GLDI: AutoCopy Enforcement Level: When
working with existing reports or report objects,
you can assign the profile options Enforce Copy,
Enforce Original and None.
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In this lesson, you should have learned how to:
• Identify the Define Report toolbar
• Create a new report, modify the components of an

existing report, and download an existing report to
a spreadsheet

• Use various methods to update report objects and
attributes

• Create content sets using the Content Set
Generator

In this lesson, you should have learned how to:
• Identify the Define Report toolbar
• Create a new report, modify the components of an

existing report, and download an existing report to
a spreadsheet

• Use various methods to update report objects and
attributes

• Create content sets using the Content Set
Generator
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R11i Submitting, Analyzing, and
Publishing Reports

R11i Submitting, Analyzing, and
Publishing Reports

Oracle Applications Desktop Integrator,
Release 7.0

Oracle Applications Desktop Integrator,
Release 7.0
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After completing this module you should be able to
do the following:
• Identify the toolbar icons and tabs of the Request

Center window and submit financial and standard
reports

• Publish to a spreadsheet, Web page, text file and create
themes to format report outputs

• Setup Request Center
• Identify the icons on the Analyze Report toolbar and

drill down to various types of balances
• Manipulate dimensions to change your analysis views

and export analysis to a Microsoft Excel

After completing this module you should be able to
do the following:
• Identify the toolbar icons and tabs of the Request

Center window and submit financial and standard
reports

• Publish to a spreadsheet, Web page, text file and create
themes to format report outputs

• Setup Request Center
• Identify the icons on the Analyze Report toolbar and

drill down to various types of balances
• Manipulate dimensions to change your analysis views

and export analysis to a Microsoft Excel



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Submitting, Analyzing, and Publishing Reports
Chapter 22 - Page 4

Agenda

Copyright © Oracle Corporation, 2001. All rights reserved.
®

AgendaAgenda

• Overview of Submitting, Analyzing, and Publishing
Reports.

• Submitting and Publishing Reports
• Analyzing Reports

• Overview of Submitting, Analyzing, and Publishing
Reports.

• Submitting and Publishing Reports
• Analyzing Reports
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• The Request Center provides a central location for
submitting, publishing, and monitoring reports
and concurrent programs for any Oracle
Application

• Some of the benefits of Request Center include:
– Publishing reports automatically to a Web

page or spreadsheet
– Using themes to format reports
– Formatting at the cell level
– Monitoring any concurrent request submitted

from any Oracle application across multiple
databases

• The Request Center provides a central location for
submitting, publishing, and monitoring reports
and concurrent programs for any Oracle
Application

• Some of the benefits of Request Center include:
– Publishing reports automatically to a Web

page or spreadsheet
– Using themes to format reports
– Formatting at the cell level
– Monitoring any concurrent request submitted

from any Oracle application across multiple
databases
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AgendaAgenda

• Overview of Submitting, Analyzing, and Publishing
Reports.

• Submitting and Publishing Reports
• Analyzing Reports

• Overview of Submitting, Analyzing, and Publishing
Reports.

• Submitting and Publishing Reports
• Analyzing Reports
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Toolbar IconsToolbar Icons

From the Request Center toolbar, you can access all
of the Request Center features for submitting,
monitoring, and publishing your reports.
• Submit Report - Submit standard or financial

reports to be run on your server
• Show Request Details - Show submission details,

such as phase, status, and request date, for a
selected request

• Cancel Request - Cancel a concurrent request
• View Output/Log - Download the report output or

log file of a selected request and view it in the
default output viewer

From the Request Center toolbar, you can access all
of the Request Center features for submitting,
monitoring, and publishing your reports.
• Submit Report - Submit standard or financial

reports to be run on your server
• Show Request Details - Show submission details,

such as phase, status, and request date, for a
selected request

• Cancel Request - Cancel a concurrent request
• View Output/Log - Download the report output or

log file of a selected request and view it in the
default output viewer

(Help) Oracle Financial Applications > Applications Desktop
Integrator > Getting Started with ADI > ADI Toolbar
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Toolbar Icons (continued)Toolbar Icons (continued)

• Publish Report - Download and publish the report
output of a selected request to a Web page,
Microsoft Excel worksheet, or text viewer

• Publish Sets - Download and publish report and
request sets, created in Oracle Applications, using
the Request Center. You can apply publishing
templates (themes and publishing options) to each
report in the set then publish all reports in a
Financial or Standard Report set. Publishing
Templatescan be saved and reused.

• Report Manager Tools- Set the formatting options
for your report output (You can select from
predefined report themes or define your own)

• Publish Report - Download and publish the report
output of a selected request to a Web page,
Microsoft Excel worksheet, or text viewer

• Publish Sets - Download and publish report and
request sets, created in Oracle Applications, using
the Request Center. You can apply publishing
templates (themes and publishing options) to each
report in the set then publish all reports in a
Financial or Standard Report set. Publishing
Templatescan be saved and reused.

• Report Manager Tools- Set the formatting options
for your report output (You can select from
predefined report themes or define your own)
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Toolbar Icons (continued)Toolbar Icons (continued)

• Print Output/Log - Download a report output or log
file and print it to a local or network printer

• Monitor Request - Select a request to monitor (The
request is added to the Pending or Completed tab
in the Request Center window)

• Add Request to Hotlist - Place a completed
request in a special hotlist holding area (Deleting
requests from the Completed tab does not affect
the entries in the hotlist)

• Stop Monitoring Selected Request - Remove a
selected request from either the Pending,
completed, or Hotlist tabs of the Request Center
window

• Print Output/Log - Download a report output or log
file and print it to a local or network printer

• Monitor Request - Select a request to monitor (The
request is added to the Pending or Completed tab
in the Request Center window)

• Add Request to Hotlist - Place a completed
request in a special hotlist holding area (Deleting
requests from the Completed tab does not affect
the entries in the hotlist)

• Stop Monitoring Selected Request - Remove a
selected request from either the Pending,
completed, or Hotlist tabs of the Request Center
window
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Toolbar Icons (continued)Toolbar Icons (continued)

• Stop Monitoring ALL Requests - Remove all
requests from the Pending, Completed, or Hotlist
tabs of the Request Center window

• Signon - Sign on to an Oracle Applications
database (You must sign on before you can
monitor requests for a specific database)

• Disconnect - Disconnect from the selected Oracle
Applications database

• Change Responsibility - Select a different
responsibility when you have signed on to the
database

• ADI - Start ADI if it is installed on your PC

• Stop Monitoring ALL Requests - Remove all
requests from the Pending, Completed, or Hotlist
tabs of the Request Center window

• Signon - Sign on to an Oracle Applications
database (You must sign on before you can
monitor requests for a specific database)

• Disconnect - Disconnect from the selected Oracle
Applications database

• Change Responsibility - Select a different
responsibility when you have signed on to the
database

• ADI - Start ADI if it is installed on your PC
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Toolbar Icons (continued)Toolbar Icons (continued)

• Oracle Applications - Start Oracle Applications if they
are installed on your PC (When you click this button,
you will be asked to select an applications database. If
you select the same database that you are using for
your Request Center session, you will not have to enter
your username and password in Oracle Applications)

• Options - Set the Request Center options
• Help - Access the Request Center online Help features
• Minimize - Minimize the Request Center window
• Exit - Close and exit the Request Center
• Pending Request - Indicates that a request is currently

pending

• Oracle Applications - Start Oracle Applications if they
are installed on your PC (When you click this button,
you will be asked to select an applications database. If
you select the same database that you are using for
your Request Center session, you will not have to enter
your username and password in Oracle Applications)

• Options - Set the Request Center options
• Help - Access the Request Center online Help features
• Minimize - Minimize the Request Center window
• Exit - Close and exit the Request Center
• Pending Request - Indicates that a request is currently

pending
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Request Center TabsRequest Center Tabs

There are four tabs you can select from to view
different information:
• Pending - Displays all pending requests (You can

add a pending request to the pending list by
clicking the Monitor Request icon from the
Request Center toolbar)

• Completed - Displays all completed requests (You
can add a completed request to the completed list
by clicking the Monitor Request icon from the
Request Center toolbar)

There are four tabs you can select from to view
different information:
• Pending - Displays all pending requests (You can

add a pending request to the pending list by
clicking the Monitor Request icon from the
Request Center toolbar)

• Completed - Displays all completed requests (You
can add a completed request to the completed list
by clicking the Monitor Request icon from the
Request Center toolbar)

(Help) Oracle Financial Applications > Applications Desktop
Integrator > The Request Center
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Request Center Tabs (continued)Request Center Tabs (continued)

• Hotlist - Displays any completed requests that you
have added to the hotlist by clicking the Add
Request to Hotlist icon from the Request Center
toolbar

• Databases - Displays all Oracle Applications
databases that you have defined (This tab also
indicates whether you are connected to the
database and shows how many requests related to
the database are complete, pending, and hotlisted)

• Hotlist - Displays any completed requests that you
have added to the hotlist by clicking the Add
Request to Hotlist icon from the Request Center
toolbar

• Databases - Displays all Oracle Applications
databases that you have defined (This tab also
indicates whether you are connected to the
database and shows how many requests related to
the database are complete, pending, and hotlisted)
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Selecting a Report Type
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Selecting a Report TypeSelecting a Report Type

When you click the Submit icon in the Request Center
toolbar, you open the Report Submission and
Publishing window. You can select from the following
reports in the Report Type region:
• Standard (Fixed Format) - Submit any standard

reports that are available in Oracle Applications if
they are available to your responsibility

• Standard (Variable Format) - Submit any variable
format report that enables the user to define the
content and order of the report (variable reports
are used only in Oracle Assets)

When you click the Submit icon in the Request Center
toolbar, you open the Report Submission and
Publishing window. You can select from the following
reports in the Report Type region:
• Standard (Fixed Format) - Submit any standard

reports that are available in Oracle Applications if
they are available to your responsibility

• Standard (Variable Format) - Submit any variable
format report that enables the user to define the
content and order of the report (variable reports
are used only in Oracle Assets)

(Help) Oracle Financial Applications > Applications Desktop
Integrator > The Request Center > Submitting Reports



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Submitting, Analyzing, and Publishing Reports
Chapter 22 - Page 15

Selecting a Report Type (continued)

Copyright © Oracle Corporation, 2001. All rights reserved.
®

Selecting a Report Type (continued)Selecting a Report Type (continued)

• Financial Statement - Submit any financial report
that has been defined if your responsibility
enables you to access the reports (Financial
reports are used only in Oracle GL)

• Financial Statement - Submit any financial report
that has been defined if your responsibility
enables you to access the reports (Financial
reports are used only in Oracle GL)
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Selecting Publishing Options
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Selecting Publishing OptionsSelecting Publishing Options

You can publish report outputs to Web pages, a
spreadsheet, or a text file. You can also choose to have the
report published automatically after processing.
• Publish Report - If you select this, ADI will publish your

report
• Prompt - If you select Prompt, a dialog box appears

before the system publishes the report.
• Output Type - Select how you want to publish your

report output
• Themes - Select a theme to apply formatting to your

report (themes are covered later in the lesson)
• Options region - Select options based on the output

type that you have selected

You can publish report outputs to Web pages, a
spreadsheet, or a text file. You can also choose to have the
report published automatically after processing.
• Publish Report - If you select this, ADI will publish your

report
• Prompt - If you select Prompt, a dialog box appears

before the system publishes the report.
• Output Type - Select how you want to publish your

report output
• Themes - Select a theme to apply formatting to your

report (themes are covered later in the lesson)
• Options region - Select options based on the output

type that you have selected

(Help) Oracle Financial Applications > Applications Desktop
Integrator > The Request Center > Setting Report Publishing Options
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Selecting OptionsSelecting Options

Scheduling Report Processing
• When you submit a report for processing, you can

set the Oracle Applications request submission
options, including scheduling the report to be
processed at a specific time on a specific date.
You can also choose to print your report to a local
or network printer, and you can specify the
number of copies to print.

Scheduling Report Processing
• When you submit a report for processing, you can

set the Oracle Applications request submission
options, including scheduling the report to be
processed at a specific time on a specific date.
You can also choose to print your report to a local
or network printer, and you can specify the
number of copies to print.
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How to Submit a Financial Report
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How to Submit a Financial ReportHow to Submit a Financial Report

If your financial report or your report components are
already defined, you can use the Request Center to
submit and publish a report.
1.  Click the Submit Report button on the Request

Center toolbar and select  Financial Statement as
the Report Type.

2.  You can select a report from the Existing Report
poplist or query a report name.

3.  To create an ad hoc report, leave the Existing
Report field blank and click the Select
Components button.

If your financial report or your report components are
already defined, you can use the Request Center to
submit and publish a report.
1.  Click the Submit Report button on the Request

Center toolbar and select  Financial Statement as
the Report Type.

2.  You can select a report from the Existing Report
poplist or query a report name.

3.  To create an ad hoc report, leave the Existing
Report field blank and click the Select
Components button.



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Submitting, Analyzing, and Publishing Reports
Chapter 22 - Page 19

How to Submit a Financial Report
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How to Submit a Financial ReportHow to Submit a Financial Report

4.  Enter or select your other report parameters,
including Period, Date, Content Set, Segment
Override, Rounding Option, Currency, and
Exceptions Only.

Note: If you run an existing report that already has a
content set defined, you can override the original
content set by specifying a new one when you submit
 the report.

4.  Enter or select your other report parameters,
including Period, Date, Content Set, Segment
Override, Rounding Option, Currency, and
Exceptions Only.

Note: If you run an existing report that already has a
content set defined, you can override the original
content set by specifying a new one when you submit
 the report.
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Publishing a to a Spreadsheet
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Publishing a to a SpreadsheetPublishing a to a Spreadsheet

Set the following options if you choose Spreadsheet
as your output type:
• New Workbook - Publishes the report to a new

Microsoft Excel workbook
• Current Workbook -  Publishes the report to the

currently active Microsoft Excel workbook (You
can add a new worksheet (Add Output) or replace
an existing worksheet (Replace Output)

• Apply Formatting Applies the formatting specified
in your selected theme (Do not select this option if
you do not want formatting)

Set the following options if you choose Spreadsheet
as your output type:
• New Workbook - Publishes the report to a new

Microsoft Excel workbook
• Current Workbook -  Publishes the report to the

currently active Microsoft Excel workbook (You
can add a new worksheet (Add Output) or replace
an existing worksheet (Replace Output)

• Apply Formatting Applies the formatting specified
in your selected theme (Do not select this option if
you do not want formatting)

(Help) Oracle Financial Applications > Applications Desktop
Integrator > The Request Center > Setting Report Publishing Options
> Spreadsheet Options
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Publishing a Financial Report
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Publishing a Financial ReportPublishing a Financial Report

The Request Center displays the actual financial
report name instead of the text “Financial Statement
Generator” in the Program Name column. This feature
enables you to quickly identify and publish any
financial statement that you have previously run.
• If you select the Prompt option in the Report

Submission and Publishing window, when your
request finishes, a Request Center decision
window appears

• To publish now, click Yes. If you click No, you can
publish at any time by using the Publish Output
icon

The Request Center displays the actual financial
report name instead of the text “Financial Statement
Generator” in the Program Name column. This feature
enables you to quickly identify and publish any
financial statement that you have previously run.
• If you select the Prompt option in the Report

Submission and Publishing window, when your
request finishes, a Request Center decision
window appears

• To publish now, click Yes. If you click No, you can
publish at any time by using the Publish Output
icon
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Viewing a Financial Report Published to a Spreadsheet
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Viewing a Financial Report Published to a
Spreadsheet

Viewing a Financial Report Published to a
Spreadsheet

After you publish a financial report to a spreadsheet,
you can save it as a file to send as an attachment.
• The amounts that you see represent a range of

account values
• To view additional details, you can either publish

your report with a content set or use the Analyze
Report feature of ADI

• Analyze Report will be covered later in this module

After you publish a financial report to a spreadsheet,
you can save it as a file to send as an attachment.
• The amounts that you see represent a range of

account values
• To view additional details, you can either publish

your report with a content set or use the Analyze
Report feature of ADI

• Analyze Report will be covered later in this module
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Demonstration
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DemonstrationDemonstration

This demonstration shows you how to:
• Submit a financial report
• Publish to a spreadsheet
• Request Center > Submit Report > (B)Submission

This demonstration shows you how to:
• Submit a financial report
• Publish to a spreadsheet
• Request Center > Submit Report > (B)Submission
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Practice 1 Overview

Copyright © Oracle Corporation, 2001. All rights reserved.
®

Practice 1 OverviewPractice 1 Overview

This practice covers the following topics:
• Submitting a financial report
• Publishing to a spreadsheet

This practice covers the following topics:
• Submitting a financial report
• Publishing to a spreadsheet
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Practice 1 Instructions with Solutions
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Practice 1 Instructions with SolutionsPractice 1 Instructions with Solutions

In this practice, you will  select and publish a report
to a spreadsheet.
In this practice, you will  select and publish a report
to a spreadsheet.

Practice Instructions
In this practice, you will select and publish a report to a spreadsheet.
Step 1: Select the Report
You need to submit the Class Act/Bud/Var report for the latest open period.
Make sure to include the XX Content Set.
Step 2: Select Publishing Options
Publish your output to a new spreadsheet worksheet, applying the Turtle
theme.
Accept the remaining defaults.
Hint: If you need help, you can either go back to the lesson for more
information, or review the solutions.
Practice Solution

Step 1: Select the Report
1. Click the Request Center on the task bar at the bottom of your screen.
2. Click the Submit Request icon on the Request Center toolbar.
3. In the Report Type region, select Financial Statement.
4. In the Existing Report field, select your XX Act/Bud/Var report from the list

of values.
5. Put your cursor in the Period field. The latest open period defaults. Use May

of the current year  as the period for the report. In the Content Set field, you
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should see the content set XX Content Set. If you do not, use the list of values
to find it.

6. Click the Publishing button.
Step 2: Select Publishing Options

1. Select the Spreadsheet output type.
2. Select the Spreadsheet options, New Workbook, Add Output, Apply

Formatting.
3. Click the Options button. Accept the defaults.
4. Click the green check mark to submit the report.
5. Click OK to acknowledge the submission of the report.
6. Your request will be in the Pending tab in the Request Center window.

When the Request Center prompt appears, click Yes.
7. View your output in your spreadsheet. Notice the output tabs for each

department. You can click on each tab to see a report for each department.
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Overview of Web Publishing
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Overview of Web PublishingOverview of Web Publishing

• Web publishing eliminates printing reports for manual
distribution. You can publish reports directly to a Web
site by linking output to an HTML Web page on a
corporate intranet or on the Internet

• Interested users log in to the Web site to subscribe to or
view selected reports. Those users who need to analyze
the report further can download a spreadsheet version
of the report from the Web site

• You can apply report themes or custom formatting,
such as colors, fonts, and a corporate logo, to make
your outputs look more professional

• Each time you run the report, you have the option of
automatically updating the Web page

• Web publishing eliminates printing reports for manual
distribution. You can publish reports directly to a Web
site by linking output to an HTML Web page on a
corporate intranet or on the Internet

• Interested users log in to the Web site to subscribe to or
view selected reports. Those users who need to analyze
the report further can download a spreadsheet version
of the report from the Web site

• You can apply report themes or custom formatting,
such as colors, fonts, and a corporate logo, to make
your outputs look more professional

• Each time you run the report, you have the option of
automatically updating the Web page
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Publishing a Report to the Web
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Publishing a Report to the WebPublishing a Report to the Web

Set the following options for your Web output type:
• Publish To - Enter a path and filename for the Web

page that ADI will create. If a Publish To value has
been defined within the theme, it will override any
value that you enter now

• Launch Browser - This option displays report
output in your browser

• Include Spreadsheet - Check this box to download
both web page and spreadsheet output. This
option only appears for FSG and Ad Hoc reports.

Set the following options for your Web output type:
• Publish To - Enter a path and filename for the Web

page that ADI will create. If a Publish To value has
been defined within the theme, it will override any
value that you enter now

• Launch Browser - This option displays report
output in your browser

• Include Spreadsheet - Check this box to download
both web page and spreadsheet output. This
option only appears for FSG and Ad Hoc reports.

(Help) Oracle Financial Applications > Applications Desktop
Integrator > The Request Center > Setting Report Publishing Options
> Local Web Page Options
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Publishing a Report to the Web (continued)
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Publishing a Report to the Web
(continued)

Publishing a Report to the Web
(continued)

• Include Text (Plain) File - Check this box to
download both web page and text output. This
option only appears for standard and variable
format reports.

• Include Printable Copy - Check this box to
download a web-based version of the report that is
suitable for printing. This option only appears for
standard and variable format reports.

• Link Reports - Use this option to link financial
report pages when you use a content set

• Separate Directories - Use this option to save
financial report pages to separate subdirectories
when you use a content set

• Include Text (Plain) File - Check this box to
download both web page and text output. This
option only appears for standard and variable
format reports.

• Include Printable Copy - Check this box to
download a web-based version of the report that is
suitable for printing. This option only appears for
standard and variable format reports.

• Link Reports - Use this option to link financial
report pages when you use a content set

• Separate Directories - Use this option to save
financial report pages to separate subdirectories
when you use a content set
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Demonstration
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DemonstrationDemonstration

This demonstration shows you how to:
• Publish a financial report to the Web
• Use a content set
• Request Center > Submit Report > (B)Publishing

This demonstration shows you how to:
• Publish a financial report to the Web
• Use a content set
• Request Center > Submit Report > (B)Publishing
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Practice 2 Overview
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Practice 2 OverviewPractice 2 Overview

This practice covers the following topics:
• Publishing a financial report to the Web
• Using a content set

This practice covers the following topics:
• Publishing a financial report to the Web
• Using a content set
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Practice 2 Instructions with Solution
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Practice 2 Instructions
with Solution

Practice 2 Instructions
with Solution

In this practice, you will submit and publish to the
Web an ad hoc financial report with a content set.
In this practice, you will submit and publish to the
Web an ad hoc financial report with a content set.

Practice Instructions
In this practice, you will submit and publish to the Web an ad hoc financial

report with a content set.
Scenario
You need to publish a financial report to the web. Also, you need to include the

budget and content set as instructed below. You should publish this report to
a Web page instead of a spreadsheet.

Step 1: Select Your Report and Content Set
1. From the Report Submission and Publishing window, select Financial

Statement as the report type.
2. Select Create Ad Hoc Report and submit the report with the XX RW Row

Set and XX RW Column Set.
3. Include your XX Web Content Set.
4. Select the 1999 BUDGET.
5. Submit the report for latest open period.

Step 2: Select Publishing Options
1. Publish your output to the Web, applying the Turtle theme.
2. Accept the remaining defaults.
Hint: If you need help, you can either go back to the lesson for more
information, or review the solutions.
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Practice Solution
Step 1: Select Your Report and Content Set

1. Click the Request Center on the task bar at the bottom of your screen.
2. Click the Submit Request icon on the Request Center toolbar.
3. Select Financial Statement as the report type.
4. Click the Select Components button.
5. From the list of values, select  XX RW Row Set, XX RW Column Set and

XX Web Content Set.
6. Select the 1999 BUDGET from the list of values.
7. Click the green check mark to close the window.
8. In the Period field, select the latest open period (it should default).
9. Accept the remaining default values and click the Publishing button.

Step 2: Select Publishing Options
1. Select the Web output type.
2. Select the Web Options Launch Browser, Include Spreadsheet, Link

Reports, Separate Directories.
3. Click the green check mark.
4. Click OK to acknowledge the submission of the report.
5. Your request will be in the Pending tab in the Request Center window.

When the Request Center window appears, click Yes.
6. View your report. Notice how each department report has its own link.
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Publishing a Report to Text
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Publishing a Report to TextPublishing a Report to Text

Set the following options if you select Text as your
output type:
• Publish To - Enter a path and filename for the text

file that the Request Center will create. Optionally,
click the Find button to locate the directory you
want

• Launch Viewer - Select this option to enable
Request Center to start your specified output
viewer, download the report, and display it

Set the following options if you select Text as your
output type:
• Publish To - Enter a path and filename for the text

file that the Request Center will create. Optionally,
click the Find button to locate the directory you
want

• Launch Viewer - Select this option to enable
Request Center to start your specified output
viewer, download the report, and display it

(Help) Oracle Financial Applications > Applications Desktop
Integrator > The Request Center > Setting Report Publishing Options
> Text Options
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Demonstration
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DemonstrationDemonstration

This demonstration shows you how to publish a
financial report to text
• Request Center > Submit Report > (B)Publishing

This demonstration shows you how to publish a
financial report to text
• Request Center > Submit Report > (B)Publishing
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Practice 3 Overview
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Practice 3 OverviewPractice 3 Overview

This practice covers publishing a financial report to
text.
This practice covers publishing a financial report to
text.
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Practice 3 Instructions with Solution
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Practice 3 Instructions
with Solution

Practice 3 Instructions
with Solution

In this practice, you will submit a financial report that
is published to text.
• Select a Financial Report
• Publish to Text

In this practice, you will submit a financial report that
is published to text.
• Select a Financial Report
• Publish to Text

Practice Instructions
In this practice, you will submit a financial report that is published to text.

Scenario
You need to include a financial report for the month of January 1998 within a
document, so you decide to publish to text.

Step 1: Select a Financial Report
Select the XX Consolidated Balance Sheet report from the list of values and run
the report for the period Jan-98.

Step 2: Publish to Text
Publish the output to text.
Hint: If you need help, you can either go back to the lesson for more
information, or review the solutions.

Practice Solution
Step 1: Select a Financial Report

1. Select the Request Center on the task bar at the bottom of your screen.
2. Click the Submit Request icon on the Request Center toolbar.
3. Select a Financial Statement report type.
4. In the Existing Report field, select XX Consolidated Balance Sheet from

the list of values.
5. In the Period field, select Jan-98 from the list of values.
6. Click the Publishing button.
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Step 2: Publish to Text
1. Select the Text (Plain) output type.
2. Select the options Launch Viewer.
3. Click the Options button. Accept the defaults.
4. Click the green check mark to submit the report.
5. Click OK to acknowledge the submission of the report.
6. Your request will be in the Pending tab of the Request Center window.

When the Request Center window appears, click Yes.
7. View the output.
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How to Submit a Standard Report
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How to Submit a Standard ReportHow to Submit a Standard Report

1.  Click the Submit Report icon in the Request Center
toolbar select Standard (Fixed Format) as the
report type.

2.  Select the standard report that you want to run and
enter your standard report parameters.

3.  Click the Submission button to display the
standard report submission parameters and click
the click the Publishing button to set your report
publishing options.

Note: The list of standard reports depends on which
responsibility you chose

1.  Click the Submit Report icon in the Request Center
toolbar select Standard (Fixed Format) as the
report type.

2.  Select the standard report that you want to run and
enter your standard report parameters.

3.  Click the Submission button to display the
standard report submission parameters and click
the click the Publishing button to set your report
publishing options.

Note: The list of standard reports depends on which
responsibility you chose

Note: The list of standard reports depends on which responsibility you chose
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Demonstration

Copyright © Oracle Corporation, 2001. All rights reserved.
®

DemonstrationDemonstration

This demonstration shows you how to:
• Submitting a standard report
• Publishing to a spreadsheet
• Request Center > Submit Report

This demonstration shows you how to:
• Submitting a standard report
• Publishing to a spreadsheet
• Request Center > Submit Report
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Practice 4 Overview
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Practice 4 OverviewPractice 4 Overview

This practice covers the following topics:
• Submitting a standard report
• Publishing to a spreadsheet

This practice covers the following topics:
• Submitting a standard report
• Publishing to a spreadsheet
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Practice 4 Instructions with Solution
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Practice 4 Instructions
with Solution

Practice 4 Instructions
with Solution

In this practice, you will submit a standard report
and publish it to a spreadsheet.
• Standard report: Chart of Accounts - Segment

Values Listing
• Output type: Spreadsheet

In this practice, you will submit a standard report
and publish it to a spreadsheet.
• Standard report: Chart of Accounts - Segment

Values Listing
• Output type: Spreadsheet

Practice Instructions
In this practice, you will submit a standard report and publish it to a
spreadsheet.

Scenario
You need to submit the standard report Chart of Accounts - Segment Values
Listing.
You want to publish it to a spreadsheet so that you can save it as a file. You will
publish it in a new workbook.

Step 1: Select Standard Report
From the Submit Report window, select the standard report Chart of Accounts -
Segment Values Listing. From the Segment Name drop-down box, select
Account.

Step 2: Select Publishing Options
Publish your output to a new worksheet, applying the Turtle theme. Accept the
remaining defaults.
Hint: If you need help, you can either go back to the lesson for more
information, or go forward to the solutions.

Practice Solution
Step 1: Select Standard Report
1. Click the Request Center on the task bar on the bottom of your screen.
2. Click the Submit Request icon on the Request Center toolbar.
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3. Select a Standard (Fixed Format) report type.
4. In the Report field, select Chart of Accounts - Segment Values Listing from

the list of values.
5. Click the Submission button or press [Tab].
6. Enter the parameters Segment Name: Account
7. Click the Publishing button.
Step 2: Select Publishing Options
1. Select the Spreadsheet output type.
2. Select the options: New Workbook
3. Click the green check mark (OK) to submit the report.
4. Click OK to acknowledge the submission of the report.
5. Your request will be in the Pending tab of the Request Center window. When

the Request Center prompt appears, click Yes.
6. View your report in a spreadsheet.
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Using Themes
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Using ThemesUsing Themes

• You can format any report request that you submit
through the Request Center by applying a report
output theme when you publish the report

• You can create new themes or customize existing
themes in a spreadsheet environment by using a
combination of ADI and Microsoft Excel formatting
features

• You can fine-tune your themes by using tokens
and cell level formatting to control the appearance
of your financial reports down to the cell level; that
is, the intersection of a row and a column

• You can format any report request that you submit
through the Request Center by applying a report
output theme when you publish the report

• You can create new themes or customize existing
themes in a spreadsheet environment by using a
combination of ADI and Microsoft Excel formatting
features

• You can fine-tune your themes by using tokens
and cell level formatting to control the appearance
of your financial reports down to the cell level; that
is, the intersection of a row and a column

(Help) Oracle Financial Applications > Applications Desktop
Integrator > The Request Center > Setting Report Submission
Options > Formatting Report Output > Using Report Output Themes
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Applying a Report Theme
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Applying a Report ThemeApplying a Report Theme

When you submit the report from the Report
Submission and Publishing window or publish a
report by using the Request Center Publish Output
button, enter the path and name of the theme that you
want to use in the Apply Theme field. A theme can be
applied to any report published to the Web or a
spreadsheet.

When you submit the report from the Report
Submission and Publishing window or publish a
report by using the Request Center Publish Output
button, enter the path and name of the theme that you
want to use in the Apply Theme field. A theme can be
applied to any report published to the Web or a
spreadsheet.
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How to Create a Theme
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How to Create a ThemeHow to Create a Theme

1. Click the Format Report Output icon on the
Request Center toolbar.

2. Click Create and select the report type: Financial
Statement, Standard (Fixed Format), or Standard
(Variable Format). ADI creates a theme based on
the Theme Defaults tab of the General Options
window

3. Customize the theme worksheet as described in
the next section, and save your theme.

1. Click the Format Report Output icon on the
Request Center toolbar.

2. Click Create and select the report type: Financial
Statement, Standard (Fixed Format), or Standard
(Variable Format). ADI creates a theme based on
the Theme Defaults tab of the General Options
window

3. Customize the theme worksheet as described in
the next section, and save your theme.
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How to Customize a Theme
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How to Customize a ThemeHow to Customize a Theme

1.  From the Report Output Themes window, click the
folder icon to open the theme that you want to
customize then click the Customize button and
select the report output feature that you want to
change.

3.  Define your formatting choices within each tab of
the Format Cells window.

4.  (Optional) Click Publish To, then select a default
path and filename to use for publishing Web-
based reports with this theme.

5.  (Optional) Click Background, then select an image
file to use as a background for any report that you
create with this report output theme.

1.  From the Report Output Themes window, click the
folder icon to open the theme that you want to
customize then click the Customize button and
select the report output feature that you want to
change.

3.  Define your formatting choices within each tab of
the Format Cells window.

4.  (Optional) Click Publish To, then select a default
path and filename to use for publishing Web-
based reports with this theme.

5.  (Optional) Click Background, then select an image
file to use as a background for any report that you
create with this report output theme.
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Demonstration
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DemonstrationDemonstration

This demonstration shows you how to:
• Creating a custom theme
• Publishing a standard report to a spreadsheet
• Modifying a theme
• Request Center > Format Report Output

This demonstration shows you how to:
• Creating a custom theme
• Publishing a standard report to a spreadsheet
• Modifying a theme
• Request Center > Format Report Output
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Practice 5 Overview
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Practice 5 OverviewPractice 5 Overview

This practice covers the following topics:
• Creating a custom theme
• Publishing a standard report to a spreadsheet
• Modifying a theme

This practice covers the following topics:
• Creating a custom theme
• Publishing a standard report to a spreadsheet
• Modifying a theme
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Practice 5 Instructions with Solution
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Practice 5 Instructions
with Solution

Practice 5 Instructions
with Solution

In this practice, you will create a custom theme and
publish a standard report with  this theme.
• Create your custom backgound and theme
• Use your theme to  publish a standard report to a

spreadsheet
• Modify your theme and publish report to web

In this practice, you will create a custom theme and
publish a standard report with  this theme.
• Create your custom backgound and theme
• Use your theme to  publish a standard report to a

spreadsheet
• Modify your theme and publish report to web

Practice Instructions
In this practice, you will create a custom theme and publish a standard report
with  this theme.

Scenario
You just received a memo from your manager informing you that he did not like
the Turtle theme on the reports that you sent him. You need to create a basic
theme that includes a logo and a simple background.

Step 1: Create Custom Theme
1. Using the Format Report Output button on the Request Center toolbar, create

a custom theme for a standard report.
2. Select the Grey.bmp file for this background. Do not click the Publish to

button.
Hint: Look for the file in the GLDI90\Themes\Backgrounds directory.

3. Save the theme as an Excel spreadsheet to the Themes directory, and name it
XXTheme1.xls; replace XX with your initials.

4. Close both the theme and the Report Output Themes windows.
Step 2: Publish Standard Report to a Spreadsheet
1. From the Submit Report window, select the Standard report Chart of Accounts

-Account Hierarchy. There are no parameters for this report.
2. Publish this report to a spreadsheet and use your new theme.



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Submitting, Analyzing, and Publishing Reports
Chapter 22 - Page 51

3. View your report. Notice the column sizes. You will need to modify this
theme to match this report. Do not close this report.

Step 3: Modify Theme and Republish Report
1. Using the Report Output Themes window, open your theme. Change the

width of column A to 72 and the width of column B to 60.
2. Save your theme and close the window.
3. Make sure that the report you just published is open.
4. In the Request Center window, select the report you just published.
5. Click the Publish Output icon to republish this report.
6. Republish your report to the current workbook and select Replace Output.
7. When your report finishes, if you see a line in the middle of your report, select

the menu path Tools—>Options. Clear the Page Breaks check box in the
Window Options region of the View tab. Notice how the report looks with the
new column widths.

Step 4: Republish the Report to the Web
1. From the Request Center window, select the report that you just published.
2. Click the Publish Output icon to republish this report.
3. Select Web as the output type, instead of spreadsheet.
4. View your report.

Hint: If you need help, you can either go back to the lesson for more
information, or review the solutions.

Practice Solution
Step 1: Create Custom Theme
1. Click the Format Report Output icon on the Request Center toolbar. The

Report Output Themes window opens.
2. Click the Create button.
3. Select Standard (Fixed Format). A new Microsoft Excel worksheet opens.
4. In the Report Output Themes window, click the Background button.
5. From the GLDI90\Themes\Background directory, select the Grey.bmp file

and click Open.
6. The background of the report is now a gray pattern. The path of the

background picture appears on the worksheet in the Background field.
7. Leave the Publish To field clear.
8. From the Microsoft Excel menu, select File—>Save As.
9. Save the theme as a Microsoft Excel spreadsheet to the Themes directory and

name it XXTheme1.xls; replace XX with your initials. Your theme can now
be applied to published reports.

10. Close your new theme.
11. Close the Report Output Themes window.
Step 2: Publish Standard Report to a Spreadsheet
1. Click Submit Report on the Request Center toolbar.
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2. From the Submit Report window, select the Standard (Fixed Format) report
Chart of Accounts - Account Hierarchy. There are no parameters for this
report.

3. Click the Publishing button.
4. Select the Spreadsheet output type.
5. In the Apply Theme field, enter the path and filename for your new theme.

You can use the flashlight icon to find the file.
6. Click the green check mark to submit the report.
7. Click OK to acknowledge the submission of the report.
8. Your request will be in the Pending tab in the Request Center window. When

the Request Center prompt appears, click Yes.
9. View your report.
10. Do not close this report. You will replace this output in the next step.
Step 3: Modify Theme and Republish Report
1. Click Format Report Output on the Request Center toolbar.
2. Click the Open icon (folder) and find your theme. Click OK to open it.
3. Change the width of column A to 72 by clicking column A and dragging it to

the right.
4. Change the width of column B to 60.
5. Save your changes and close the theme.
6. Make sure that your report is open.
7. In the Request Center window, locate the report that you just published by

putting your cursor on the line.
8. Click the Publish Output icon on the Request Center toolbar.
9. Select Current Workbook and Replace Output.
10. Click OK.
11. View your report.
12. To remove the page break, select Tools—>Options from the Microsoft Excel

menu. The Options window appears.
13. Clear the Page Breaks check box in the Windows Options of the View tab.
14. View your new report. Notice how the columns are sized differently.
Step 4: Republish the Report to the Web
1. In the Request Center window, select the report you just published.
2. Click the Publish Output icon to republish this report.
3. Select Web as the output type, instead of spreadsheet.
4. View your report.
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Using Cell Level Formatting
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Using Cell Level FormattingUsing Cell Level Formatting

You can format individual cells in your financial
report themes to refine the appearance of your report
output. This feature works for financial reports with
Oracle GL releases 11i, 11 and 10.7
• Cell level formatting overrides the formatting you

defined for the report title, report headings,
column headings, line items, and amounts when
you created or customized report output themes

• Cell level formatting for releases 11 and 10.7
follow different processes. For directions
regarding 10.7, see Oracle Applications Desktop
Integrator User’s Guide

You can format individual cells in your financial
report themes to refine the appearance of your report
output. This feature works for financial reports with
Oracle GL releases 11i, 11 and 10.7
• Cell level formatting overrides the formatting you

defined for the report title, report headings,
column headings, line items, and amounts when
you created or customized report output themes

• Cell level formatting for releases 11 and 10.7
follow different processes. For directions
regarding 10.7, see Oracle Applications Desktop
Integrator User’s Guide

(Help) Oracle Financial Applications > Applications Desktop
Integrator > Request Center > Formatting Report Output >
Customizing Themes for Financial Reports > Cell Level Formatting
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Using Cell Level Formatting (continued)
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Using Cell Level Formatting (continued)Using Cell Level Formatting (continued)

• In the report title, report heading, and column
heading regions of your theme, you  can format
any cell or range of cells, and the formatting will
be displayed in your report output. Instead of
using the Report Output Themes window, you
make your changes directly in Microsoft Excel

• You can also enter tokens, text, or numbers in any
cell within these regions, to be displayed in your
report output. A token enables the report to
reference information from the database, such as
set of books, report currency, or submission date.
A token must begin with an ampersand (&)

• In the report title, report heading, and column
heading regions of your theme, you  can format
any cell or range of cells, and the formatting will
be displayed in your report output. Instead of
using the Report Output Themes window, you
make your changes directly in Microsoft Excel

• You can also enter tokens, text, or numbers in any
cell within these regions, to be displayed in your
report output. A token enables the report to
reference information from the database, such as
set of books, report currency, or submission date.
A token must begin with an ampersand (&)

(Help) Oracle Financial Applications > Applications Desktop
Integrator > Request Center > Formatting Report Output >
Customizing Themes for Financial Reports > Cell Level Formatting
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Using Cell Level Formatting (continued)
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Using Cell Level Formatting (continued)Using Cell Level Formatting (continued)

Your report definition, created in Oracle GL or ADI,
uses sequence numbers to locate the position of
rows and columns in your report output. Use these
sequence numbers in your report themes to apply
formatting to specific areas of your report definition.
The Request Center matches the formatting specified
in your report theme with the information in your
report definition to generate formatted report output.
• Sequence numbers also act as tokens by

automatically inserting row and column
descriptions in the Line Item and Column Heading
regions of your report output

Your report definition, created in Oracle GL or ADI,
uses sequence numbers to locate the position of
rows and columns in your report output. Use these
sequence numbers in your report themes to apply
formatting to specific areas of your report definition.
The Request Center matches the formatting specified
in your report theme with the information in your
report definition to generate formatted report output.
• Sequence numbers also act as tokens by

automatically inserting row and column
descriptions in the Line Item and Column Heading
regions of your report output
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Using Cell Level Formatting (continued)
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Using Cell Level Formatting (continued)Using Cell Level Formatting (continued)

• To view sequence numbers associated with your
report  you can:
– Use the Report Wizard (Define Report)

capability to view the report
– Use the View Output/Log Button in the

Request Center toolbar and select View Output
File.

• Create a specific theme for each financial report
you have defined, so that the rows and columns of
the theme match the rows and columns of the
report

• To view sequence numbers associated with your
report  you can:
– Use the Report Wizard (Define Report)

capability to view the report
– Use the View Output/Log Button in the

Request Center toolbar and select View Output
File.

• Create a specific theme for each financial report
you have defined, so that the rows and columns of
the theme match the rows and columns of the
report
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How to Use Cell Level Formatting
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How to Use Cell Level FormattingHow to Use Cell Level Formatting

1.  Create a new theme worksheet (see the section on
how to create a theme for details).

2.  In column A of your report theme, select the row
that you want to format and enter the ampersand
symbol (&), followed by the row sequence number
that you want to use.

3.  Select Format Cells, or select Format—>Cells from
the menu. Use the Format Cells window in
Microsoft Excel to make font color, style, and size
changes.

1.  Create a new theme worksheet (see the section on
how to create a theme for details).

2.  In column A of your report theme, select the row
that you want to format and enter the ampersand
symbol (&), followed by the row sequence number
that you want to use.

3.  Select Format Cells, or select Format—>Cells from
the menu. Use the Format Cells window in
Microsoft Excel to make font color, style, and size
changes.
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How to Use Cell Level Formatting (continued)
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How to Use Cell Level Formatting
(continued)

How to Use Cell Level Formatting
(continued)

4.  Locate the column that you want to format and
select the cell beneath the column heading and
enter the ampersand symbol (&), followed by the
column sequence number that you want to use.

5.  Use Microsoft Excel’s formatting capabilities to
format a cell or range of cells. The Request Center
uses sequence numbers to reference formatting
instructions your report theme with the
information in your report definition to generate
your formatted report output.

4.  Locate the column that you want to format and
select the cell beneath the column heading and
enter the ampersand symbol (&), followed by the
column sequence number that you want to use.

5.  Use Microsoft Excel’s formatting capabilities to
format a cell or range of cells. The Request Center
uses sequence numbers to reference formatting
instructions your report theme with the
information in your report definition to generate
your formatted report output.
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Republish Report Output Manually
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Republish Report Output ManuallyRepublish Report Output Manually

• You may decide to republish a report and change
the theme. You can use the Publish Output option
to change the theme of a previously published
report

• You can also publish a report that was submitted
but not published (the Publish Report check box
was cleared). Report requests listed on the
Request Center Completed tab or Hotlist tab can
be published manually

• You may decide to republish a report and change
the theme. You can use the Publish Output option
to change the theme of a previously published
report

• You can also publish a report that was submitted
but not published (the Publish Report check box
was cleared). Report requests listed on the
Request Center Completed tab or Hotlist tab can
be published manually
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How to Republish Report Output Manually
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How to Republish Report Output
Manually

How to Republish Report Output
Manually

1.  Select the report from the Request Center
Completed tab or Hotlist tab.

2.  Click the Publish Output icon on the Request
Center toolbar.

3.  From the Apply Themes drop-down list, select the
report theme that you want to use. Apply Theme is
not enabled if publishing output to text.

4.  Select the output type for your report and
complete the appropriate publishing options for
the output type.

5.  Click OK to publish the report, or Cancel to abort.

1.  Select the report from the Request Center
Completed tab or Hotlist tab.

2.  Click the Publish Output icon on the Request
Center toolbar.

3.  From the Apply Themes drop-down list, select the
report theme that you want to use. Apply Theme is
not enabled if publishing output to text.

4.  Select the output type for your report and
complete the appropriate publishing options for
the output type.

5.  Click OK to publish the report, or Cancel to abort.
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Demonstration
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DemonstrationDemonstration

This demonstration shows you how to:
• Create custom themes for financial reports
• Change the format of a published financial report
• Request Center > Format Report Output

This demonstration shows you how to:
• Create custom themes for financial reports
• Change the format of a published financial report
• Request Center > Format Report Output
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Practice 6 Overview
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Practice 6 OverviewPractice 6 Overview

This practice covers the following topics:
• Creating custom themes for financial reports
• Changing the format of a published financial

report

This practice covers the following topics:
• Creating custom themes for financial reports
• Changing the format of a published financial

report
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Practice 6 Instructions with Solution
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Practice 6 Instructions
with Solution

Practice 6 Instructions
with Solution

In this practice, you will create another custom theme
and use it for your financial report
• Create cell level formatting for your theme by

changing font colors and sizes and moving the
text to the center.

• Publish a report using this theme to both a
spreadsheet and the Web.

In this practice, you will create another custom theme
and use it for your financial report
• Create cell level formatting for your theme by

changing font colors and sizes and moving the
text to the center.

• Publish a report using this theme to both a
spreadsheet and the Web.

Practice Instructions
In this practice, you will create another custom theme and use it for a financial
report, the Company Balance Sheet. You will create cell level formatting for
this theme by changing font colors and sizes and moving the text to the center.
You will publish a report using this theme to both a spreadsheet and the Web.
Scenario
The following is an example of the report definition. When you create a
custom theme for a financial report, it is recommended that you have a copy
of the definition in order to format specific rows and columns.
You will need this information to create your custom theme for row and
column sequences. Notice the column sequence numbers. You will move the
text between the columns. Notice the row sequence numbers. You will format
specific text and rows as well.

Step 1: Create a Custom Theme for a Financial Report
1. Click the Format Report Output button on the Request Center toolbar.
2. Format cells A3–G3 with a white pattern.
3. Delete row 4, which is an extra report title line.
4. Move the Oracle Applications icon to cell A3.
5. Remove the default tokens in cells B3–B6 by selecting Clear—>Contents

from the Edit menu.
6. Add the following tokens, making sure that the spelling and case are identical.

Note: It will look like you are typing in column D.
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Cell Cell Name
C3 &SetOfBooksName
C4 &ReportTitle
C5 For the Month Ending: &POINAME0

7. Change the cell formatting to the following:
Cell Formatting
C3 Arial 22, dark blue, bold
C4 Arial 18, dark blue, bold
C5 Arial 11, dark blue, bold

8. Put your cursor in cell A4. You should see Report Heading in the name box in
the upper left corner of your screen. This is the beginning of the report
heading area.

9. Move your cursor to cell A5. What is in the name box?
10. In what cell does Column Headings begin? ________________________
11. Delete rows 7–9 to eliminate the space between the title and the   headings.
12. Change the height of rows 6 and 7 to 13.
Step 2: Format Line Items
1. Move the line item text between column sequence numbers 10 and 20 by

clicking the right-arrow Move Line Items button.
2. Change the background color of the line items column (where you see text) to

ivory and the font color to black.
3. Apply the background color light turquoise to column A from row 7 through

row 19 (only where you see text), using Microsoft Excel    formatting.
4. Change the background color of rows 7 and 8 (the column heading region) to

gray.
5. Increase the width of columns A and C to 20. Increase the width of column B

to 50.
Cell Cell Name
C3 &SetOfBooksName
C4 &ReportTitle
C5 For the Month Ending: &POINAME0
Cell Formatting
C3 Arial 22, dark blue, bold
C4 Arial 18, dark blue, bold
C5 Arial 11, dark blue, bold

Step 3: Use Cell Level Formatting
1. Change the &default_line_format text to Arial 11, green. Unless indicated, all

row text will print with this color.
Hint: Put your cursor over the color in the Format Cells window to view the color
name.
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2. Look at the report defined in step 1 of this practice. Notice rows 5 and 85.
You will change the formatting specifically for these cells as well as 145 and
160. On the next line, after &default_line_format, type &5 Assets. Format in

Arial 12, dark red.
3. On the next line, type &85 Liabilities. Format in Arial 12, dark red.
4. On the next line, type &145 Owner’s Equity. Format in Arial 12, dark red.
5. On the next line, type &160 Total Liabilities and Owner’s

Equity. Format in Arial 12, blue.
6. Highlight this row from column A through column E with a gray background.

Select a border on the top and bottom. Change the amount format to $,
decimals, no pennies, and parentheses to indicate a negative amount.

7. Delete rows 15 to 19.
8. Delete columns D to G.
9. Save the theme as a Microsoft Excel spreadsheet to the Themes directory, and

name it XXBalSheetTheme.xls; replace XX with your initials.
10. Close the theme window.
Step 4: Submit the Financial Report to a Spreadsheet
1. In the Submit Report window, select a Financial Statement report type.
2. In the Existing Report field, select Company Balance Sheet and publish

thisreport for the period of Jan-98.
3. Publish this report to a spreadsheet and use your new theme.
Step 5: Republish the Report to the Web
1. From the Request Center window, select the report that you just published.
2. Republish this report, changing the output type from Spreadsheet to Web.
3. View your report.
Hint: If you need help, you can either go back to the lesson for more information,
or review the solutions.
Practice Solution
Step 1: Create a Custom Theme for a Financial Report
1. In the Request Center window, select Format Report Output.
2. Click the Create button in the Report Output Themes window, and select

Financial Statement. A new Microsoft Excel window opens.
3. Close the Report Output Themes window.
4. Highlight cells A3–G3 and click the right mouse button.
5. Select Format Cells. The Format Cells window opens. You can also open this

window by selecting Format—>Cells from the menu or by using the
Microsoft Excel toolbar. Formatting cells will be used throughout this
practice. Use these directions to access the window.

6. Click the Patterns tab and select white to change the color of these cells.
When you are done, click OK.

7. Click row 4 and click the right mouse button to open the Edit menu.
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8. Select Delete to delete the row.
9. Click the Oracle Applications icon once. Click and drag it to cell A3.
10. Highlight cells B3–B6. From the Edit menu, select Clear—>Contents to

delete the cells.
11. Add the following tokens, making sure that the spelling and case are identical.
Note: It will look like you are typing in column D.

Cell Cell Name
C3 &SetOfBooksName
C4 &ReportTitle
C5 For the Month Ending: &POINAME0

12. Using the Format Cells window, change the cell formatting to the following:
Cell Formatting
C3 Arial 22, dark blue, bold
C4 Arial 18, dark blue, bold
C5 Arial 11, dark blue, bold

13. Put your cursor in cell A4. You should see Report Heading in the name box in
the upper left corner of your screen. This is the beginning of the report
heading area.

14. Move your cursor to cell A5. What is in the name box? A5
15. In what cell does Column Headings begin? A10

Cell Cell Name
C3 &SetOfBooksName
C4 &ReportTitle
C5 For the Month Ending: &POINAME0
Cell Formatting
C3 Arial 22, dark blue, bold
C4 Arial 18, dark blue, bold
C5 Arial 11, dark blue, bold

16. Delete rows 7–9 to eliminate the space between the title and the column
headings (See step 7 for details on how to delete rows).

17. Change the height of rows 6 and 7 by highlighting the rows, clicking the right
mouse button and selecting Row Height. In the Row Height window, enter 13
and click OK.

Step 2: Format Line Items
1. Move the line item text between column sequence numbers 10 and 20 by

using the right-arrow Move Line Items button.
2. Change the background color of the line items column (where you see text) to

ivory and the font color to black.
3. Apply the background color light turquoise to column A from row 7 through

row 19 (only where you see text), using Microsoft Excel formatting.
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4. Change the background color of rows 7 and 8 (the column heading region) to
gray.

Move Line
Pattern = ivory
Font color = black
Items arrow buttons

5. Increase the width of columns A and C to 20. Increase the width of column B
to 50. To widen the columns, highlight the column, click the right mouse
button and select Column Width, or select Format—>Column—>Width from
the menu.

Step 3: Use Cell Level Formatting
1. Change the &default_line_format text to Arial 11, green. Unless
2. indicated, all row text will print with this color.

Hint: Put your cursor over the color in the Format Cells window to view the
color name.

3. Look at the report definition under step 1 of this practice. Notice rows 5, 85,
and 145. You will change the formatting specifically for these cells.

4. To format at the cell level, on the next line, after &default_line_format,type
&5 Assets. Format in Arial 12, dark red. When you publish the Company
Balance Sheet report with this theme, ADI will format the description of row
sequence 5 with this formatting.

5. On the next line, type &85 Liabilities. Format in Arial 12, dark red.
6. On the next line, type &145 Owner’s Equity. Format in Arial 12, dark red.
7. On the next line, type &160 Total Liabilities and Owner’sEquity. Format in

Arial 12, blue.
Highlight this row from column A through column E with a gray
background.
Select a border on the top and bottom. Change the amount format to $,
decimals, no pennies, and parentheses to indicate a negative amount.

8. Delete rows 15 to 19.
9. Delete columns D to G.

Your theme should look like the following:
10. Save the theme as a Microsoft Excel spreadsheet to the Themes directory, and

name it XXBalSheetTheme.xls; replace XX with your initials.
11. Close the theme window.
Step 4: Submit the Financial Report to a Spreadsheet
1. Click Submit Report on the Request Center toolbar.
2. In the Report Submission and Publishing window, select the Financial

Statement report type.
3. In the Existing Report field, select Company Balance Sheet from the list of

values.
4. Select Jun-98 in the period field.
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5. Click the Publishing button.
6. Select Spreadsheet as the output type.
7. In the Apply Theme field, enter the path and filename for your new theme.

You can use the flashlight icon to find the file.
8. Click the green check mark to submit the report.
9. Click OK to acknowledge the submission of the report.
10. Your request will be in the Pending tab in the Request Center window. When

the Request Center prompt appears, click Yes.
11. View your report with the new formatting.
Step 5: Republish the Report to the Web
1. In the Request Center window, select the report that you just published.
2. Click the Publish Output icon.
3. Change the output type from Spreadsheet to Web.
4. Click OK.
5. View your report.
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How to View Other Output Reports or Log Files
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How to View Other Output Reports or Log
Files

How to View Other Output Reports or Log
Files

Report logs are used to document submission details
and report parameters.
1.  From the Completed tab or Hotlist tab of the

Request Center window, select the entry for the
completed report.

2.  Click the View Output/Log icon on the Request
Center toolbar, select View Output File or View
Log File. The output or log file is downloaded and
then opened in the default output viewer that you
specified in the Request Center Options window.

Report logs are used to document submission details
and report parameters.
1.  From the Completed tab or Hotlist tab of the

Request Center window, select the entry for the
completed report.

2.  Click the View Output/Log icon on the Request
Center toolbar, select View Output File or View
Log File. The output or log file is downloaded and
then opened in the default output viewer that you
specified in the Request Center Options window.

(Help) Oracle Financial Applications > Applications Desktop
Integrator > The Request Center > Viewing Report Output and Logs
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How to Monitor a Request
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How to Monitor a RequestHow to Monitor a Request

1.  Start the Request Center if it is not already
running, and select Monitor Request.

2.  Select requests to include in the list by setting the
selection criteria.

3.  To stop monitoring a request, select the request
from one of the tabs and click Stop Monitoring
Selected Request on the Request Center toolbar.

1.  Start the Request Center if it is not already
running, and select Monitor Request.

2.  Select requests to include in the list by setting the
selection criteria.

3.  To stop monitoring a request, select the request
from one of the tabs and click Stop Monitoring
Selected Request on the Request Center toolbar.
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Demonstration
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DemonstrationDemonstration

This demonstration shows you how to:
• View request details of a completed report
• Clear all monitored requests from the Request

Center
• Request Center > Format Report Output

(T)Completed

This demonstration shows you how to:
• View request details of a completed report
• Clear all monitored requests from the Request

Center
• Request Center > Format Report Output

(T)Completed
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Practice 7 Overview
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Practice 7 OverviewPractice 7 Overview

This practice covers the following topics:
• Viewing request details of a completed report
• Clearing all monitored requests from the Request

Center

This practice covers the following topics:
• Viewing request details of a completed report
• Clearing all monitored requests from the Request

Center
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Practice 7 Instructions with Solution
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Practice 7 Instructions
with Solution

Practice 7 Instructions
with Solution

In this practice, you will use the request center to do
the following:
• View the request details of your completed report
• Add it to your hotlist
• Clear all completed requests

In this practice, you will use the request center to do
the following:
• View the request details of your completed report
• Add it to your hotlist
• Clear all completed requests

Practice Instructions
In this practice, you will view the request details of a complete report, add it to
your hotlist, and clear all completed requests.
Step 1: View Request Details
Select the first report shown on the Completed tab of the Request Center. View
the request details of this report.
Step 2: Add the Request to the Hotlist
Add the first report that is shown on the Completed tab of the Request Center to
your hotlist.
Step 3: Clear Requests
Clear the Request Center of all requests.
Hint: If you need help, you can either go back to the lesson for more information,
or review the solutions.
Step 1: View Request Details
1. Open the Request Center window.
2. Click the Completed tab and highlight the first report shown.
3. Click the Show Request Details icon on the Request Center toolbar, then click

OK when you are finished.
Step 2: Add Request to the Hotlist
1. Highlight the first report on the Completed tab.
2. Click the Add Request to Hot List icon on the Request Center toolbar.
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3. View the same request in the Hot List tab.
Step 3: Clear Requests
1. Click Select Stop Monitoring All Requests on the Request Center toolbar.
2. The Request Center is now cleared of all requests.
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Setting Request Center Options
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Setting Request Center OptionsSetting Request Center Options

You can set the following Request Center options:
• Update Every - The interval, in seconds, that the

Request Center waits between queries while monitoring
requests

• Query Last - The number of requests that are retrieved
in the Select Request to Monitor window when you click
the Query button (This can be changed when
monitoring)

• Flash Notification - The number of times the title bar
flashes when a request completes

• Display - The Oracle Applications requests that are
monitored by selecting the application name from the
drop-down list

You can set the following Request Center options:
• Update Every - The interval, in seconds, that the

Request Center waits between queries while monitoring
requests

• Query Last - The number of requests that are retrieved
in the Select Request to Monitor window when you click
the Query button (This can be changed when
monitoring)

• Flash Notification - The number of times the title bar
flashes when a request completes

• Display - The Oracle Applications requests that are
monitored by selecting the application name from the
drop-down list

(Help) Oracle Financial Applications > Applications Desktop
Integrator > The Request Center > Setting Request Center Options
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Setting Request Center Options (continued)
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Setting Request Center Options
(continued)

Setting Request Center Options
(continued)

• Sounds - The audible alert when a request finishes
processing

• Output Viewer - The program that you want to use
to view report output or request logs

• Print Settings - The default font used when
printing reports to a local printer

• Language Options - The language used in
windows, menus, and tool tips (At installation, the
language defaults from the one set at the
database)

• Sounds - The audible alert when a request finishes
processing

• Output Viewer - The program that you want to use
to view report output or request logs

• Print Settings - The default font used when
printing reports to a local printer

• Language Options - The language used in
windows, menus, and tool tips (At installation, the
language defaults from the one set at the
database)

(Help) Oracle Financial Applications > Applications Desktop
Integrator > The Request Center > Setting Request Center Options
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Specifying a Sound File for Request Completion
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Specifying a Sound File for Request
Completion

Specifying a Sound File for Request
Completion

You can have an audible alert notify you when a
request finishes processing or when an error occurs.
All you need to do is select a sound (WAV) file.

• When you install ADI, some sound files are added
to the Orant\GLDI90\Sounds or
orawin95\GLDI90\Sounds directory on your PC.
You can use one of these sound files or provide
your own.

• The error alert only recognizes processes that
have completed in error in the Concurrent
Manager.

You can have an audible alert notify you when a
request finishes processing or when an error occurs.
All you need to do is select a sound (WAV) file.

• When you install ADI, some sound files are added
to the Orant\GLDI90\Sounds or
orawin95\GLDI90\Sounds directory on your PC.
You can use one of these sound files or provide
your own.

• The error alert only recognizes processes that
have completed in error in the Concurrent
Manager.

(Help) Oracle Financial Applications > Applications Desktop
Integrator > The Request Center > Specifying a Sound File for
Request Completion
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How to Specify a Sound File for Request Completion
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How to Specify a Sound File for Request
Completion

How to Specify a Sound File for Request
Completion

1.  Click the Options button on the Request Center
toolbar and select the Play Sound When Request
Completes check box.

2.  For successful completions, click the Find button
for the Normal field. For errors, click the Find
button for the Error field.

3.  From the Choose Sound File window, select the
drive, directory, and filename for your sound file.

4.  (Optional) Click the Test button to hear the sound
you selected.

1.  Click the Options button on the Request Center
toolbar and select the Play Sound When Request
Completes check box.

2.  For successful completions, click the Find button
for the Normal field. For errors, click the Find
button for the Error field.

3.  From the Choose Sound File window, select the
drive, directory, and filename for your sound file.

4.  (Optional) Click the Test button to hear the sound
you selected.

(Help) Oracle Financial Applications > Applications Desktop
Integrator > The Request Center > Specifying a Sound File for
Request Completion
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Agenda
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AgendaAgenda

• Overview of Submitting, Analyzing, and Publishing
Reports.

• Submitting and Publishing Reports
• Analyzing Reports

• Overview of Submitting, Analyzing, and Publishing
Reports.

• Submitting and Publishing Reports
• Analyzing Reports
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Analyze Report Features
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Analyze Report FeaturesAnalyze Report Features

• Analyze Report offers full support for average
balances and cross-set of books drilldown

• Segment security is enforced using the Oracle
General Ledger (GL) profile option FSG: Enforce
Segment Value Security

• With multidimensional data analysis, you can drag
account segments, periods, and other dimensions
to different areas of your drill window. Analyze
Report reorganizes the displayed information to
reflect your new dimensions

• Data can be exported to Microsoft Excel or the
Windows clipboard

• Analyze Report offers full support for average
balances and cross-set of books drilldown

• Segment security is enforced using the Oracle
General Ledger (GL) profile option FSG: Enforce
Segment Value Security

• With multidimensional data analysis, you can drag
account segments, periods, and other dimensions
to different areas of your drill window. Analyze
Report reorganizes the displayed information to
reflect your new dimensions

• Data can be exported to Microsoft Excel or the
Windows clipboard

(Help) Oracle Financial Applications > Applications Desktop
Integrator > Analysis Wizard > Analysis Wizard Features
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Analyze Report Features (continued)
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Analyze Report Features (continued)Analyze Report Features (continued)

• You can drill down to summary accounts, detail
accounts, journal details, and subledger details

Note: Before you can use Analyze Report, you must
use Request Center to publish a financial report to a
Microsoft Excel spreadsheet.

• You can drill down to summary accounts, detail
accounts, journal details, and subledger details

Note: Before you can use Analyze Report, you must
use Request Center to publish a financial report to a
Microsoft Excel spreadsheet.

(Help) Oracle Financial Applications > Applications Desktop
Integrator > Analysis Wizard > Analysis Wizard Features
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How to Start Analyze Report
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How to Start Analyze ReportHow to Start Analyze Report

1.  Publish a financial report to a Microsoft Excel
spreadsheet and select a specific financial amount
(not a calculated amount).

2.  Click Analyze Report on the Applications Desktop
Integrator (ADI) toolbar or double-click on the
amount.

Note: You must enable the double-click analysis
functionality in the Environment region of the Default
Drill Options window for Analyze Report.

1.  Publish a financial report to a Microsoft Excel
spreadsheet and select a specific financial amount
(not a calculated amount).

2.  Click Analyze Report on the Applications Desktop
Integrator (ADI) toolbar or double-click on the
amount.

Note: You must enable the double-click analysis
functionality in the Environment region of the Default
Drill Options window for Analyze Report.
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How to Start Analyze Report (continued)
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How to Start Analyze Report (continued)How to Start Analyze Report (continued)

3.  The Context window opens, displaying information
about the amount on which you have chosen to
drill down. Included is the amount, what the
amount includes (Detail, Summary, or Both
balances), the period, the currency, and the
amount type.

3.  The Context window opens, displaying information
about the amount on which you have chosen to
drill down. Included is the amount, what the
amount includes (Detail, Summary, or Both
balances), the period, the currency, and the
amount type.
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Using the Context Window
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Using the Context WindowUsing the Context Window

The Context window includes the following five
buttons:
• View/Filter - View all of the effective account

ranges associated with the amount in the Context
window

• Show Summary Accounts - Drill down to the
summary accounts and amounts if summary
account ranges have been defined in the Context
window

• Show Detail Accounts - Drill down to the detail
accounts and amounts if detail account ranges
have been defined in the Context window

The Context window includes the following five
buttons:
• View/Filter - View all of the effective account

ranges associated with the amount in the Context
window

• Show Summary Accounts - Drill down to the
summary accounts and amounts if summary
account ranges have been defined in the Context
window

• Show Detail Accounts - Drill down to the detail
accounts and amounts if detail account ranges
have been defined in the Context window
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Using the Context Window (continued)
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Using the Context Window (continued)Using the Context Window (continued)

• Drill Options - Change the drill options
• Data Source - Open the Drill Source window to

view reference information such as the GL
database, application, workbook name, worksheet
name, and worksheet cell

• Drill Options - Change the drill options
• Data Source - Open the Drill Source window to

view reference information such as the GL
database, application, workbook name, worksheet
name, and worksheet cell



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Submitting, Analyzing, and Publishing Reports
Chapter 22 - Page 86

About the Analyze Report Toolbar
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About the Analyze Report ToolbarAbout the Analyze Report Toolbar

From the Analyze Report toolbar, you can access all
the features of Analyze Report for drilling down to
detail accounts and balances.

From the Analyze Report toolbar, you can access all
the features of Analyze Report for drilling down to
detail accounts and balances.

(Help) Oracle Financial Applications > Applications Desktop
Integrator > Analysis Wizard > Analysis Wizard Toolbar
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How to use the Analyze Report Toolbar
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How to use the Analyze Report ToolbarHow to use the Analyze Report Toolbar

1.  Window - Navigate to an open drilldown window
2.  Export to Excel - Export the highlighted balance

information to a Microsoft Excel worksheet
3.  Export to Clipboard - Export the highlighted

balance information to the Windows clipboard
4.  Print - Print the currently active drill window

(Analyze Report displays a print preview window
first. From the preview window, you can set your
print options)

5.  General Options - Set the default drill options

1.  Window - Navigate to an open drilldown window
2.  Export to Excel - Export the highlighted balance

information to a Microsoft Excel worksheet
3.  Export to Clipboard - Export the highlighted

balance information to the Windows clipboard
4.  Print - Print the currently active drill window

(Analyze Report displays a print preview window
first. From the preview window, you can set your
print options)

5.  General Options - Set the default drill options

(Help) Oracle Financial Applications > Applications Desktop
Integrator > Analysis Wizard > Analysis Wizard Toolbar
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How to use the Analyze Report Toolbar (continued)
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How to use the Analyze Report Toolbar
(continued)

How to use the Analyze Report Toolbar
(continued)

6.  Show Performance Information - Display technical
information about a highlighted amount
in the currently active drill window

7.  Help - Access the online Help features of Analyze
Report

8.  Minimize - Minimize the toolbar
9.  Exit - Close and exit Analyze Report

6.  Show Performance Information - Display technical
information about a highlighted amount
in the currently active drill window

7.  Help - Access the online Help features of Analyze
Report

8.  Minimize - Minimize the toolbar
9.  Exit - Close and exit Analyze Report

(Help) Oracle Financial Applications > Applications Desktop
Integrator > Analysis Wizard > Analysis Wizard Toolbar
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Possible Drilldown FlowsPossible Drilldown Flows

 Subledger Details 

 Context 1

Amount $7,000

 Summary 

T.199  2,000
T.299  4,000
T.399  1,000

 Detail for T.299 

01.200  2,000
01.201     500
01.202  1,500

 Journal Details 

Line 10  01.202  800
Line 20  01.202  450
Line 30  01.202  250

BusinessWorld  Inv#1923  7/15/98  800
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DemonstrationDemonstration

This demonstration shows you how to:
• Submit a financial statement to your spreadsheet
• Drill down on an expense amount
• View the account ranges and detail accounts that

make up the amount
• Define drill options
• Application Desktop Integrator > Ledger > Analyze

Report

This demonstration shows you how to:
• Submit a financial statement to your spreadsheet
• Drill down on an expense amount
• View the account ranges and detail accounts that

make up the amount
• Define drill options
• Application Desktop Integrator > Ledger > Analyze

Report



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Submitting, Analyzing, and Publishing Reports
Chapter 22 - Page 91

Practice 8 Overview

Copyright © Oracle Corporation, 2001. All rights reserved.
®

Practice 8 OverviewPractice 8 Overview

This practice covers the following topics:
• Submitting a financial statement to your

spreadsheet
• Drilling down on an expense amount
• Viewing the account ranges and detail accounts

that make up the amount
• Defining drill options

This practice covers the following topics:
• Submitting a financial statement to your

spreadsheet
• Drilling down on an expense amount
• Viewing the account ranges and detail accounts

that make up the amount
• Defining drill options
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Practice 8 Instructions
with Solution

Practice 8 Instructions
with Solution

In this practice, you will submit a financial report and
use Analyze Report to view account details.
• Submit and publish a  financial report with content

set
• Drill down to period expense detail
• View and select drill options
• View account ranges and detail accounts that

comprise an amount

In this practice, you will submit a financial report and
use Analyze Report to view account details.
• Submit and publish a  financial report with content

set
• Drill down to period expense detail
• View and select drill options
• View account ranges and detail accounts that

comprise an amount

Practice 8 Instructions
In this practice, you will submit a financial report and use Analyze Report to view

account details.
Step 1: Submit and Publish a Financial Report
1. Submit and publish the Summary Income Statement for the period Jun-97 to a

spreadsheet.
2. Use the content set Expand by Sales Department for this financial report.
Step 2: Drill Down on an Amount and View Details
1. Drill down on operating expenses for QTD-Actual for Jun-97.

What is this amount? ___________________________
2. View the ranges for this amount. How many effective ranges does this amount

have? _____________
3. View the drill options for this amount and select the following options:

• Show Account Type
• Suppress Zero Balances
• Show Outline Indicators
• Show Totals
• Include Descriptions for Account Segment

4. View the detail accounts that make up this amount.
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What is the ending balance in the Total column? ______________________
How does this amount relate to the amount in the Summary Income
Statement?______________________________________________________

Note: Do not close the Detail Balances window in Analyze Report. You will use
this window for the next practice.

Step 1: Submit and Publish a Financial Report
1. Click the Submit Request icon on the Request Center toolbar.
2. Select Financial Statement.
3. Select the Summary Income Statement report for the period Jun-97. Use the

Expand by Sales Department content set.
4. Click Publishing and select the Spreadsheet output type.
5. Click the green check mark to submit your report, then click OK when the

message appears that your report was submitted successfully.
6. When the Request Center prompt appears, click Yes to publish your report.
Step 2: Drill Down on an Amount and View Details
1. Select the amount for Jun-97 operating expenses for QTD-Actual. What is this

amount? 2,071,176.00
2. Click the Analyze Report icon to open the Context window and drill down on

this amount.
3. Click View/Filter to see the ranges. How many effective ranges does this

amount have? Two
4. Click OK to close this window.
5. Click the Drill Options button.
6. Select or enter the values: Individually;  Account, Show Account Type,

Suppress Zero Balances, Show OutlineIndicators, Show Totals
7. Click OK to close the Drill Options window.
8. Click the Show Detail Accounts button.
9. Use the scroll bar on the right to get a better view.
10. What is the ending balance in the Total column? 2,071,175.92. How does this

amount relate to the amount in the Summary Income Statement?
They are identical. The total amount shown reconciles with the amount that
you initially drilled down on.

Note: Do not close the Detail Balances window in Analyze Report. You will use
this window for the next practice.
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Using Dimensions and Display Options
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Using Dimensions and Display OptionsUsing Dimensions and Display Options

You can use the online analytical processing (OLAP)
capabilities of Analyze Report to pivot your report
dimensions—your individual account segments—in
real time.
• This enables you to work through various

scenarios, rather than writing several custom
reports

• Analyze Report creates a matrix showing the
detailed accounts by period. The matrix has three
dimensions: page, row, and column

• Note: The row dimension values are the flexfield
segment values, and the column dimension values
are time

You can use the online analytical processing (OLAP)
capabilities of Analyze Report to pivot your report
dimensions—your individual account segments—in
real time.
• This enables you to work through various

scenarios, rather than writing several custom
reports

• Analyze Report creates a matrix showing the
detailed accounts by period. The matrix has three
dimensions: page, row, and column

• Note: The row dimension values are the flexfield
segment values, and the column dimension values
are time

(Help) Oracle Financial Applications > Applications Desktop
Integrator > Analysis Wizard > Drilling Down to Summary and Detail
Accounts
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How to Change Your ViewHow to Change Your View

How to Change Your View
• Simply drag one segment (such as the account

segment) from one dimension (the row dimension)
and drop it into another dimension (such as the
column dimension)

• Use your right mouse button to quickly move
segments to the row dimension or the page
dimension

• The right mouse button also enables you to show
all values or to limit the values to view by filtering
the values

How to Change Your View
• Simply drag one segment (such as the account

segment) from one dimension (the row dimension)
and drop it into another dimension (such as the
column dimension)

• Use your right mouse button to quickly move
segments to the row dimension or the page
dimension

• The right mouse button also enables you to show
all values or to limit the values to view by filtering
the values

(Help) Oracle Financial Applications > Applications Desktop
Integrator > Analysis Wizard > Drilling Down to Summary and Detail
Accounts
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DemonstrationDemonstration

This demonstration shows you how to:
• Manipulate dimension values to change how you

view your data
• Limit the periods to view
• Limit the accounts to view
• Show the journal details of a selected amount
• Application Desktop Integrator > Ledger > Analyze

Report > Context window > (B) Show Details >
Detail Balances

This demonstration shows you how to:
• Manipulate dimension values to change how you

view your data
• Limit the periods to view
• Limit the accounts to view
• Show the journal details of a selected amount
• Application Desktop Integrator > Ledger > Analyze

Report > Context window > (B) Show Details >
Detail Balances
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Practice 9 OverviewPractice 9 Overview

This practice covers the following topics:
• Manipulating dimension values to change how you

view your data
• Limiting the periods to view
• Limiting the accounts to view
• Showing the journal details of a selected amount

This practice covers the following topics:
• Manipulating dimension values to change how you

view your data
• Limiting the periods to view
• Limiting the accounts to view
• Showing the journal details of a selected amount
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Practice 9 Instructions
with Solution

Practice 9 Instructions
with Solution

In this practice, you will change dimension values to
change how you view your data including the
following:
• Limiting the periods to view
• Limiting the accounts to view
• Showing the journal details of a selected amount

In this practice, you will change dimension values to
change how you view your data including the
following:
• Limiting the periods to view
• Limiting the accounts to view
• Showing the journal details of a selected amount

Practice Instructions
In this practice, you will change the dimensions in your drill. You will view the

journal details of an account balance, as well.
Step 1: Change Your View
1. Click the Company dimension value and drag it to the upper left corner of the

window, below the Analysis Wizard toolbar. Do the same with the Sub-
Account, Product, and Type dimensions. Company, Sub-Account, Product,
and Type are now page dimensions.

2. Move the Account, Account Description, and Department dimensions by
dragging them to the column area.

3. Click the Period dimension with the right mouse button and select Move to
Row.

Step 2: Limit the Periods to View
View the periods Apr-97 and May-97 only.

Step 3: Change Your View Again
Change your view again to look like the following example, but this time do
not view accounts 7410 through 7510.

Hint: Click Account with the right mouse button and select Filter Values.
Step 4: Show Journal Details
One of the most powerful features of Analyze Report is its ability to show journal
details for a number.
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1. View the Show Journal Details for Account 01.402.7110.0000.000 for Apr-
97.

2. When finished reviewing the journal entry, return to the Detail Accounts
window.

Practice Solution
Step 1: Change Your View
1. Click the Company dimension value and drag it to the upper left corner of the

window, below the Analysis Wizard toolbar. Do the same with the Sub-
Account, Product, and Type dimensions. Company, Sub-Account, Product,
and Type are now page dimensions.

2. Move the Account, Account Description, and Department dimensions by
dragging them to the column area.

3. Click the Period dimension with the right mouse button and select Move to
Row.

Step 2: Limit the Periods to View
1. Click the down arrow on the Period dimension to display the data values for

the period. Notice that Apr-97, May-97, and Jun-97 have been selected.
2. Clear Jun-97. Your matrix now displays only values from Apr-97 to May-97.
Step 3: Change Your View Again
1. Move the Period dimension back to the column area. Enable Jun-97.
2. Move the Department and Account dimensions back to the row area.
3. Move the Company dimension back to the row area, before Department.

Move the Sub-Account and Product dimensions to the row area, after
Account. Minimize the width of the Period columns.

4. Place the cursor anywhere in the Account column and click the right mouse
button. Select Filter Values from the drop-down menu.

5. Clear the check boxes for accounts 7410, 7420, 7450, and 7510.
Step 4: Show Journal Details
1. Select the value for Account 01.402.7110.0000.000 for Apr-97.
2. Click the Show Journal Details button. The following window appears:
3. Click Return to Detail Accounts.
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How to Export to Microsoft Excel
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How to Export to Microsoft ExcelHow to Export to Microsoft Excel

1.  Select an amount in the Detail Balances - Net
window and click Export to Excel on the Analyze
Report toolbar.

2.  Under Export, select Current Window to export the
entire window.

3.  Under Workbook, select New to export to a new
workbook, or Current to export to the open
workbook.

4.  Select the Apply Formatting check box to format
the worksheet in the same way as the Analyze
Report window, with colors and lines

5.  View your export in a spreadsheet.

1.  Select an amount in the Detail Balances - Net
window and click Export to Excel on the Analyze
Report toolbar.

2.  Under Export, select Current Window to export the
entire window.

3.  Under Workbook, select New to export to a new
workbook, or Current to export to the open
workbook.

4.  Select the Apply Formatting check box to format
the worksheet in the same way as the Analyze
Report window, with colors and lines

5.  View your export in a spreadsheet.

(Help) Oracle Financial Applications > Applications Desktop
Integrator > Analysis Wizard > Analysis Wizard Toolbar
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Viewing Your Exported Data
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Viewing Your Exported DataViewing Your Exported Data

ADI creates a new worksheet using the account
combinations, periods, and balances from the
drilldown window.

ADI creates a new worksheet using the account
combinations, periods, and balances from the
drilldown window.
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Practice 10 OverviewPractice 10 Overview

This practice covers exporting data to Microsoft
Excel.
This practice covers exporting data to Microsoft
Excel.
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Practice 10 Instructions
with Solution

Practice 10 Instructions
with Solution

In this practice, you will export data from the drill
window to Microsoft Excel.
• Export: Current Window and Workbook: Current
• Use Apply Formatting option

In this practice, you will export data from the drill
window to Microsoft Excel.
• Export: Current Window and Workbook: Current
• Use Apply Formatting option

Practice Instructions
In this practice, you will export data from the drill window to Microsoft
Excel.
Using the report drilldown from the previous practice, store the results of your
analysis on your current spreadsheet workbook.

Practice Solution
1. Click the Export to Excel option on the Analyze Report toolbar.
2. Select Export: Current Window and Workbook: Current.
3. Select the Apply Formatting option.
4. Click Finish to export to Excel.
5. Maximize Microsoft Excel. The following window appears:
6. Exit Analyze Report.
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Setting Analyze Report OptionsSetting Analyze Report Options

• Click the General Options button on the Analyze Report
toolbar

• Optionally, you can click the Options icon on the ADI
toolbar, then select Ledger Options from the list of
values

• Click the Report Analysis tab to open the window
Current Drill Options

• Click the General Options button on the Analyze Report
toolbar

• Optionally, you can click the Options icon on the ADI
toolbar, then select Ledger Options from the list of
values

• Click the Report Analysis tab to open the window
Current Drill Options
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Setting Analyze Report Options
(continued)

Setting Analyze Report Options
(continued)

Select Grouped to have your account segments displayed
as one value, or Individual to perform multidimensional
analysis of your drill-down data.
• Show Account Type - Select this option to

automatically show the account type when you
drill down to detail accounts

• Suppress Zero Balances - Select this option if you
do not want zero balance amounts to be displayed
in your drill windows.

• Show Outline Indicators - Select this option
displays expand or collapse indicators in your drill
windows.

Select Grouped to have your account segments displayed
as one value, or Individual to perform multidimensional
analysis of your drill-down data.
• Show Account Type - Select this option to

automatically show the account type when you
drill down to detail accounts

• Suppress Zero Balances - Select this option if you
do not want zero balance amounts to be displayed
in your drill windows.

• Show Outline Indicators - Select this option
displays expand or collapse indicators in your drill
windows.
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Setting Analyze Report Options (continued)
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Setting Analyze Report Options
(continued)

Setting Analyze Report Options
(continued)

• Totals - This option includes totals for rows and
columns in your drill windows.

• Include Descriptions for - This options displays
descriptions for your account balancing segment, cost
center segment, and natural account segment.

• Minimum Amount  Width - Use this field to select the
minimum column width to use.

• Double Click Drill Enabled - Select this option to drill
down by double-clicking an amount from one of the
displayed drill windows, or drill down on amounts from
your spreadsheet-published report output without
having to select the Analyze Report icon.

• Totals - This option includes totals for rows and
columns in your drill windows.

• Include Descriptions for - This options displays
descriptions for your account balancing segment, cost
center segment, and natural account segment.

• Minimum Amount  Width - Use this field to select the
minimum column width to use.

• Double Click Drill Enabled - Select this option to drill
down by double-clicking an amount from one of the
displayed drill windows, or drill down on amounts from
your spreadsheet-published report output without
having to select the Analyze Report icon.
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Setting Analyze Report Options (continued)
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Setting Analyze Report Options
(continued)

Setting Analyze Report Options
(continued)

• Hide Windows When Navigating - Select this option to
close the active drill window when you drill up to the
previous or down to next drill window.

• Maximum Active Drills - Use this field to select a
maximum number of drill context windows you can
have active at one time.

Note: Each open drill window consumes system resources.
Use the Maximum Active Drills option to prevent accidental
overload of your PC.

• Hide Windows When Navigating - Select this option to
close the active drill window when you drill up to the
previous or down to next drill window.

• Maximum Active Drills - Use this field to select a
maximum number of drill context windows you can
have active at one time.

Note: Each open drill window consumes system resources.
Use the Maximum Active Drills option to prevent accidental
overload of your PC.
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Setting Profile OptionsSetting Profile Options

You can set the following profile options for Analyze
Report:
• GLDI: Maximum Effective Ranges for Drilldown

(optional) You can set the maximum effective
ranges for drilldown for Analyze Report

• GLDI: Allow Drilldown Across Books When
working with Analyze Report, this option enables
the user to drill down across sets of books

• GLDI: Analysis Wizard Privileges This option
enables or disables access to Analyze Report

You can set the following profile options for Analyze
Report:
• GLDI: Maximum Effective Ranges for Drilldown

(optional) You can set the maximum effective
ranges for drilldown for Analyze Report

• GLDI: Allow Drilldown Across Books When
working with Analyze Report, this option enables
the user to drill down across sets of books

• GLDI: Analysis Wizard Privileges This option
enables or disables access to Analyze Report

Applied Technology > Oracle Applications System Administration >
Setting Profile Options > System Profile Value Window
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SummarySummary

In this module you should have learned how to:
• Identify the toolbar icons and tabs of the Request

Center window and submit financial and standard
reports

• Publish to a spreadsheet, Web page, text file and create
themes to format report outputs

• Setup Request Center
• Identify the icons on the Analyze Report toolbar and

drill down to various types of balances
• Manipulate dimensions to change your analysis views

and export analysis to a Microsoft Excel

In this module you should have learned how to:
• Identify the toolbar icons and tabs of the Request

Center window and submit financial and standard
reports

• Publish to a spreadsheet, Web page, text file and create
themes to format report outputs

• Setup Request Center
• Identify the icons on the Analyze Report toolbar and

drill down to various types of balances
• Manipulate dimensions to change your analysis views

and export analysis to a Microsoft Excel
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R11i Implementing Applications Desktop Integrator
(ADI)
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R11i Implementing Applications Desktop
Integrator (ADI)

R11i Implementing Applications Desktop
Integrator (ADI)
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ObjectivesObjectives

After completing this course, you should be able to
do the following:
• Explain the ADI features
• Describe the ADI functionality
• Demonstrate how to sign on to ADI
• Demonstrate how to set up ADI

After completing this course, you should be able to
do the following:
• Explain the ADI features
• Describe the ADI functionality
• Demonstrate how to sign on to ADI
• Demonstrate how to set up ADI
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AgendaAgenda

• Overview of the ADI features
• Overview of the ADI functionality
• Signing on to ADI
• Setting up ADI

• Overview of the ADI features
• Overview of the ADI functionality
• Signing on to ADI
• Setting up ADI
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AgendaAgenda

• Overview of the ADI features
• Overview of the ADI functionality
• Signing on to ADI
• Setting up ADI

• Overview of the ADI features
• Overview of the ADI functionality
• Signing on to ADI
• Setting up ADI
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ADI FamilyADI Family

Assets
Integration

Assets
Integration

General
Ledger

Integration

General
Ledger

Integration
Request
Center

Request
Center

• Submit reports
  and programs
• Publishing
• Use themes
• Monitor requests

• Journals
• Budgets
• Reports
• Analysis
• Account Hierarchy
  Editor

• Record physical
  inventory
• Create assets
• Import text files
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Oracle Applications and ADIOracle Applications and ADI

• ADI is a family of products that provide a
spreadsheet front end to Oracle Applications.

• ADI is compatible with:
–  Oracle Assets Release 10.7 and later.
– Oracle General Ledger 10.7 and later.

• ADI is a family of products that provide a
spreadsheet front end to Oracle Applications.

• ADI is compatible with:
–  Oracle Assets Release 10.7 and later.
– Oracle General Ledger 10.7 and later.
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Supported Microsoft Excel VersionsSupported Microsoft Excel Versions

The following are the Microsoft Excel versions that
are supported:
• Microsoft Excel 7.0
• Microsoft Excel 97
• Microsoft Excel 2000
Note: Earlier versions of Microsoft Excel are no
longer supported in this release.

The following are the Microsoft Excel versions that
are supported:
• Microsoft Excel 7.0
• Microsoft Excel 97
• Microsoft Excel 2000
Note: Earlier versions of Microsoft Excel are no
longer supported in this release.
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ADI HistoryADI History

• ADI used to be known as General Ledger Desktop
Integrator (GLDI) because it could only function
with Oracle General Ledger.
– It was included with the Oracle General Ledger

installation disks.

• ADI used to be known as General Ledger Desktop
Integrator (GLDI) because it could only function
with Oracle General Ledger.
– It was included with the Oracle General Ledger

installation disks.
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• With release 4.0, integration for Oracle Assets was
added, and the name was changed from GLDI to
ADI.

• Until version 4.0, the installation disk also
included functionality for other applications,
including Oracle Assets Report eXchange, Human
Resource Management System Application Data
Export, and Oracle Projects Connect.

• These products are still available with the
exception of Oracle Assets Report eXchange,
which is now part of the Request Center.

• With release 4.0, integration for Oracle Assets was
added, and the name was changed from GLDI to
ADI.

• Until version 4.0, the installation disk also
included functionality for other applications,
including Oracle Assets Report eXchange, Human
Resource Management System Application Data
Export, and Oracle Projects Connect.

• These products are still available with the
exception of Oracle Assets Report eXchange,
which is now part of the Request Center.
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Review QuestionReview Question

Applications Desktop Integrator used to be known as:
1. Oracle Projects Connect
2. Fixed Asset Desktop Integrator
3. Oracle Assets Report eXchange
4. General Ledger Desktop Integrator
5. Human Resource Management System Application

Data Export

Applications Desktop Integrator used to be known as:
1. Oracle Projects Connect
2. Fixed Asset Desktop Integrator
3. Oracle Assets Report eXchange
4. General Ledger Desktop Integrator
5. Human Resource Management System Application

Data Export
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Answer to Review QuestionAnswer to Review Question

Applications Desktop Integrator used to be known as:
1. Oracle Projects Connect
2. Fixed Asset Desktop Integrator
3. Oracle Assets Report eXchange
4. General Ledger Desktop Integrator
5. Human Resource Management System Application

Data Export

Applications Desktop Integrator used to be known as:
1. Oracle Projects Connect
2. Fixed Asset Desktop Integrator
3. Oracle Assets Report eXchange
4. General Ledger Desktop Integrator
5. Human Resource Management System Application

Data Export
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• Overview of the ADI features
• Overview of the ADI functionality
• Signing on to ADI
• Setting up ADI

• Overview of the ADI features
• Overview of the ADI functionality
• Signing on to ADI
• Setting up ADI
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General Ledger FunctionalityGeneral Ledger Functionality

Account Hierarchy EditorAccount Hierarchy EditorAccount Hierarchy Editor

Enter JournalsEnter JournalsEnter Journals

Enter BudgetsEnter BudgetsEnter Budgets

Define ReportDefine ReportDefine Report

Request CenterRequest CenterRequest Center

Analyze ReportAnalyze ReportAnalyze Report

(Help) Oracle Financial Applications > Applications Desktop
Integrator > Introduction > General Ledger
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Assets FunctionalityAssets Functionality

Create AssetsCreate AssetsCreate Assets

Record Physical InventoryRecord Physical InventoryRecord Physical Inventory

Import Text FilesImport Text FilesImport Text Files

Request CenterRequest CenterRequest Center

(Help) Oracle Financial Applications > Applications Desktop
Integrator > Introduction > Oracle Assets
(Help) Oracle Financial Applications > Applications Desktop
Integrator > Introduction > Oracle Applications
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• Overview of the ADI features
• Overview of the ADI functionality
• Signing on to ADI
• Setting up ADI
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How to Sign On to ADIHow to Sign On to ADI

• To use Oracle Applications, you need an Oracle
Applications sign-on, which consists of a unique
username and password.
– These are different from the username and

password you use to sign on to your
computer.

– If you are not sure of your Oracle Applications
sign-on, consult your system administrator.

• Oracle Applications security is based on your
sign-on, since this connects you to your
responsibilities, which control your access to
applications, functions, reports, and data.

• To use Oracle Applications, you need an Oracle
Applications sign-on, which consists of a unique
username and password.
– These are different from the username and

password you use to sign on to your
computer.

– If you are not sure of your Oracle Applications
sign-on, consult your system administrator.

• Oracle Applications security is based on your
sign-on, since this connects you to your
responsibilities, which control your access to
applications, functions, reports, and data.

(Help) Oracle Financial Applications > Applications Desktop
Integrator > Getting Started with ADI > Signing on to ADI
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Icon Name Description

Sign On Enter your username, password, and 
responsibility

Change Select a different responsibility once you 
Responsibility have signed on to the database
Ledger Select from the Ledger options

Applications Select either Request Center, Oracle 
Applications, or Microsoft Excel

ADI Toolbar Icon DescriptionsADI Toolbar Icon Descriptions

(Help) Oracle Financial Applications > Applications Desktop
Integrator > Getting Started with ADI > ADI Toolbar
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Icon Name Description

ADI Options Define options for your toolbar, worksheet
colors, defaults, and settings

Tip Wizard Enable Tip Wizard and select options

Help Access the online Help features of ADI

Minimize Minimize the toolbar

Exit Close and exit ADI

ADI Toolbar Icon DescriptionsADI Toolbar Icon Descriptions
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Option Description

Enter Budgets Create budget worksheets, refresh values, or
edit the budget criteria for the current budget
worksheet

Enter Journals Create a worksheet for entering journals
Define Report Start the Define Report, which can be used

to define Financial Statement Generator 
(FSG) reports, download existing report 
definition, or create content sets

View Account View and create segment values and 
Hierarchy hierarchies

Ledger OptionsLedger Options

(Help) Oracle Financial Applications > Applications Desktop
Integrator > Getting Started with ADI > ADI Toolbar
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Option Description

List of Values Select from a list of valid values for a 
particular item, such as currency or journal
category

Upload to Upload your budget values or journal 
Interface entries to the Oracle General Ledger 

interface tables and start the Submit process

Submit Process Start any of these processes:
• Budget Import
• Journal Import
• Report Submission

Ledger OptionsLedger Options
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Option Description

Insert Budget Insert a new account row into a budget 
Account worksheet

Apply Budget Use budget rules, such as Repeat per Cell or
Rule Divide Evenly by Row, to update your 

budgets

Add Budget Append notes to an entire budget, to an 
Note account, or to individual amounts in a 

budget worksheet
Create Graph View your budget balances in graph form

Ledger OptionsLedger Options
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Option Description

Create Assets Create an asset worksheet, enter asset data,
and upload to Oracle

Record Create a physical inventory worksheet, enter
Physical inventory data, and upload to Oracle Assets
Inventory
Import Text Import a text file containing asset or physical
File inventory data that you can format in a 

Microsoft Excel spreadsheet and upload to
Oracle Assets

Asset OptionsAsset Options

(Help) Oracle Financial Applications > Applications Desktop
Integrator > Getting Started with ADI > ADI Toolbar
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Option Description

List of Values Select from a list of valid values for a 
particular item, such as location or category

Upload to Upload your asset and physical inventory
Interface data to the Oracle Assets interface tables;

submit the import
Submit Process Start either of these processes:

• Post Mass Additions
• Compare Physical Inventory

Asset OptionsAsset Options
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Option Description

Request Center Submit and monitor requests, publish 
reports

Applications Start Oracle Applications

Excel Start Microsoft Excel

Applications OptionsApplications Options

(Help) Oracle Financial Applications > Applications Desktop
Integrator > Getting Started with ADI > ADI Toolbar



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Implementing ADI
Chapter 23 - Page 26

Review Question

Copyright © Oracle Corporation, 2001. All rights reserved.
®

Review QuestionReview Question

Using the Upload to Interface option, you can upload
budget values or journal entries to the Oracle General
Ledger interface tables, or upload your asset and
physical inventory data to the Oracle Assets interface
tables.
1. True
2. False

Using the Upload to Interface option, you can upload
budget values or journal entries to the Oracle General
Ledger interface tables, or upload your asset and
physical inventory data to the Oracle Assets interface
tables.
1. True
2. False
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Answer to Review QuestionAnswer to Review Question

Using the Upload to Interface option, you can upload
budget values or journal entries to the Oracle General
Ledger interface tables, or upload your asset and
physical inventory data to the Oracle Assets interface
tables.
1. True
2. False

Using the Upload to Interface option, you can upload
budget values or journal entries to the Oracle General
Ledger interface tables, or upload your asset and
physical inventory data to the Oracle Assets interface
tables.
1. True
2. False
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Using the ADI Options PoplistUsing the ADI Options Poplist

From the ADI Options poplist, you can modify your
toolbar, set other options, and view information about
ADI.
• Toolbar Options: You can use Toolbar Options to

add, delete, or arrange icons on the ADI toolbar.
– You can customize your toolbar and display

icons in any order you choose.
• Switch Orientation: Selecting this option switches

your toolbar from horizontal to vertical display (or
vertical to horizontal).

• Reset Icons: Select this option to reset your
toolbar to the default ADI toolbar.

From the ADI Options poplist, you can modify your
toolbar, set other options, and view information about
ADI.
• Toolbar Options: You can use Toolbar Options to

add, delete, or arrange icons on the ADI toolbar.
– You can customize your toolbar and display

icons in any order you choose.
• Switch Orientation: Selecting this option switches

your toolbar from horizontal to vertical display (or
vertical to horizontal).

• Reset Icons: Select this option to reset your
toolbar to the default ADI toolbar.

(Help) Oracle Financial Applications > Applications Desktop
Integrator > Getting Started with ADI > ADI Options > Toolbar
Options



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Implementing ADI
Chapter 23 - Page 29

ADI Key Equivalents

Copyright © Oracle Corporation, 2001. All rights reserved.
®

Icon/Option Key Equivalents

Sign On [Ctrl] + [Shift] + S

Change Responsibility [Ctrl] + [Shift] + R

Enter Budgets [Ctrl] + [Shift] + B

Enter Journals [Ctrl] + [Shift] + T

Define Report [Ctrl] + [Shift] + D

List of Values [Ctrl] + [Shift] + L

Upload to Interface [Ctrl] + [Shift] + U

Apply Budget Rule [Ctrl] + [Shift] + Z

ADI Key EquivalentsADI Key Equivalents
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ADI Key Equivalents
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Icon/Option Key Equivalents

Add Budget Note [Ctrl] + [Shift] + N

Create Graph [Ctrl] + [Shift] + G

Request Center [Ctrl] + [Shift] + W

Oracle Applications [Ctrl] + [Shift] + A

Excel [Ctrl] + [Shift] + E

ADI Options Menu [Ctrl] + [Shift] + O

Help [Ctrl] + [Shift] + H

Minimize [Ctrl] + [Shift] + M

Exit [Ctrl] + [Shift] + X

ADI Key EquivalentsADI Key Equivalents
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Customizing Your ToolbarCustomizing Your Toolbar

You can add buttons to your toolbar to invoke
programs and processes external to ADI. From the
Toolbar Options window, select the Add Icons tab.
You must specify the following:
• Description: Name of the button that appears

when you place the cursor over the button on the
toolbar.

• Command Line: Name of the program that you
want to launch when you select the button.

• Working Directory: Pathname to the program that
is specified in the Command Line.

You can add buttons to your toolbar to invoke
programs and processes external to ADI. From the
Toolbar Options window, select the Add Icons tab.
You must specify the following:
• Description: Name of the button that appears

when you place the cursor over the button on the
toolbar.

• Command Line: Name of the program that you
want to launch when you select the button.

• Working Directory: Pathname to the program that
is specified in the Command Line.
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DemonstrationDemonstration

This demonstration covers:
• How to sign on to ADI
• The ADI toolbar icon descriptions
• The Ledger and Asset options
• The Applications options
• Using the ADI Options Poplist

(N) ADI > Signon
(N) ADI > Ledger
(N) ADI > Assets
(N) ADI > Applications
(N) ADI > Options

This demonstration covers:
• How to sign on to ADI
• The ADI toolbar icon descriptions
• The Ledger and Asset options
• The Applications options
• Using the ADI Options Poplist

(N) ADI > Signon
(N) ADI > Ledger
(N) ADI > Assets
(N) ADI > Applications
(N) ADI > Options
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AgendaAgenda

• Overview of the ADI features
• Overview of the ADI functionality
• Signing on to ADI
• Setting up ADI

• Overview of the ADI features
• Overview of the ADI functionality
• Signing on to ADI
• Setting up ADI
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Using Diagnostic WizardUsing Diagnostic Wizard

The Diagnostic Wizard verifies the Microsoft
Windows environment to ensure the stability of
Applications Desktop Integrator (ADI), as well as all
Windows software.
The Diagnostic Wizard automatically goes through a
checklist of more than 60 items, and gives specific
feedback with instructions for corrective actions
when it finds issues such as incorrect settings within
ADI, file versions, registries, and configurations.
It can even apply the latest object linking and
embedding (OLE) patches. This ADI utility enables
you to troubleshoot installation problems quickly and
gives you the tools to fix them.

The Diagnostic Wizard verifies the Microsoft
Windows environment to ensure the stability of
Applications Desktop Integrator (ADI), as well as all
Windows software.
The Diagnostic Wizard automatically goes through a
checklist of more than 60 items, and gives specific
feedback with instructions for corrective actions
when it finds issues such as incorrect settings within
ADI, file versions, registries, and configurations.
It can even apply the latest object linking and
embedding (OLE) patches. This ADI utility enables
you to troubleshoot installation problems quickly and
gives you the tools to fix them.
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Running a System CheckRunning a System Check

How to Run a System Check by Using Diagnostic
Wizard.
1. To run the Diagnostic Wizard, select

Start—>Programs—>Oracle ADI—>ADI Diagnostic
Wizard.

2. Click each numbered button to get more details
about the specific test and its result.

How to Run a System Check by Using Diagnostic
Wizard.
1. To run the Diagnostic Wizard, select

Start—>Programs—>Oracle ADI—>ADI Diagnostic
Wizard.

2. Click each numbered button to get more details
about the specific test and its result.
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Running a System CheckRunning a System Check

3. If the Diagnostic Wizard finds problems, a red
indicator replaces the green one to flag the area
that needs to be fixed. Click the appropriate button
to get more information about the problem and
suggestions on how to fix it.

4. When you have completed the diagnostic test, click
Exit to close the Diagnostic Wizard.

3. If the Diagnostic Wizard finds problems, a red
indicator replaces the green one to flag the area
that needs to be fixed. Click the appropriate button
to get more information about the problem and
suggestions on how to fix it.

4. When you have completed the diagnostic test, click
Exit to close the Diagnostic Wizard.
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Setting up a Database in ADISetting up a Database in ADI

How to Set Up a Database in ADI:
1. From the Signon window, click the Define Database

icon.
2. Click the green plus sign button to add a new

database. When you have defined a database, you
can use the pencil button to edit or the red X
button to delete.

3. In the Name and Description fields, enter the name
and description of the database. The name must
be at least six characters. You can enter any name
and description.

How to Set Up a Database in ADI:
1. From the Signon window, click the Define Database

icon.
2. Click the green plus sign button to add a new

database. When you have defined a database, you
can use the pencil button to edit or the red X
button to delete.

3. In the Name and Description fields, enter the name
and description of the database. The name must
be at least six characters. You can enter any name
and description.
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Setting up a Database in ADI
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Setting up a Database in ADISetting up a Database in ADI

4. The GWYUID (Gateway User ID), FNDNAM, and
Connect String fields are system-level parameters
for your database. You must enter text in these
fields. If you do not know this information, consult
your system administrator.

5. The NCA Connection field is used if you want to
launch NCA applications from the ADI toolbar. You
must specify the entire name and directory
location of the applet .bat file. See your system
administrator for more information.

6. The Server ID field is used for database security.
Consult your database administrator for this
information.

4. The GWYUID (Gateway User ID), FNDNAM, and
Connect String fields are system-level parameters
for your database. You must enter text in these
fields. If you do not know this information, consult
your system administrator.

5. The NCA Connection field is used if you want to
launch NCA applications from the ADI toolbar. You
must specify the entire name and directory
location of the applet .bat file. See your system
administrator for more information.

6. The Server ID field is used for database security.
Consult your database administrator for this
information.
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DemonstrationDemonstration

This demonstration covers setting up a database in
ADI.

(N) ADI > Signon > Define Databases > Add

This demonstration covers setting up a database in
ADI.

(N) ADI > Signon > Define Databases > Add
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Setting ADI OptionsSetting ADI Options

• The ADI Options poplist enables you to access
general options for ADI, General Ledger, Request
Center, and language. You can also view sign on
and ADI release information.

• When you are ready to set your ADI options, click
the Options icon on the toolbar. Select the option
that you would like to set from the poplist.

• The ADI Options poplist enables you to access
general options for ADI, General Ledger, Request
Center, and language. You can also view sign on
and ADI release information.

• When you are ready to set your ADI options, click
the Options icon on the toolbar. Select the option
that you would like to set from the poplist.
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Setting General Options: The Worksheet
Colors Tab

Setting General Options: The Worksheet
Colors Tab

Worksheet Colors: Select default color settings for
journal, budget, report, asset, and physical inventory
worksheets.
• You can set colors for field text, field background,

context text, context background, data entry area,
and sheet background.

• The sample worksheet to the left of the Workbook
Regions options reflects your color choices as
you make them.

Note: These color choices apply only to worksheets,
not to report output. You make report output color
selections by using the Theme Defaults tab.

Worksheet Colors: Select default color settings for
journal, budget, report, asset, and physical inventory
worksheets.
• You can set colors for field text, field background,

context text, context background, data entry area,
and sheet background.

• The sample worksheet to the left of the Workbook
Regions options reflects your color choices as
you make them.

Note: These color choices apply only to worksheets,
not to report output. You make report output color
selections by using the Theme Defaults tab.

(Help) Oracle Financial Applications > Applications Desktop
Integrator > Getting Started with ADI > ADI Options > General
Options > Worksheet Colors Tab
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Setting General Options: The Theme
Defaults Tab

Setting General Options: The Theme
Defaults Tab

Theme Defaults: You can use the Theme Default tab
to set the defaults for new report themes.
The Theme Default determines the default colors
used when a new Theme is created.

Theme Defaults: You can use the Theme Default tab
to set the defaults for new report themes.
The Theme Default determines the default colors
used when a new Theme is created.

(Help) Oracle Financial Applications > Applications Desktop
Integrator > Getting Started with ADI > ADI Options > General
Options > Theme Defaults Tab
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Setting General Options: The Theme
Defaults Tab

Setting General Options: The Theme
Defaults Tab

• Region: From the Theme drop-down list, you can
select Report Title, Report Heading, Column
Headings, Line Items, or Amounts. Once selected,
the choices you make affect the related region, as
reflected in the sample report output.
– For each theme option, you can set the font to

use for displaying text, the font size, whether
text is bold or italic, the text and background
colors, and whether the report area should be
enclosed by a border.

– To select colors, select either the text or
background color field. When the Select Color
window appears, select a color, then click OK.

• Region: From the Theme drop-down list, you can
select Report Title, Report Heading, Column
Headings, Line Items, or Amounts. Once selected,
the choices you make affect the related region, as
reflected in the sample report output.
– For each theme option, you can set the font to

use for displaying text, the font size, whether
text is bold or italic, the text and background
colors, and whether the report area should be
enclosed by a border.

– To select colors, select either the text or
background color field. When the Select Color
window appears, select a color, then click OK.
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Setting General Options: The Theme
Defaults Tab

Setting General Options: The Theme
Defaults Tab

• Logo: You can specify an image file to be
displayed on your report output.
– Specify the path and filename for the image, or

click the Find button to browse your directory
structure for the file you want. Once you select
your image, you can set formatting options.

– As you make your selections, ADI updates the
sample image on the right side of the window.

• Logo: You can specify an image file to be
displayed on your report output.
– Specify the path and filename for the image, or

click the Find button to browse your directory
structure for the file you want. Once you select
your image, you can set formatting options.

– As you make your selections, ADI updates the
sample image on the right side of the window.
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Review QuestionReview Question

You make report output color selections by using the
Worksheet Colors tab.
1. True
2. False

You make report output color selections by using the
Worksheet Colors tab.
1. True
2. False
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Answer to Review QuestionAnswer to Review Question

You make report output color selections by using the
Worksheet Colors tab.
1. True
2. False

You make report output color selections by using the
Worksheet Colors tab.
1. True
2. False
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Type Description

Item Records the amount a supplier charges for
goods or services purchased

Tax Records the sales or other tax amount due
on goods or services purchased

Freight Records the amount a supplier charges for
shipping and handling

Miscellaneous Records the amount for miscellaneous 
expenses on an invoice

Setting General Options: The Settings
Tab

Setting General Options: The Settings
Tab

Setting Description
Start ADI when Select this option if you want ADI to
Opening Workbook start automatically (if it is not 

already running) whenever you 
open an ADI worksheet in Excel.

Start Request Center at Select if you want the Request 
Signon Center to start automatically when

you start ADI.

Show Upload Success Select if you want ADI to display 
upload success indicators on your
worksheets. The indicators tell you
whether related lines uploaded 
successfully. Regardless of this 
setting, error lines are always 
displayed.

(Help) Oracle Financial Applications > Applications Desktop
Integrator > Getting Started with ADI > ADI Options > General
Options > Settings Tab
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Type Description

Item Records the amount a supplier charges for
goods or services purchased

Tax Records the sales or other tax amount due
on goods or services purchased

Freight Records the amount a supplier charges for
shipping and handling

Miscellaneous Records the amount for miscellaneous 
expenses on an invoice

Setting General Options: The Settings
Tab

Setting General Options: The Settings
Tab

Setting Description
Zero Pad Account Select if you want account segment
Values values to be zero-padded. For 

example, an account number of 50,
where the segment is four 
characters in length, will display as
0050.

Enable Hot Keys Select this check box to enable the
special hot keys that are mapped
from your keyboard to the ADI 
functions. See the ADI User’s Guide
for a list of hot keys.
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Type Description

Item Records the amount a supplier charges for
goods or services purchased

Tax Records the sales or other tax amount due
on goods or services purchased

Freight Records the amount a supplier charges for
shipping and handling

Miscellaneous Records the amount for miscellaneous 
expenses on an invoice

Setting General Options: The Settings
Tab

Setting General Options: The Settings
Tab

Setting Description
Always on Top Select this check box to force 

Windows to always display the 
toolbar on top of all other open 
windows.

Display Tip Wizard Select this check box if you want to
use Microsoft Agent. In the 
Character File window, enter the 
path name for the character you 
want to use. Click the Show 
Characters button to test display 
the Agent (that is, the genie, wizard,
parrot, or robot).
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Setting Description

Run Custom When you publish reports with a theme that
Macros has a custom macro attached, the macro will

automatically run if this option is selected.
Perform Self- Select this option if you want ADI to perform
Check at a self-check when you start the system.
Startup
Play Sounds Select this option if you want ADI to play 
for Events sounds for events such as error messages.

Write Statistics Select this option if you want ADI to gather
statistics for analysis when you run 
performance-testing scenarios.

Directory and Do not modify these items unless told to do
Files region so by your system administrator.

Setting General Options: The Installation
Tab

Setting General Options: The Installation
Tab
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Type Description

Item Records the amount a supplier charges for
goods or services purchased

Tax Records the sales or other tax amount due
on goods or services purchased

Freight Records the amount a supplier charges for
shipping and handling

Miscellaneous Records the amount for miscellaneous 
expenses on an invoice

Setting Ledger Options: The Budget TabSetting Ledger Options: The Budget Tab

Option Name Description
Decimal Places The number of decimal places (up

to 5)

Minimum Width of The minimum column width in
Value Columns  worksheets

Update Budget Status The option to have the system 
automatically update the budget 
status information on the Create 
Budget Worksheet window any time
you make changes to your budget
worksheet parameters, such as 
number or accounts that will be 
retrieved

(Help) Oracle Financial Applications > Applications Desktop
Integrator > Getting Started with ADI > ADI Options > General Ledger
Options > Budget Tab
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Type Description

Item Records the amount a supplier charges for
goods or services purchased

Tax Records the sales or other tax amount due
on goods or services purchased

Freight Records the amount a supplier charges for
shipping and handling

Miscellaneous Records the amount for miscellaneous 
expenses on an invoice

Setting Ledger Options: The Budget TabSetting Ledger Options: The Budget Tab

Option Name Description
Graph Style The graph style, such as Area or 

Bar

2D or 3D To display two- or three-
dimensional graphs

Generate Axes To include values as labels on the
axes of graphs

Include Budgets and To graph both budget and actual 
Actuals values
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Region Name Description
Apply Format to • Select Fields or Hints.

Fields appear as row and column
headings. Hints appear as detail 
Information.
• Select the font and size, and the
Italic or Bold check boxes.

Layout • Set the default number of rows for
the number of journal lines 
displayed in your journal worksheet.

Header • Set the minimum width of columns.
Set display widths for field name,
context, and field value in a
journal worksheet header. The 
range of values is 1 to 10 columns.

(Help) Oracle Financial Applications > Applications Desktop
Integrator > Getting Started with ADI > ADI Options > General Ledger
Options > Journal Tab
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Type Description

Item Records the amount a supplier charges for
goods or services purchased

Tax Records the sales or other tax amount due
on goods or services purchased

Freight Records the amount a supplier charges for
shipping and handling

Miscellaneous Records the amount for miscellaneous 
expenses on an invoice

Setting Ledger Options: The Report
Definition Tab

Setting Ledger Options: The Report
Definition Tab

Region Option
Defaults Set the formatting options for rows,

columns, column width, line item
width, format, and factor.

Indicator Specify which colors to use to 
display Account Assignments, 
Calculations, and Exceptions report
indicators on your report 
worksheet. They indicate the 
number of account ranges 
assigned to your row or column, as
well as whether there are 
calculations or column exceptions
defined.

(Help) Oracle Financial Applications > Applications Desktop
Integrator > Getting Started with ADI > ADI Options > General Ledger
Options > Report Definition Tab
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Type Description

Item Records the amount a supplier charges for
goods or services purchased

Tax Records the sales or other tax amount due
on goods or services purchased

Freight Records the amount a supplier charges for
shipping and handling

Miscellaneous Records the amount for miscellaneous 
expenses on an invoice

Setting Ledger Options: The Report
Definition Tab

Setting Ledger Options: The Report
Definition Tab

Region Option
Copy Options • Make Copy Default: Choose this

option to have the Copy check 
boxes selected when you create 
new report objects or define a new
report.
• Enforcement Level: Select Prompt
to have ADI ask whether you want
to make a copy or use the original
report or report object.
Select Do Not Prompt to disable the
prompts.
Note: These options are overridden
if the ADI security-related profile 
options are defined in General 
Ledger.
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Type Description

Item Records the amount a supplier charges for
goods or services purchased

Tax Records the sales or other tax amount due
on goods or services purchased

Freight Records the amount a supplier charges for
shipping and handling

Miscellaneous Records the amount for miscellaneous 
expenses on an invoice

Setting Ledger Options: The Report
Analysis Tab

Setting Ledger Options: The Report
Analysis Tab

Option Description
Display Segment Select Grouped to have your 
Values account segments displayed as one

value, or Individual to perform 
multidimensional analysis of your
drilldown data.

Account Type Select this option to show the 
account type automatically when 
you drill down to detail accounts.

Zero Balances Select this option if you do not 
want zero balance amounts to be
displayed in your drill windows.

Outline Indicators Select this option to display expand
or collapse indicators in your drill
windows.

(Help) Oracle Financial Applications > Applications Desktop
Integrator > Getting Started with ADI > ADI Options > General Ledger
Options > Report Analysis Tab
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Type Description

Item Records the amount a supplier charges for
goods or services purchased

Tax Records the sales or other tax amount due
on goods or services purchased

Freight Records the amount a supplier charges for
shipping and handling

Miscellaneous Records the amount for miscellaneous 
expenses on an invoice

Setting Ledger Options: The Report
Analysis Tab

Setting Ledger Options: The Report
Analysis Tab

Option Description

Totals Select this option to include totals
for rows and columns in your drill
windows.

Include Descriptions Select this option to display 
for descriptions for your account 

balancing segment, cost center 
segment, and natural account 
segment.

Minimum Amount Select the minimum column width
Width to use.
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Type Description

Item Records the amount a supplier charges for
goods or services purchased

Tax Records the sales or other tax amount due
on goods or services purchased

Freight Records the amount a supplier charges for
shipping and handling

Miscellaneous Records the amount for miscellaneous 
expenses on an invoice

Setting Ledger Options: The Report
Analysis Tab

Setting Ledger Options: The Report
Analysis Tab

Option Description

Double Click Drill Select this option to drill down by
Enabled double-clicking an amount from 

one of the displayed drill windows,
or to drill down on amounts from 
your spreadsheet-published report
output without having to select the
Analyze Reports icon.

Hide Windows Select this option to close the 
When Navigating active drill window when you drill

up to the previous or down to next
drill window.

Maximum Active Select a number for the maximum
Drills number of drill context windows 

that you can have active at one 
time.
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Option Name Description
Limits Set limits for Request Center 

functions.
Sounds Specify a sound file for request 

completion

Output Viewer Select the program you want to use
to view report output or request 
logs whenever you choose the View
Output/Log button from the 
Request Center toolbar.
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Type Description

Item Records the amount a supplier charges for
goods or services purchased

Tax Records the sales or other tax amount due
on goods or services purchased

Freight Records the amount a supplier charges for
shipping and handling

Setting Request Center OptionsSetting Request Center Options

Option Name Description

Print Settings  Choose the Print Settings button 
to specify a default font to use 
when printing reports to a local 
printer.

Language Options Choose the Language Options 
button to change the language that
the Request Center uses in 
windows, menus, and tool tips.
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If U.S. English is not your native language, you can
change the language that ADI uses in windows,
menus, and tool tips, as well as the font and font
characteristics.
1. Click the Options button, then select Language

Options from the list of values.
2. In the Language Options window, select “Use

default” to use U.S. English. To use another
language, select Specific, then choose a language.

3. (Optional) Change the font if the language uses
unique characters.

4. Click OK to save your work.

If U.S. English is not your native language, you can
change the language that ADI uses in windows,
menus, and tool tips, as well as the font and font
characteristics.
1. Click the Options button, then select Language

Options from the list of values.
2. In the Language Options window, select “Use

default” to use U.S. English. To use another
language, select Specific, then choose a language.

3. (Optional) Change the font if the language uses
unique characters.

4. Click OK to save your work.

(Help) Oracle Financial Applications > Applications Desktop
Integrator > Getting Started with ADI > Language Options



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Implementing ADI
Chapter 23 - Page 62

Viewing ADI Information

Copyright © Oracle Corporation, 2001. All rights reserved.
®
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• From the ADI toolbar, you can display information
about your signon details.

• Select the Functional tab to display functional
information, such as the set of books name
associated with your current responsibility or
whether dynamic insertion is set to Yes.

• Select the Technical tab to review technical
information, such as identification numbers and
language details. You can also enable the SQL
Trace function.

• From the ADI toolbar, you can display information
about your signon details.

• Select the Functional tab to display functional
information, such as the set of books name
associated with your current responsibility or
whether dynamic insertion is set to Yes.

• Select the Technical tab to review technical
information, such as identification numbers and
language details. You can also enable the SQL
Trace function.

(Help) Oracle Financial Applications > Applications Desktop
Integrator > Getting Started with ADI > Displaying Signon Information
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DemonstrationDemonstration

This demonstration covers:
• Setting General Options
• Setting Ledger Options
• Setting Request Center Options
• Setting Language Options
• Viewing ADI information

(N) ADI > Options > General Options
(N) ADI > Options > Ledger Options
(N) ADI > Options > Request Center Options
(N) ADI > Options > Language Options
(N) ADI > Options > Information

This demonstration covers:
• Setting General Options
• Setting Ledger Options
• Setting Request Center Options
• Setting Language Options
• Viewing ADI information

(N) ADI > Options > General Options
(N) ADI > Options > Ledger Options
(N) ADI > Options > Request Center Options
(N) ADI > Options > Language Options
(N) ADI > Options > Information
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Using SecurityUsing Security

Profile optionsProfile options
FunctionFunction
securitysecurity

oror



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Implementing ADI
Chapter 23 - Page 65

Enabling Security Within ADI

Copyright © Oracle Corporation, 2001. All rights reserved.
®

Enabling Security Within ADIEnabling Security Within ADI

• ADI security is enforced through either profile
options or function security.
– Profile options are defined by the System

Administrator and can be set at the user,
responsibility, application, or site levels.

– Function security is based on the functions
defined for your responsibility in the standard
applications.

• ADI security is enforced through either profile
options or function security.
– Profile options are defined by the System

Administrator and can be set at the user,
responsibility, application, or site levels.

– Function security is based on the functions
defined for your responsibility in the standard
applications.

(Help) Oracle Financial Applications > Applications Desktop
Integrator > Getting Started with ADI > Security
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Enabling Security Within ADIEnabling Security Within ADI

• By default, access to ADI is not restricted; all
users have access to all functions.

• If you want to control access to ADI icons and
features, you must first decide which security
model to implement.

• Define the profile option ADI: Use Function
Security to enable this feature. If the profile option
is set to No, profile option security will be used.

• By default, access to ADI is not restricted; all
users have access to all functions.

• If you want to control access to ADI icons and
features, you must first decide which security
model to implement.

• Define the profile option ADI: Use Function
Security to enable this feature. If the profile option
is set to No, profile option security will be used.
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Review QuestionReview Question

The two security options in ADI are ______ and
______.
The two security options in ADI are ______ and
______.
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Answer to Review QuestionAnswer to Review Question

The two security options in ADI are profile options
and function security.
The two security options in ADI are profile options
and function security.
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Specifying a Security ModelSpecifying a Security Model

If you wish to control access to ADI icons and
features, you must first decide which security model
to implement:
• Function Security: allows you to control access to

specific Oracle Applications functions for each
defined responsibility.

• Profile Options: allows you to specify how Oracle
Applications controls access to and processes
data based on defined profile options. This model
gives you finer control over user access because
you can set security at the user, responsibility,
application, or site level.

If you wish to control access to ADI icons and
features, you must first decide which security model
to implement:
• Function Security: allows you to control access to

specific Oracle Applications functions for each
defined responsibility.

• Profile Options: allows you to specify how Oracle
Applications controls access to and processes
data based on defined profile options. This model
gives you finer control over user access because
you can set security at the user, responsibility,
application, or site level.
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To specify your security model:
1. Define the profile option ADI: Use Function

Security for your database.
2. Set the profile option ADI: Use Function Security

to:
– Yes to use the function security model
– No to use the profile options model

3. If you selected the function security model, assign
functions to your defined responsibilities in Oracle
Applications.

4. If you selected the profile options model, define the
ADI security profile options.

To specify your security model:
1. Define the profile option ADI: Use Function

Security for your database.
2. Set the profile option ADI: Use Function Security

to:
– Yes to use the function security model
– No to use the profile options model

3. If you selected the function security model, assign
functions to your defined responsibilities in Oracle
Applications.

4. If you selected the profile options model, define the
ADI security profile options.
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• If you choose to use the function security model,
you must create responsibilities that include or
exclude particular functions.

• To do this, sign on to Oracle Applications using
the System Administrator responsibility and
navigate to the Responsibility Definition window.

• You can also group your functions under a Menu
which you can then assign to a responsibility.

• If you choose to use the function security model,
you must create responsibilities that include or
exclude particular functions.

• To do this, sign on to Oracle Applications using
the System Administrator responsibility and
navigate to the Responsibility Definition window.

• You can also group your functions under a Menu
which you can then assign to a responsibility.
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Once you have defined the ADI security profile
options, you must enable them in Oracle
Applications. For each profile option, you need to
enter the value for the security level you want.

Once you have defined the ADI security profile
options, you must enable them in Oracle
Applications. For each profile option, you need to
enter the value for the security level you want.
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GLDI: Journal Wizard Privileges
• You can have one of four security levels assigned:

– Entry: You can only enter journals in a journal
worksheet.

– Entry, Upload: You can enter journals and
upload them to the GL Interface table.

– Entry, Upload, Submit: You can enter journals,
upload them, and submit journal import
processes.

– None: You have no access to any Enter
Journals features.

GLDI: Journal Wizard Privileges
• You can have one of four security levels assigned:

– Entry: You can only enter journals in a journal
worksheet.

– Entry, Upload: You can enter journals and
upload them to the GL Interface table.

– Entry, Upload, Submit: You can enter journals,
upload them, and submit journal import
processes.

– None: You have no access to any Enter
Journals features.
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GLDI: Journal Source (Optional)
• This option controls whether or not the source can

be changed from Enter Journals.
– When you set this profile option in General

Ledger, the specified journal source will
always be used when the user creates journals
using Journal Wizard.

– This source cannot be changed from within
General Ledger.

GLDI: Journal Source (Optional)
• This option controls whether or not the source can

be changed from Enter Journals.
– When you set this profile option in General

Ledger, the specified journal source will
always be used when the user creates journals
using Journal Wizard.

– This source cannot be changed from within
General Ledger.
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GLDI: Converted Entry Threshold (Optional)
• You can set a threshold amount within which

converted journals must balance before upload to
General Ledger.

GLDI: Balance by Accounting Date (Optional)
• When this option is enabled, journal amounts

must balance by accounting date before upload to
General Ledger.

GLDI: Converted Entry Threshold (Optional)
• You can set a threshold amount within which

converted journals must balance before upload to
General Ledger.

GLDI: Balance by Accounting Date (Optional)
• When this option is enabled, journal amounts

must balance by accounting date before upload to
General Ledger.
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GLDI: Create Group ID (Optional)
• When this option is enabled, ADI generates a

Group ID automatically during journal upload. Use
this profile option to trace journals posted in GL to
specific ADI users.

GLDI: Force Journal to Balance (Optional)
• When this option is enabled, journal entries must

balance before upload to General Ledger.

GLDI: Create Group ID (Optional)
• When this option is enabled, ADI generates a

Group ID automatically during journal upload. Use
this profile option to trace journals posted in GL to
specific ADI users.

GLDI: Force Journal to Balance (Optional)
• When this option is enabled, journal entries must

balance before upload to General Ledger.



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Implementing ADI
Chapter 23 - Page 77

General Ledger Profile Options

Copyright © Oracle Corporation, 2001. All rights reserved.
®

General Ledger Profile OptionsGeneral Ledger Profile Options

GLDI: Force Full Validation (Optional)
• ADI enforces full pre-validation of budget or

journal data before the data is uploaded to General
Ledger. If set to Yes, this option will override the
selected journal upload criteria in the Upload
Journal window.

GLDI: Budget Wizard Privileges
• Security levels for Enter Budgets are the same as

for Enter Journals, except that they pertain to
creating and uploading budgets and submitting
budget import processes.

GLDI: Force Full Validation (Optional)
• ADI enforces full pre-validation of budget or

journal data before the data is uploaded to General
Ledger. If set to Yes, this option will override the
selected journal upload criteria in the Upload
Journal window.

GLDI: Budget Wizard Privileges
• Security levels for Enter Budgets are the same as

for Enter Journals, except that they pertain to
creating and uploading budgets and submitting
budget import processes.
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GLDI: Enforce Budget Wizard Segment Security
• ADI enforces segment security rules that have

been defined in General Ledger. This profile option
applies only to budgets downloaded to the Budget
Wizard.

GLDI: AHE Privileges
• When this option is enabled, the user can access

the Account Hierarchy Editor.
GL AHE: Saving Allowed
• This option enables users to save any changes

they make to the account structure from the
Account Hierarchy Editor.

GLDI: Enforce Budget Wizard Segment Security
• ADI enforces segment security rules that have

been defined in General Ledger. This profile option
applies only to budgets downloaded to the Budget
Wizard.

GLDI: AHE Privileges
• When this option is enabled, the user can access

the Account Hierarchy Editor.
GL AHE: Saving Allowed
• This option enables users to save any changes

they make to the account structure from the
Account Hierarchy Editor.
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GLDI: Report Wizard Privileges
• You may have one of two security levels assigned:

– Define: You can only define reports.
– Define, Submit: You can define and submit

reports.

GLDI: Report Wizard Privileges
• You may have one of two security levels assigned:

– Define: You can only define reports.
– Define, Submit: You can define and submit

reports.
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GLDI: AutoCopy Enforcement Level
• You can assign one of three security levels:

– Enforce Copy: When working with existing
reports or report objects, the user must create
copies rather than use the originals that are
stored in the Oracle Applications database.

– Enforce Original: When working with existing
reports or report objects, the user must work
with the originals.

– None: To select working with copies or
originals.

GLDI: AutoCopy Enforcement Level
• You can assign one of three security levels:

– Enforce Copy: When working with existing
reports or report objects, the user must create
copies rather than use the originals that are
stored in the Oracle Applications database.

– Enforce Original: When working with existing
reports or report objects, the user must work
with the originals.

– None: To select working with copies or
originals.
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GLDI: Maximum Effective Ranges for Drilldown
(Optional)
• With this option, you can set the maximum

effective ranges for drilldown for the Analysis
Wizard.

GLDI: Analysis Wizard Privileges
• This option enables access to Analysis Wizard and

can be set to Yes or No.

GLDI: Maximum Effective Ranges for Drilldown
(Optional)
• With this option, you can set the maximum

effective ranges for drilldown for the Analysis
Wizard.

GLDI: Analysis Wizard Privileges
• This option enables access to Analysis Wizard and

can be set to Yes or No.
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GLDI: Allow Drilldown Across Books
• When working with Analyze Reports, this option

enables the user to drill down across sets of
books.

ADI: Allow Sysadmin to View All Output (Optional)
• When enabled, this option allows the system

administrator to view all output from the Request
Center.

GLDI: Allow Drilldown Across Books
• When working with Analyze Reports, this option

enables the user to drill down across sets of
books.

ADI: Allow Sysadmin to View All Output (Optional)
• When enabled, this option allows the system

administrator to view all output from the Request
Center.
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Which profile option controls whether or not a user
can access the Account Hierarchy Editor?
1. GLDI: AHE Privileges
2. GL AHE: Saving Allowed
3. GLDI: Force Full Validation
4. GLDI: AutoCopy Enforcement Level
5. ADI: Allow Sysadmin to View All Output

Which profile option controls whether or not a user
can access the Account Hierarchy Editor?
1. GLDI: AHE Privileges
2. GL AHE: Saving Allowed
3. GLDI: Force Full Validation
4. GLDI: AutoCopy Enforcement Level
5. ADI: Allow Sysadmin to View All Output
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Which profile option controls whether or not a user
can access the Account Hierarchy Editor?
1. GLDI: AHE Privileges
2. GL AHE: Saving Allowed
3. GLDI: Force Full Validation
4. GLDI: AutoCopy Enforcement Level
5. ADI: Allow Sysadmin to View All Output

Which profile option controls whether or not a user
can access the Account Hierarchy Editor?
1. GLDI: AHE Privileges
2. GL AHE: Saving Allowed
3. GLDI: Force Full Validation
4. GLDI: AutoCopy Enforcement Level
5. ADI: Allow Sysadmin to View All Output
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FADI: Create Assets Privileges
• You can assign one of four security levels:

– Entry: User can only enter assets in a
worksheet.

– Entry, Upload: User can enter assets and
upload them to the Oracle Assets Interface
table.

– Entry, Upload, Submit: User can enter assets,
upload them, and submit Post Mass Additions
processes.

– None: User has no access to any Create
Assets features.

FADI: Create Assets Privileges
• You can assign one of four security levels:

– Entry: User can only enter assets in a
worksheet.

– Entry, Upload: User can enter assets and
upload them to the Oracle Assets Interface
table.

– Entry, Upload, Submit: User can enter assets,
upload them, and submit Post Mass Additions
processes.

– None: User has no access to any Create
Assets features.
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FADI: Physical Inventory Privileges
• You can assign one of four security levels:

– Entry: User can only enter physical inventory
in a worksheet.

– Entry, Upload: User can enter physical
inventory and upload to the Oracle Assets
Interface table.

– Entry, Upload, Submit: User can enter physical
inventory, upload, and submit Physical
Inventory Comparison processes.

– None: User has no access to any physical
inventory features.

FADI: Physical Inventory Privileges
• You can assign one of four security levels:

– Entry: User can only enter physical inventory
in a worksheet.

– Entry, Upload: User can enter physical
inventory and upload to the Oracle Assets
Interface table.

– Entry, Upload, Submit: User can enter physical
inventory, upload, and submit Physical
Inventory Comparison processes.

– None: User has no access to any physical
inventory features.
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Security by BookSecurity by Book

Oracle Assets Security By Book is extended to ADI
users. This feature is effective only with Oracle
Assets, Release 11i. If the profile option FA: Security
Profile is enabled, user access is controlled in two
key areas:
• The list of values for the Corporate Depreciation

Book in the Asset Creation window is limited
according to the Set(s) of Books that the user's
responsibility grants.

• The list of values for Standard and Variable Format
Reports that have the Book parameter is limited to
the Set(s) of Books that the user's responsibility
grants.

Oracle Assets Security By Book is extended to ADI
users. This feature is effective only with Oracle
Assets, Release 11i. If the profile option FA: Security
Profile is enabled, user access is controlled in two
key areas:
• The list of values for the Corporate Depreciation

Book in the Asset Creation window is limited
according to the Set(s) of Books that the user's
responsibility grants.

• The list of values for Standard and Variable Format
Reports that have the Book parameter is limited to
the Set(s) of Books that the user's responsibility
grants.
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Application Validation Within ADIApplication Validation Within ADI

Flexfield Validation
• ADI performs full flexfield validation for table-

validated value sets as long as the list of values is
used.

Cross-Validation Rules
• ADI always enforces cross-validation rules when

using the list of values. You must be connected to
the server to use the list of values.

• If the profile option Flexfields:Validate On Server
is set to Yes, cross-validation checking is done
before the data reaches the interface table.
Otherwise it is done during import.

Flexfield Validation
• ADI performs full flexfield validation for table-

validated value sets as long as the list of values is
used.

Cross-Validation Rules
• ADI always enforces cross-validation rules when

using the list of values. You must be connected to
the server to use the list of values.

• If the profile option Flexfields:Validate On Server
is set to Yes, cross-validation checking is done
before the data reaches the interface table.
Otherwise it is done during import.
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This practice covers setting up a Database in ADI.This practice covers setting up a Database in ADI.
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Practice 1 Instructions
with Solution

Practice 1 Instructions
with Solution

Set up a database in ADI.Set up a database in ADI.

Practice 1 Instructions
In the Signon window, select the Define Database icon.
Enter the name and description of the database.
The instructor will provide the information for the GWYUID (Gateway User
ID),FNDNAM, and Connect String fields.

Practice 1 Solutions
1. Navigate to the Signon window.

(N) ADI > Signon
2. Click the Define Database icon.
3. Click the green plus sign button to add a new database. When you have

defined a database, you can use the pencil button to edit it.
4. In the Name and Description fields, enter the name and description of the

database. The name must be at least six characters. You can enter any name
and description.

5. The GWYUID (Gateway User ID), FNDNAM, and Connect String fields are
system-level parameters for your database. You must enter text in these fields.
Use the information given to you by the instructor.
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This practice covers:
• Signing on to ADI
• Changing worksheet color defaults
• Setting theme defaults
• Identifying settings and installation
• Viewing ADI information

This practice covers:
• Signing on to ADI
• Changing worksheet color defaults
• Setting theme defaults
• Identifying settings and installation
• Viewing ADI information
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Practice 2 Instructions
with Solution

Practice 2 Instructions
with Solution

Signon to ADI and change the worksheet color
defaults, set theme defaults, identify settings and
installation, and view ADI information.

Signon to ADI and change the worksheet color
defaults, set theme defaults, identify settings and
installation, and view ADI information.

Practice 2 Instructions
Step 1: Signon to ADI

Sign on to ADI using the username, password, and database given to you by
your instructor. Make sure to select General Ledger, Vision Operations
(USA) responsibility.

Step 2: Change the Worksheet Colors
After selecting the General Options from the toolbar, view the settings in the

Worksheet colors tab. Set the following options in the Worksheet Colors
tab:

Workbook Region Color
Field Text White
Field Background Purple
Context Text Black
Context Background Light blue
Data Entry Area White
Sheet Background Dark gray

Step 3: Change Theme Defaults
Set the following options in the Theme Defaults tab:

Region Background Text
Report Title Black Red
Report Heading White Blue
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Column Headings Black Blue
Line Items Red White
Amounts Black White

Step 4: Identify Settings
Identify the feature in the Settings tab that correlates to each of the following
descriptions:

1. The toolbar can always be
seen:_______________________________________

2. Display indicators on your
worksheet:__________________________________

3. Use key equivalents for ADI:_______________________________________
4. When you open an ADI worksheet, also start

ADI:_______________________________________
5. An account number of 50 would display as

0050:_______________________________________
6. The submitting and publishing feature of ADI would start when ADI was

started:______________________________________
Hint: Review the Settings tab in the General Options window, or review the
lesson.

Step 5: Create a Journal Worksheet with New Colors
Create a journal worksheet to test your new layout colors.

Practice 2 Solutions
Step 1: Signon to ADI
1. Navigate to the Signon window.

(N) ADI > Signon
2. The Oracle Applications Signon window appears.
3. Select the database to which you want to connect.
4. Enter the username and password that you use to sign on to Oracle

Applications.
5. Select a responsibility from the same list of responsibilities that you use to

access Oracle Applications.
6. Click the green check mark (the OK button) to sign on. After ADI connects to

the database, your toolbar will expand to include additional buttons.
Step 2: Change the Worksheet Colors
1. Click the Options icon on your toolbar. Select General Options from the list.
2. View the settings in the Worksheet Colors tab. Set the following options:

Workbook Region Color
Field Text White
Field Background Purple
Context Text Black
Context Background Light blue
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Data Entry Area White
Sheet Background Dark gray

Step 3: Change Theme Defaults
1. Select the Theme Defaults tab and set the following options:

Region Text Background
Report Title Black Red
Report Heading White Blue
Column Headings Black Blue
Line Items Red White
Amounts Black White

Step 4: Identify Settings
Identify the feature in the Settings tab that correlates to each of the following

descriptions:
1. The toolbar can always be seen: Always on Top
2. Display indicators on your worksheet: Show Upload Success Indicator
3. Use key equivalents for ADI: Enable Hot Keys
4. When you open an ADI worksheet, also start ADI: Start ADI when Opening

Workbook
5. An account number of 50 would display as 0050: Zero Pad Account Values
6. The submitting and publishing feature of ADI would start when ADI was

started: Start Request Center at Signon
Step 5: Create a Journal Worksheet with New Colors
1. Click the Enter Journals icon in your toolbar.
2. The Create Journal Worksheet window appears. Accept all defaults and click

the green check mark.
3. Your worksheet should appear.
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SummarySummary

In this course, you should have learned how to:
• Explain the ADI features
• Describe the ADI functionality
• Demonstrate how to sign on to ADI
• Demonstrate how to set up ADI

In this course, you should have learned how to:
• Explain the ADI features
• Describe the ADI functionality
• Demonstrate how to sign on to ADI
• Demonstrate how to set up ADI
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Accounting for Foreign and Multiple Currencies
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Accounting for Foreign and Multiple
Currencies

Accounting for Foreign and Multiple
Currencies

Oracle General Ledger Release 11iOracle General Ledger Release 11i
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After completing this module, you should be able to
do the following:
After completing this module, you should be able to
do the following:

ObjectivesObjectives

• Define foreign currencies, including the European
Monetary Union (EMU) currency

• Enter foreign currency journals
• Revalue foreign currency balances
• Translate foreign currency balances

• Define foreign currencies, including the European
Monetary Union (EMU) currency

• Enter foreign currency journals
• Revalue foreign currency balances
• Translate foreign currency balances
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• Overview of translation and revaluation
• Defining foreign currencies and conversion rates
• Creating foreign currency journals
• Revaluing foreign currency balances
• Translating foreign currency balances

• Overview of translation and revaluation
• Defining foreign currencies and conversion rates
• Creating foreign currency journals
• Revaluing foreign currency balances
• Translating foreign currency balances
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Concepts You Should KnowConcepts You Should Know

Multiple Sets of BooksMultiple Sets of Books MRC Sets of BooksMRC Sets of Books

Transactions must beTransactions must be
entered, revalued, andentered, revalued, and
translated separately intranslated separately in
each set of books.each set of books.

EnterEnter
transactions intransactions in
primary bookprimary book

Transactions entered inTransactions entered in
primary books areprimary books are
automatically converted toautomatically converted to
each reporting set of books.each reporting set of books.

ReportingReporting
booksbooks

For more information, see:
(Help) Oracle Applications Help > Oracle Financial Applications >
Oracle General Ledger > Multi-Currency
Set of Books

Before you begin this unit, you should be aware of some concepts regarding sets
of books.  A set of books consists of the following elements: an accounting
calendar, an account structure, and currency. If one of these elements is
different, you must create a separate set of books.

Multiple Reporting Set of Books
Multiple Reporting Currencies (MRC). MRC is beneficial for companies who
must regularly and routinely report its transactions and financial results in
multiple currencies, other than its primary functional currency. With MRC, you
create a primary set of books and then associate one or more reporting sets of
books (with different currencies) to that primary set of books. Day-to-day
transactions are entered in the primary set of books where they are converted to
the designated currencies for the reporting sets of books.
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Working with Multiple CurrenciesWorking with Multiple Currencies
Update DailyUpdate Daily
Conversion RatesConversion Rates

Enter invoice

Translate ForeignTranslate Foreign
Currency AccountCurrency Account
BalancesBalances

Revalue Asset and
Liability Accounts

1 USD = 7.1 BEF
1 USD = 20 ITL
1 USD = 1.5 AUD

1 USD = 7.1 BEF
1 USD = 20 ITL
1 USD = 1.5 AUD Enter, Import and PostEnter, Import and Post

Foreign Currency JE’sForeign Currency JE’s

Review Entered,Review Entered,
Converted, andConverted, and
Translated CurrencyTranslated Currency
BalancesBalances

PostPost
RevaluationRevaluation
JournalsJournals

JE 126
Foreign
Currency
____ ____
____ ____
____  _____

JE 125
Foreign
Currency
____ ____
____ ____
____  __ __

JE 126
Foreign
Currency
____ ____
____ ____
____  __ ___

JE 125
DR. AR   1000
CR.    GAIN/LOSS
1000
DR. AP    500
CR    GAIN/LOSS
500

Run Foreign Currency TrialRun Foreign Currency Trial
Balance ReportsBalance Reports  andand
Produce Foreign CurrencyProduce Foreign Currency
Financial StatementsFinancial Statements

Working with Multiple Currencies
• Update your daily conversion rates regularly.
• Enter, import, and post foreign currency journals.
• Revalue asset and liability accounts whose balances are denominated in a

foreign currency.
• Post the revaluation journal batch to adjust your unrealized gain/loss

account for exchange rate fluctuations.
• Translate account balances before consolidating sets of books with

different functional currencies, or to report account balances in an
alternate currency.

• Review entered, converted, and translated currency balances.
• Run foreign currency Trial Balance reports.
• Produce foreign currency financial statements
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Foreign Currency ConceptsForeign Currency Concepts

There are three key concepts in Oracle General
Ledger that pertain to foreign currency:
There are three key concepts in Oracle General
Ledger that pertain to foreign currency:

Conversion

Revaluation

Translation

Conversion
Conversion refers to foreign currency transactions that are immediately
converted at the time of entry to the functional currency of the set of books in
which the transaction takes place.

Revaluation
Revaluation adjusts liability or asset accounts that may be understated or
overstated at the end of a period due to a significant fluctuation in the exchange
rate between the time the transaction was entered and the end of the period. It
restates balances using proper period end rate.

Translation
Translation refers to the act of restating an entire set of books or balances for a
company from the functional currency to a foreign currency.
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Oracle General Ledger automatically converts the
amounts in foreign currency journals to functional
currency equivalents using supplied daily exchange
rates.

Oracle General Ledger automatically converts the
amounts in foreign currency journals to functional
currency equivalents using supplied daily exchange
rates.

FunctionalFunctional
 currency currency

  Foreign  Foreign
currenciescurrencies

Conversion
Conversion uses a daily rate that either you supply when you enter your foreign
currency transaction or that Oracle General Ledger looks up in the Daily Rates
table.
When you post foreign currency transactions, Oracle General Ledger maintains
a separate balance for all accounts entered in a foreign currency and their
equivalent balances in the functional currency.
The conversion functionality allows you to:

• Segregate portions of an account balance by the different currencies used
in each transaction.

• Specifically identify the source currencies of a functional balance, a key
component of performing proper revaluation of the balance.
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ExampleExample

On May 17, an organization provides consulting
services to a foreign company for 10,000 foreign
dollars. The exchange rate at the time of the payment
is 0.8 functional dollars per foreign dollar.

On May 17, an organization provides consulting
services to a foreign company for 10,000 foreign
dollars. The exchange rate at the time of the payment
is 0.8 functional dollars per foreign dollar.

Dr.  Accounts Receivable……………10,000 foreign dollars
Cr.        Revenue……………………………….10,000 foreign dollars

Dr. Accounts Receivable …………  8,000 functional dollars
Cr.        Revenue…………………………..8,000 functional dollars

Entered Journal Entry Lines

Automatically Converted Journal Entry Lines in Foreign Currency
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Revaluation ProcessRevaluation Process

Revaluation is a process that reviews foreign
currency transactions, reconverts them to the
functional currency using the Revaluation Rate, then
creates a journal entry to adjust the functional
balance to the reconverted amount.

Revaluation is a process that reviews foreign
currency transactions, reconverts them to the
functional currency using the Revaluation Rate, then
creates a journal entry to adjust the functional
balance to the reconverted amount.

FunctionalFunctional
 currency currency

  Foreign  Foreign
currenciescurrencies

Conversion at the time of theConversion at the time of the
foreign currency transactionforeign currency transaction

Revaluation at the end ofRevaluation at the end of
the accounting periodthe accounting period

FunctionalFunctional
 currency currency

  Foreign  Foreign
currenciescurrencies

Revaluation
The revaluation process performs the following:

• Finds all accounts (within a range of specified accounts) in which all or a
portion of the balance is derived from foreign currency transactions.

• Takes the foreign currency portion of the account balance and revalues it
using the Revaluation Rate from the Period Rates table. The Revaluation
Rate is the inverse of the Period End Rate (expressed as 1/Period End
Rate).

• Figures the difference between the current cumulative functional balance
of these foreign transactions and the revalued functional currency balance
calculated using the Revaluation Rate.

• Creates an unposted journal batch to adjust the account balance to the new
revalued balance. The offset account is the Unrealized Gain/Loss account
specified when you run the revaluation process.

• Note: Revaluation is necessary only while the obligation remains
unsettled. The Realized Gain/Loss will be recorded by the appropriate
subledger (Accounts Payable or Accounts Receivable) at the time the
obligation is settled.

Because all balances are restated to a single currency, you can also use this
process to enable reconciliation of your foreign subsidiary intercompany
accounts.
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Revaluation ExampleRevaluation Example

On May 31, the receivable for the previously
converted May 17 consulting services remains
uncollected and the organization wants to report on
its financial position.

– The exchange rate has risen to 0.81.
– The receivable is still for 10,000 foreign

dollars, but that receivable is now worth 8,100
functional dollars.

On May 31, the receivable for the previously
converted May 17 consulting services remains
uncollected and the organization wants to report on
its financial position.

– The exchange rate has risen to 0.81.
– The receivable is still for 10,000 foreign

dollars, but that receivable is now worth 8,100
functional dollars.
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Foreign ReceivableForeign ReceivableForeign Receivable

10,00010,00010,000

Functional ReceivableFunctional ReceivableFunctional Receivable

8,0008,0008,000

Foreign ReceivableForeign ReceivableForeign Receivable

10,00010,00010,000

Functional ReceivableFunctional ReceivableFunctional Receivable

8,1008,1008,100

Functional Unrealized GainFunctional Unrealized GainFunctional Unrealized Gain

100100100

After RevaluationAfter RevaluationAfter Revaluation

Revaluation ExampleRevaluation Example
Before RevaluationBefore RevaluationBefore Revaluation
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TranslationTranslation

Foreign currency translation is a process that
enables you to restate your functional currency
account balances into a reporting currency.

Foreign currency translation is a process that
enables you to restate your functional currency
account balances into a reporting currency.

 Foreign Foreign
currencycurrency

 Functional Functional
  currency  currency TranslationTranslation
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Translation ExampleTranslation Example

Functional Currency 
Income Statement
Functional Currency Functional Currency 
Income StatementIncome Statement

Revenue  7,000
Expense (4,000)
Net Income  3,000

Revenue Revenue  7,000 7,000
ExpenseExpense (4,000)(4,000)
Net IncomeNet Income  3,000 3,000

Functional Currency
Balance Sheet
Functional CurrencyFunctional Currency
Balance SheetBalance Sheet

Assets
100,000
AssetsAssets
100,000100,000

Liabilities
60,000
Owner’s Equity
40,000

LiabilitiesLiabilities
60,00060,000
Owner’s EquityOwner’s Equity
40,00040,000

Foreign Currency
Income Statement
Foreign CurrencyForeign Currency
Income StatementIncome Statement

Revenue  5,040
Expense (2,880)
Net Income  2,160

Revenue Revenue  5,040 5,040
ExpenseExpense (2,880)(2,880)
Net IncomeNet Income  2,160 2,160

Foreign Currency
Balance Sheet
Foreign CurrencyForeign Currency
Balance SheetBalance Sheet

Assets
75,000
AssetsAssets
75,00075,000

Liabilities
45,000
Owner’s Equity
28,000

LiabilitiesLiabilities
45,00045,000
Owner’s EquityOwner’s Equity
28,00028,000

Period Average
Rate = 0.72
Period AveragePeriod Average
Rate = 0.72Rate = 0.72 Period End

Rate = 0.75
Period EndPeriod End
Rate = 0.75Rate = 0.75

Historical
Rate = 0.70
HistoricalHistorical
Rate = 0.70Rate = 0.70
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Integrating with SubledgersIntegrating with Subledgers
Many foreign-denominated transactions are originally
entered in feeder systems such as Oracle Payables
and Oracle Receivables, then settled in the feeder
system.

Many foreign-denominated transactions are originally
entered in feeder systems such as Oracle Payables
and Oracle Receivables, then settled in the feeder
system.

Foreign currencyForeign currency
obligation isobligation is

entered in Oracleentered in Oracle
Payables.Payables.

Payables journalPayables journal
entry is recorded in entry is recorded in 

Oracle General Ledger.Oracle General Ledger.

Foreign currencyForeign currency
conversion,conversion,

revaluation, andrevaluation, and
unrealized gain orunrealized gain or
loss is recorded.loss is recorded.

Foreign currencyForeign currency
obligation is paidobligation is paid

in Oracle Payables.in Oracle Payables.

Realized foreignRealized foreign
currencycurrency

gain or loss isgain or loss is
calculated.calculated.

Payables journalPayables journal
entry is recordedentry is recorded
in Oracle Generalin Oracle General

Ledger.Ledger.

Foreign Currency Transactions from Subledgers
Each subledger handles foreign currency conversion slightly different,
depending upon the application’s system options and the rate type.
Companies should implement procedures for users entering exchange rates
online to avoid inconsistencies in rates between applications. The procedures for
entry and maintenance of exchange rates should be addressed by a joint team of
all affected applications.
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AgendaAgenda

• Overview of translation and revaluation
• Defining foreign currencies and conversion rates
• Creating foreign currency journals
• Revaluing foreign currency balances
• Translating foreign currency balances

• Overview of translation and revaluation
• Defining foreign currencies and conversion rates
• Creating foreign currency journals
• Revaluing foreign currency balances
• Translating foreign currency balances
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After completing this lesson, you should be able to
do the following:
• Define and enable new currencies

– Non-ISO currencies
– European Economic and Monetary Union

(EMU) currencies
• Enter period rates for all types of currencies

including EMU currencies
• Define daily conversion rate types
• Enter daily rates

After completing this lesson, you should be able to
do the following:
• Define and enable new currencies

– Non-ISO currencies
– European Economic and Monetary Union

(EMU) currencies
• Enter period rates for all types of currencies

including EMU currencies
• Define daily conversion rate types
• Enter daily rates

For more information, see:
(Help) Oracle Applications Help > Oracle Financial Applications >
Oracle General Ledger > Multi-Currency
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Prerequisites for Entering Foreign
Currency Transactions

Prerequisites for Entering Foreign
Currency Transactions

Before you can enter foreign currency transactions,
there are a number of steps you must complete.
1. Define new currencies.
2. For EMU currencies, establish an EMU relationship

with an existing currency.
3. Enable currencies.
4. Define sets of books.
5. Define daily conversion rate types.
6. Enter daily rates.

In addition, you will need to enter period rates for
revaluation and translation.

Before you can enter foreign currency transactions,
there are a number of steps you must complete.
1. Define new currencies.
2. For EMU currencies, establish an EMU relationship

with an existing currency.
3. Enable currencies.
4. Define sets of books.
5. Define daily conversion rate types.
6. Enter daily rates.

In addition, you will need to enter period rates for
revaluation and translation.

Enabled Currencies
The only currency that is initially enabled is the U.S. dollar (USD). To use a
currency other than U.S. dollars, you must define (if not already defined) and
enable that currency in Oracle General Ledger.

The Euro
Oracle Applications and General Ledger include specific features to support the
new pan-European currency, the euro. General Ledger comes with a predefined
currency for the euro, with a currency code of EUR.
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Defining and Enabling CurrenciesDefining and Enabling Currencies

• Oracle Applications has predefined all currencies
specified in ISO standard #4217.

• U.S. Dollars(USD) is the only currency that is
enabled initially.

• To use a currency other than U.S. Dollars (USD),
you must enable the currency.

• Use the Currencies window to define non-ISO
(International Standards Organization) currencies,
and to enable/disable currencies.

• Oracle Applications has predefined all currencies
specified in ISO standard #4217.

• U.S. Dollars(USD) is the only currency that is
enabled initially.

• To use a currency other than U.S. Dollars (USD),
you must enable the currency.

• Use the Currencies window to define non-ISO
(International Standards Organization) currencies,
and to enable/disable currencies.

For more information, see:
(Help) Oracle Applications Help > Oracle Financial Applications >
Oracle General Ledger > Multi-Currency > Defining Currencies
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(N) Setup > Currencies > Define(N) Setup > Currencies > Define

Steps to Define Non-ISO CurrenciesSteps to Define Non-ISO Currencies

1. Enter the following:
• Code to identify currency
• Currency Name and Description
• (Optional) Select Issuing Territory.
• Symbol, such as $
• Precision

– number of digits to right of decimal used in
regular currency transactions

• Extended Precision
– number of digits to right of decimal to be used

in calculations
– must be equal to or greater than Precision

1. Enter the following:
• Code to identify currency
• Currency Name and Description
• (Optional) Select Issuing Territory.
• Symbol, such as $
• Precision

– number of digits to right of decimal used in
regular currency transactions

• Extended Precision
– number of digits to right of decimal to be used

in calculations
– must be equal to or greater than Precision

For more information, see:
(Help) Oracle Applications Help > Oracle Financial Applications >
Oracle General Ledger > Currencies > Defining Currencies
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Steps to Define Non-ISO CurrenciesSteps to Define Non-ISO Currencies

Enter the following, continued:
• Minimum Accountable Unit

– designates smallest denomination
– does not need to correspond to precision

• If EMU currency, define Currency Derivation
options

• (Optional) Effective Dates
2. Enable the currency

Enter the following, continued:
• Minimum Accountable Unit

– designates smallest denomination
– does not need to correspond to precision

• If EMU currency, define Currency Derivation
options

• (Optional) Effective Dates
2. Enable the currency
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In February 1992 members of the European Union (EU) signed the Maastricht
treaty and agreed to form the European Economic and Monetary Union (EMU).
The schedule for introduction of the EMU as published by the European
Commission is as follows:
Date Event
Spring 1998 Decision on EMU conversion rates set
January 1, 1998 Euro exists

Conversion rates locked
Bank transactions and settlements in Euro

January 1, 2002 Coins and notes issued
July 1, 2002 National currencies withdrawn

Note: The following countries are members of the first group of the EMU:
France, Germany, Ireland, Finland, Belgium, Luxembourg, The Netherlands,
Austria, Italy, Spain, and Portugal. In spring 2000 Greece was added.
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European Economic and
Monetary Union

European Economic and
Monetary Union

Separate CurrenciesSeparate Currencies One CurrencyOne Currency

The Euro
Oracle Applications and General Ledger include specific features for defining
the relationships between the official currency (euro) of the European Monetary
Union (EMU) and the national currencies of EMU member states. For each
EMU currency, you define its Euro-to-EMU fixed conversion rate and the
effective starting date.

Doing Business in Euro and National Currencies
Existing national currencies are defined as nondecimal denominations of the
euro. This means that the euro has two monetary units in an EMU country: the
euro unit, and the National Currency Unit (NCU). A national currency unit has a
fixed relationship to the euro, just as a cent has a fixed relationship (100:1) with
a dollar.

EU Countries Not Joining Monetary Union
By contrast to EMU countries, where the former national currency has a fixed
rate relationship to the euro, organizations outside EMU countries that wish to
comply with euro requirements will need to maintain and support floating
exchange rates between their national currency and the euro.
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Steps to Define a New EMU CurrencySteps to Define a New EMU Currency

1. Follow the steps for defining a currency.
2. While defining the currency, select Euro Derived

as the Currency Derivation Type.
3. Enter the Currency Derivation Factor. This is the

fixed conversion rate by which you multiply one
euro to derive the equivalent EMU currency
amount.

4. Enter the Currency Derivation Effective Starting
Date. This is the date on which the relationship
between the EMU currency and the euro effectively
starts.

5. Complete the steps for defining a currency.

1. Follow the steps for defining a currency.
2. While defining the currency, select Euro Derived

as the Currency Derivation Type.
3. Enter the Currency Derivation Factor. This is the

fixed conversion rate by which you multiply one
euro to derive the equivalent EMU currency
amount.

4. Enter the Currency Derivation Effective Starting
Date. This is the date on which the relationship
between the EMU currency and the euro effectively
starts.

5. Complete the steps for defining a currency.

(N) Setup > Currencies > Define(N) Setup > Currencies > Define

For more information, see:
(Help) Oracle Applications Help > Oracle Financial Applications >
Oracle General Ledger > Multi-Currency > Currencies >   Defining
European Monetary Union Relationships
(N) Setup > Currencies > Define
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Steps to Create an EMU Relationship for
an Existing Currency

Steps to Create an EMU Relationship for
an Existing Currency

1. Navigate to the Currencies window and select the
currency.

2. Select EMU derived as the Currency Derivation
Type.

3. Enter the Currency Derivation Factor between the
Euro and the EMU currency.

4. Enter the Currency Derivation Effective starting
date.
NOTE: You must create the EMU relationship for
your existing currency before you enter period
rates for any period that is the same as or which
follows the period of the effective starting date.

1. Navigate to the Currencies window and select the
currency.

2. Select EMU derived as the Currency Derivation
Type.

3. Enter the Currency Derivation Factor between the
Euro and the EMU currency.

4. Enter the Currency Derivation Effective starting
date.
NOTE: You must create the EMU relationship for
your existing currency before you enter period
rates for any period that is the same as or which
follows the period of the effective starting date.

(N) Setup > Currencies > Define(N) Setup > Currencies > Define
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Steps to Enable CurrenciesSteps to Enable Currencies

1. From the Currencies window, select the currency.
2. (Optional for Euro currencies) select the Euro

Currency as the Currency Derivation Type.
3. Select the Enabled box.
4. Save your work.

NOTE: Although Oracle Applications has many
predefined currencies, only the currency U.S.
Dollars (USD) is initially enabled.

1. From the Currencies window, select the currency.
2. (Optional for Euro currencies) select the Euro

Currency as the Currency Derivation Type.
3. Select the Enabled box.
4. Save your work.

NOTE: Although Oracle Applications has many
predefined currencies, only the currency U.S.
Dollars (USD) is initially enabled.

(N) Setup > Currencies > Define(N) Setup > Currencies > Define

For more information, see:
(Help) Oracle Applications Help > Oracle Financial Applications >
Oracle General Ledger > Multi-Currency > Currencies >   Defining
European Monetary Union Relationships
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Defining a Set of BooksDefining a Set of Books

(N) Setup > Financials > Books > Define
• If you need to report on your account balances or

at the transactions level in multiple currencies,
define a primary set of books using your
functional currency and additional sets of books
using your reporting currencies.

• Set up the Rounding Differences account to
automatically post rounding differences that occur
during currency conversion.

• Set up the Cumulative Translation Adjustment
account to post any net adjustments resulting
from translation or revaluation to this account in
accordance with SFAS #52 (U.S.).

(N) Setup > Financials > Books > Define
• If you need to report on your account balances or

at the transactions level in multiple currencies,
define a primary set of books using your
functional currency and additional sets of books
using your reporting currencies.

• Set up the Rounding Differences account to
automatically post rounding differences that occur
during currency conversion.

• Set up the Cumulative Translation Adjustment
account to post any net adjustments resulting
from translation or revaluation to this account in
accordance with SFAS #52 (U.S.).

For more information, see:
(Help) Oracle Applications Help > Oracle Financial Applications >
Oracle General Ledger > Setting Up General Ledger > Defining Sets
of Books
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Predefined Daily Conversion Rate TypesPredefined Daily Conversion Rate Types
RateType Description

Spot An exchange rate used to perform
conversion based on the rate on a specific
date.

Corporate An exchange rate used to standardize rates
for your company.

User An exchange rate you specify when you
enter a foreign currency journal entry.

EMU Fixed
Rate

An exchange rate General Ledger provides
automatically when you enter journals (after
the EMU effective starting date) when
translating values from one EMU currency to
another.

For more information, see:
(Help) Oracle Applications Help > Oracle Financial Applications >
Oracle General Ledger > Multi-Currency > Defining Conversion Rate
Types
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Steps to Define a New Conversion Rate Type
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Steps to Define a New Conversion Rate
Type

Steps to Define a New Conversion Rate
Type

1. Navigate to the Conversion Rate Types window.
2. Enter a name and description for the new

conversion rate type.
NOTE: The only rate type reserved for use by
Oracle Financials is the User rate type. User rates
are directly entered by the user when a transaction
is entered.

1. Navigate to the Conversion Rate Types window.
2. Enter a name and description for the new

conversion rate type.
NOTE: The only rate type reserved for use by
Oracle Financials is the User rate type. User rates
are directly entered by the user when a transaction
is entered.

(N) Setup > Currencies > Rates > Types(N) Setup > Currencies > Rates > Types
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• One set of daily rates is used for all sets of books
within an Applications instance.

• General Ledger uses daily rates to perform foreign
currency journal conversions.
– You can maintain daily conversion rates

between any two non-EMU currencies
– For EMU currencies, you can only enter daily

rates between the EMU currency and other
currencies if the date precedes the EMU
currency's effective starting date.

– In addition, you can enter a range of dates for
a single exchange rate in the Enter Rates By
Date Range window.

• One set of daily rates is used for all sets of books
within an Applications instance.

• General Ledger uses daily rates to perform foreign
currency journal conversions.
– You can maintain daily conversion rates

between any two non-EMU currencies
– For EMU currencies, you can only enter daily

rates between the EMU currency and other
currencies if the date precedes the EMU
currency's effective starting date.

– In addition, you can enter a range of dates for
a single exchange rate in the Enter Rates By
Date Range window.

For more information, see:
(Help) Oracle Applications Help > Oracle Financial Applications >
Oracle General Ledger > Multi-Currency > Entering Daily Rates
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Loading Daily Rates AutomaticallyLoading Daily Rates Automatically

• General Ledger provides the
GL_DAILY_RATES_INTERFACE table that you can
use to automatically insert, update, or delete daily
rates in the GL_DAILY_RATES table.

• General Ledger validates the rows in the interface
table before making changes in the
GL_DAILY_RATES table.

• Warning: Always use the interface table to load
your daily rates into General Ledger. Do not load
rates directly into the GL_DAILY_RATES table; this
can corrupt your daily rates data.

• General Ledger provides the
GL_DAILY_RATES_INTERFACE table that you can
use to automatically insert, update, or delete daily
rates in the GL_DAILY_RATES table.

• General Ledger validates the rows in the interface
table before making changes in the
GL_DAILY_RATES table.

• Warning: Always use the interface table to load
your daily rates into General Ledger. Do not load
rates directly into the GL_DAILY_RATES table; this
can corrupt your daily rates data.
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Entering Daily Rates and MRCEntering Daily Rates and MRC

• In MRC daily rates are used to convert your
primary set of books' journals to the appropriate
reporting currencies when the journals are copied
to your reporting sets of books.

• Daily rates must be defined before you post
journals in your primary set of books.

• In MRC daily rates are used to convert your
primary set of books' journals to the appropriate
reporting currencies when the journals are copied
to your reporting sets of books.

• Daily rates must be defined before you post
journals in your primary set of books.
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Steps to Enter Daily RatesSteps to Enter Daily Rates

1. Navigate to the Daily Rates window.
2. Select the currency.
3. Change the To: currency (functional currency) that

will be displayed automatically. If your functional
currency is an EMU currency, the To currency
defaults to EUR.

4. Enter the conversion Date and Type.
5. Enter the conversion rate to be used to convert

foreign currency journal amounts into functional
currency equivalents.
Rates entered in one column will be converted to
the inverse in the other column.

1. Navigate to the Daily Rates window.
2. Select the currency.
3. Change the To: currency (functional currency) that

will be displayed automatically. If your functional
currency is an EMU currency, the To currency
defaults to EUR.

4. Enter the conversion Date and Type.
5. Enter the conversion rate to be used to convert

foreign currency journal amounts into functional
currency equivalents.
Rates entered in one column will be converted to
the inverse in the other column.

(N) Setup > Currencies > Rates > Daily(N) Setup > Currencies > Rates > Daily
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Daily Rates Profile OptionsDaily Rates Profile Options

• Enforce Inverse Relationship During Entry:
– Yes: rates in both From and To Currency

columns have inverse relationship. If either
rate is changed, the inverse is automatically
recalculated.

– No: change rates in both columns
independently.

• Journals: Display Inverse Rate
– Displays inverse exchange rates in Enter

Journals and other windows.

• Enforce Inverse Relationship During Entry:
– Yes: rates in both From and To Currency

columns have inverse relationship. If either
rate is changed, the inverse is automatically
recalculated.

– No: change rates in both columns
independently.

• Journals: Display Inverse Rate
– Displays inverse exchange rates in Enter

Journals and other windows.
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Period Rate Description
Period-
Average Rate

Used to perform currency translation
(income statement accounts)

Period-End
Rate

Used to perform currency translation
(balance sheet accounts)
Inverse is used for revaluation rate (or you
can enter revaluation rate directly)

Revaluation
Rate

Used to perform revaluation
Inverse is used for period-end rate (or you
can enter period-end rate directly)

Enter for Actual or Budget amountsEnter for Actual or Budget amounts

For more information, see:
(Help) Oracle Applications Help > Oracle Financial Applications >
Oracle General Ledger > Multi-Currency > Entering Period Rates
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Steps to Enter Period RatesSteps to Enter Period Rates

1. Navigate to the Period Rates window.
2. In the To field, enter the Currency you want to

translate.
3. Choose the Balance Type and accounting Period

for the period rates.
4. Enter the Period-Average rate for the accounting

period.
5. Enter the period-end rate for the accounting period

or enter the revaluation rate.

1. Navigate to the Period Rates window.
2. In the To field, enter the Currency you want to

translate.
3. Choose the Balance Type and accounting Period

for the period rates.
4. Enter the Period-Average rate for the accounting

period.
5. Enter the period-end rate for the accounting period

or enter the revaluation rate.

(N) Setup > Currencies > Rates > Period(N) Setup > Currencies > Rates > Period
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Using Period Rates with EMU CurrenciesUsing Period Rates with EMU Currencies

National currencyNational currency Interim EMUInterim EMU

EMUEMU
currencycurrency

Start of 
period

01-Jan01-Jan 15-Jan15-Jan 31-Jan31-Jan

Start date 
in EMU

EMU
currency

FrenchFrench
francfranc

Year 2000Year 2000
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Period Average Rates for EMU CurrenciesPeriod Average Rates for EMU Currencies
(3) From
Currency
Currency
Derivation To Currency Currency Derivation

Other Euro EMU Interim EMU
Other Entered Entered (1) Derived (1) Entered
Euro Entered N/A Derived (2) Entered
EMU Entered Derived (2) Derived (2) Entered
Interim EMU Entered Entered Entered Entered

(1) After you close the Period Rates window, the Maintain Period
Rates program is run, which creates these derived rates, based on
period-average and period-end rates you have entered.

(2) Rates are derived automatically when you open a new period or
budget year.

(3) The From Currency is also the set of books’ functional currency.

(1) After you close the Period Rates window, the Maintain Period
Rates program is run, which creates these derived rates, based on
period-average and period-end rates you have entered.

(2) Rates are derived automatically when you open a new period or
budget year.

(3) The From Currency is also the set of books’ functional currency.
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Period-End Rates for EMU CurrenciesPeriod-End Rates for EMU Currencies
(4) From
Currency
Currency
Derivation To Currency Currency Derivation

Other Euro EMU Interim EMU
Other Entered Entered (1) Derived (1) Entered
Euro Entered N/A Derived (2) Entered
EMU Entered Derived (2) Derived (2) Entered
Interim EMU Entered Derived (3) Derived (3) Derived (3)

(1) After you close the Period Rates window, the Maintain Period Rates
program is run, which creates these derived rates, based on period-
average and period-end rates you have entered.

(2) Rates are derived automatically when you open a new period or
budget year.

(3) The rate is derived from the Period Rates window when you enter the
period-average rate for the period.

(4) The From Currency is also the set of books’ functional currency.

(1) After you close the Period Rates window, the Maintain Period Rates
program is run, which creates these derived rates, based on period-
average and period-end rates you have entered.

(2) Rates are derived automatically when you open a new period or
budget year.

(3) The rate is derived from the Period Rates window when you enter the
period-average rate for the period.

(4) The From Currency is also the set of books’ functional currency.
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Currency DerivationsCurrency Derivations
Currency
Derivation

Type Effective Examples/Notes

Other Null (blank) N/a USD, JPY, AUD (currencies
of some non-EMU countries)

Euro Euro
Currency

N/a EUR. The official single
currency of the European
Monetary Union

EMU EMU Derived Any day of
the effective
starting
period

FRF, DEM, BEF, etc.

Interim EMU EMU Derived Any day other
than the first
day of the
effective
starting
period.

FRF, DEM, BEF, etc.

Currency Derivation
• Other: National currencies of EMU member states are treated as having a

currency derivation of Other for periods preceding their effective starting
date in the European Monetary Union.

• EMU: Regarding Period Rates, National currencies of EMU member
states for all full periods following the effective starting date are
considered to have a currency derivation of EMU.

• Interim EMU
– Period Rates Note: National currencies of EMU member states for

the effective starting period are considered to have a currency
derivation of Interim EMU.

– Note: Applies only when the effective starting date is not the first
day of the period. Also, the currency derivation is only in effect for
the first period. It becomes EMU for all subsequent periods.



Copyright © Oracle Corporation, 2000. All rights reserved.

Accounting for Foreign and Multiple Currencies
Chapter 24 - Page 41

Entering EMU Currency Period Rates

Copyright © Oracle Corporation, 2001. All rights reserved.
®

Entering EMU Currency Period RatesEntering EMU Currency Period Rates

• EMU Fixed Rate relationship is used for EMU to
EMU translation and revaluation
– Example: When translating British Pounds to

French Francs, British Pounds are translated
to euro using EMU fixed rate, then to French
Francs using EMU fixed rate.

• EMU to non-EMU rate can be entered if you set the
profile option: Allow Direct EMU/Non-EMU User
Rates, to YES

• EMU Fixed Rate relationship is used for EMU to
EMU translation and revaluation
– Example: When translating British Pounds to

French Francs, British Pounds are translated
to euro using EMU fixed rate, then to French
Francs using EMU fixed rate.

• EMU to non-EMU rate can be entered if you set the
profile option: Allow Direct EMU/Non-EMU User
Rates, to YES
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Running the Maintain Euro Period Rates
Program

Running the Maintain Euro Period Rates
Program

• Creates derived period-average and period-end
rates based on period rates you have entered.
– Actuals: creates derived rates for all closed,

open, and future enterable periods in current
set of books

– Budgets: creates derived rates for all periods
up through the last period of the latest open
budget year.

• Run through Submit Request window whenever
you add or change an EMU currency

• Creates derived period-average and period-end
rates based on period rates you have entered.
– Actuals: creates derived rates for all closed,

open, and future enterable periods in current
set of books

– Budgets: creates derived rates for all periods
up through the last period of the latest open
budget year.

• Run through Submit Request window whenever
you add or change an EMU currency
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Running the Maintain Euro Period Rates
Program

Running the Maintain Euro Period Rates
Program

• When you use the Period Rates window to enter
period rates from another currency to the Euro
currency.

• If your set of books’ functional currency is Euro or
an EMU currency, it runs automatically after you
open your first or subsequent accounting periods.

• If your set of books’ functional currency is Euro or
an EMU currency, it runs automatically after you
open your first or subsequent budget years.

• Derived rates will be created for each period in
your budget year.

• When you use the Period Rates window to enter
period rates from another currency to the Euro
currency.

• If your set of books’ functional currency is Euro or
an EMU currency, it runs automatically after you
open your first or subsequent accounting periods.

• If your set of books’ functional currency is Euro or
an EMU currency, it runs automatically after you
open your first or subsequent budget years.

• Derived rates will be created for each period in
your budget year.

The Maintain Euro Period Rates program runs
automatically in the following situations:
The Maintain Euro Period Rates program runs
automatically in the following situations:
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SummarySummary

This lesson covered the following topics:
• Defining and enabling new currencies, such as

Non-ISO and EMU currencies
• Entering period rates for all types of currencies
• Defining daily conversion rate types and entering

daily rates

This lesson covered the following topics:
• Defining and enabling new currencies, such as

Non-ISO and EMU currencies
• Entering period rates for all types of currencies
• Defining daily conversion rate types and entering

daily rates
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Practice 1 OverviewPractice 1 Overview

Practice contents:
• Defining currencies
• Defining conversion rate types
• Defining daily conversion rates

Practice contents:
• Defining currencies
• Defining conversion rate types
• Defining daily conversion rates
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Scenario
Your organization is about to start doing business
with the country of Oraclia. The VP of Finance
wants you to define Oraclia’s currency, the
Oraclian dollar, and a new conversion rate type
called Private. He also asks you to use the Private
conversion rate type to enter a conversion rate for
converting Oraclian dollars to U.S. dollars in the
latest open period. The conversion rate of 1.0671
U.S. dollars is equivalent to one Oraclian dollar.

Scenario
Your organization is about to start doing business
with the country of Oraclia. The VP of Finance
wants you to define Oraclia’s currency, the
Oraclian dollar, and a new conversion rate type
called Private. He also asks you to use the Private
conversion rate type to enter a conversion rate for
converting Oraclian dollars to U.S. dollars in the
latest open period. The conversion rate of 1.0671
U.S. dollars is equivalent to one Oraclian dollar.

Instructions
1. Open the Currencies window and enter <Unique Identifier> OCL as

thecurrency code and <Unique Identifier> Oraclian dollars as the currency
name. Use your initials or your two-digit terminal number for the unique
identifier.

• Leave the Issuing Territory field blank.
• Use a precision of 2.
• Do not enter a minimum accountable unit.

2. Open the Conversion Rate Types window. Enter the name <Unique
Identifier> Private and a description of the Private conversion rate type.

3. Open the Daily Rates window. Enter the Oraclian currency code, <Unique
Identifier> OCL in the From Currency field.

• Enter any date in the latest open period.
• Choose the <Unique Identifier> Private conversion rate type.
• Enter a rate of 1.0671 USD to <Unique Identifier> OCL.
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Step 1 Solution
1. Open the currencies window.

(N) Setup > Currencies > Define
2. Enter <Unique Identifier> OCL in the Code field. For example, 01OCL.
3. Enter <Unique Identifier> Oraclian Dollars in the Name field.
4. Optionally enter a Description.
5. Leave Issuing Territory and Symbol blank.
6. Enter 2 for Precision and 5 for Extended Precision.
7. Leave the Minimum Accountable Unit field blank.
8. In the Effective Date From field, enter today’s date. Leave the To field blank.
9. Select the Enabled check box.
10. Save your work and close this window.
Step 2 Solution
1. Open the Conversion Rates Types window.

(N) Setup > Currencies > Rates > Types
2. Enter <Unique Identifier> Private.
3. Optionally enter a description.
4. Save your work and close this window.
Step 3 Solution
1. Open the Daily Rates window
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(N) Setup > Currencies > Rates > Daily
2. In the Currency From field, choose the currency you defined (for example,

01OCL) from the list of values.
3. Tab to the Type field, and choose your Conversion Type (for example,

01Private) from the list of values.
4. Tab to the USD to <Unique Identifier> OCL field and enter 1.0671. Press the

tab key again to populate the <Unique Identifier> OCL to USD field. This
field should populate with the value .9371192953.

5. Save your work.
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• Overview of translation and revaluation
• Defining foreign currencies and conversion rates
• Creating foreign currency journals
• Revaluing foreign currency balances
• Translating foreign currency balances

• Overview of translation and revaluation
• Defining foreign currencies and conversion rates
• Creating foreign currency journals
• Revaluing foreign currency balances
• Translating foreign currency balances
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After completing this lesson, you should be able to
do the following:
• Enter journals in any currency
• Post foreign currency journals
• Review foreign currency journal amounts and

account balances in entered and converted
currencies

• Run reports in any currency

After completing this lesson, you should be able to
do the following:
• Enter journals in any currency
• Post foreign currency journals
• Review foreign currency journal amounts and

account balances in entered and converted
currencies

• Run reports in any currency

For more information, see:
(Help) Oracle Applications Help > Oracle Financial Applications >
Oracle General Ledger > Journal Entry > Entering Foreign Currency
Journals
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Oracle General Ledger converts journal amounts
entered in a foreign currency to functional currency
equivalents using daily conversion rates.

Oracle General Ledger converts journal amounts
entered in a foreign currency to functional currency
equivalents using daily conversion rates.

Functional
currency

ConversionConversion

Dollar

  Foreign
currency

Yen
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Methods for Entering Foreign Currency
Journals

Methods for Entering Foreign Currency
Journals

Foreign Currency Journals
• You can enter foreign currency journal entries

directly in the Enter Journals window or,
alternatively, you can enter foreign currency
journals in a Microsoft Excel worksheet created in
the Journal Wizard and take advantage of the
spreadsheet’s functionality.

Foreign Currency Journal Batches
• You can organize journal entries with common

attributes into batches. All journal entries in a
batch must share the same period. If you do not
want to enter batch information, you can enter a
journal directly.

Foreign Currency Journals
• You can enter foreign currency journal entries

directly in the Enter Journals window or,
alternatively, you can enter foreign currency
journals in a Microsoft Excel worksheet created in
the Journal Wizard and take advantage of the
spreadsheet’s functionality.

Foreign Currency Journal Batches
• You can organize journal entries with common

attributes into batches. All journal entries in a
batch must share the same period. If you do not
want to enter batch information, you can enter a
journal directly.
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Entering Journals Using MRCEntering Journals Using MRC

Primary Set
of Books

Dollar

• Enter routine
journals in your
primary currency

• Post journals
• Report on balances

French franc

Euro

Multiple Reporting
Sets of Books

•• TransactionsTransactions
areare
maintained inmaintained in
both books.both books.

•• Journals areJournals are
converted toconverted to
each of theeach of the
reportingreporting
currencies.currencies.

Belgian franc

• Post journals

• Report on balances
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Steps to Create a New Batch with Multiple
Journal Entries

Steps to Create a New Batch with Multiple
Journal Entries

1. Navigate to the Find Journals window and select
New Batch.

2. (Optional) Enter a batch name.
3. Enter the accounting period.
4. Enter a description for the batch.
5. Select the Journal Type (Standard or Average)
6. (Optional) Enter a Control Total.
7. Select Journals.

1. Navigate to the Find Journals window and select
New Batch.

2. (Optional) Enter a batch name.
3. Enter the accounting period.
4. Enter a description for the batch.
5. Select the Journal Type (Standard or Average)
6. (Optional) Enter a Control Total.
7. Select Journals.

(N) Journals > Enter > (B)New Batch > (N) Journals > Enter > (B)New Batch > 

For more information, see:
(Help) Oracle Applications Help > Oracle Financial Applications >
Oracle General Ledger > Journal Entry > Creating Journal Batches
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Steps to Enter a Foreign Currency
Journal

Steps to Enter a Foreign Currency
Journal

1. Navigate to the Enter Journals window
2. Enter the journal information and specify the

foreign currency type.
3. Enter the journal currency conversion information:

– Effective Date must be within accounting
period.

– Conversion Date defaults to Effective Date.
– Enter the conversion Type.
– Enter conversion Rate if User Type is chosen.

4. Enter the journal lines in the foreign currency.
5. If profile option Journals: Allow Multiple Exchange

Rates is enabled, you can override converted line
amounts.

1. Navigate to the Enter Journals window
2. Enter the journal information and specify the

foreign currency type.
3. Enter the journal currency conversion information:

– Effective Date must be within accounting
period.

– Conversion Date defaults to Effective Date.
– Enter the conversion Type.
– Enter conversion Rate if User Type is chosen.

4. Enter the journal lines in the foreign currency.
5. If profile option Journals: Allow Multiple Exchange

Rates is enabled, you can override converted line
amounts.

(N) Journals > Enter > (B)New Batch > 
(B) Journals
(N) Journals > Enter > (B)New Batch > 
(B) Journals

For more information, see:
(Help) Oracle Applications Help > Oracle Financial Applications >
Oracle General Ledger > Journal Entry > Entering Foreign Currency
Journals
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Steps to Change the Currency of
Unposted Journal Entry

Steps to Change the Currency of
Unposted Journal Entry

1. Navigate to the Enter Journals window and select
the batch and journal entry.

2. Select Change Currency.
3. Enter the currency conversion information:

– The conversion Date must be within the
accounting period. It is the posting date for the
journal entry. Default is the Effective Date
displayed in More Details window.

– Select the conversion Type and enter the
conversion Rate if needed.

4. Post the journal entry and save your work.

1. Navigate to the Enter Journals window and select
the batch and journal entry.

2. Select Change Currency.
3. Enter the currency conversion information:

– The conversion Date must be within the
accounting period. It is the posting date for the
journal entry. Default is the Effective Date
displayed in More Details window.

– Select the conversion Type and enter the
conversion Rate if needed.

4. Post the journal entry and save your work.

(N) Journals > Enter > (B)New Batch > 
(B) Journals  > (B) Change Currency
(N) Journals > Enter > (B)New Batch > 
(B) Journals  > (B) Change Currency

For more information, see:
(Help) Oracle Applications Help > Oracle Financial Applications >
Oracle General Ledger > Journal Entry > Changing the Journal Entry
Currency
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When you post foreign currency journals, Oracle
General Ledger maintains both entered balances and
converted balances in the GL_BALANCES TABLE.

When you post foreign currency journals, Oracle
General Ledger maintains both entered balances and
converted balances in the GL_BALANCES TABLE.

GL_BALANCES TABLE

CC_ID CURRENCY PERIOD_
NET_DR

PERIOD_
NET_CR

PERIOD_
NET_DR_BEQ

PERIOD_
NET_CR_BEQ

41357 FOREIGN 10,000 8,000
39872 FOREIGN 10,000 8,000
41357 FUNCTIONAL  8,000
39872 FUNCTIONAL  8,000

Note: BEQ stands for base (functional) equivalent.Note: BEQ stands for base (functional) equivalent.

Posting Foreign Currency Journals
You can post journal batches or journals to update the account balances of your
detail and summary accounts. You can post from the Post Journals window or
from the More Actions window when you are entering or reviewing a journal
entry.
If you post a journal entry into a prior year, General Ledger adjusts your
retained earnings balance for the effect on your income and expense accounts.
Hint: Run a Trial Balance Report whenever you post to a previous fiscal year to
ensure that your Retained Earnings account is properly reconciled.

Multiple Reporting Currencies
If you use General Ledger’s Multiple Reporting Currencies feature, General
Ledger generates unposted journal batches in your reporting sets of books
automatically. You must post entries in your primary set of books as well as in
each of your reporting sets of books.
Note: You must define appropriate daily rates for your reporting currencies
before you post journals in your primary set of books.
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Steps to Post a Journal Entry BatchSteps to Post a Journal Entry Batch

1. Navigate to the Journals window and query the
journal you want to post.

2. Select More Actions.
3. Select Post.

– This submits a concurrent request to post the
batch.

– The entire batch that contains the journal entry
will be posted.

3. Review the Posting Execution Report to determine
if there were any errors during posting.

1. Navigate to the Journals window and query the
journal you want to post.

2. Select More Actions.
3. Select Post.

– This submits a concurrent request to post the
batch.

– The entire batch that contains the journal entry
will be posted.

3. Review the Posting Execution Report to determine
if there were any errors during posting.

(N) Journals > Enter > (B)New Batch > 
(B) Journals (B) More Actions
(N) Journals > Enter > (B)New Batch > 
(B) Journals (B) More Actions

For more information, see:
(Help) Oracle Applications Help > Oracle Financial Applications >
Oracle General Ledger > Journal Entry > Posting Journal Batches
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Steps to Review Balance InformationSteps to Review Balance Information

1. Navigate to the Account Inquiry window.
2. Enter the range of Accounting Periods to include

in your inquiry.
3. Specify the currency (All or Single).
4. Select the Currency Type (Entered or Translated).
5. Choose Primary Balance Type.
6. Specify whether to view Actual, Budget, or

Encumbrance balances.
7. Specify the Factor for display and precision.
8. Enter the accounts to review.
9. Click Show Balances.

1. Navigate to the Account Inquiry window.
2. Enter the range of Accounting Periods to include

in your inquiry.
3. Specify the currency (All or Single).
4. Select the Currency Type (Entered or Translated).
5. Choose Primary Balance Type.
6. Specify whether to view Actual, Budget, or

Encumbrance balances.
7. Specify the Factor for display and precision.
8. Enter the accounts to review.
9. Click Show Balances.

(N) Inquiry > Account (B) Show Balances(N) Inquiry > Account (B) Show Balances

For more information, see:
(Help) Oracle Applications Help > Oracle Financial Applications >
Oracle General Ledger > Online Inquiries > Account Inquiry >
Performing an Account Inquiry
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Rounding DifferencesRounding Differences

• When you enter a foreign currency journal, the
entered amounts may be in balance, but the
converted amounts may be out of balance due to
rounding errors that occur during conversion.

• You can specify a separate Rounding Differences
account in the Set of Books form to track the
imbalances that occur during the conversion of
foreign currency journals.

• When you enter a foreign currency journal, the
entered amounts may be in balance, but the
converted amounts may be out of balance due to
rounding errors that occur during conversion.

• You can specify a separate Rounding Differences
account in the Set of Books form to track the
imbalances that occur during the conversion of
foreign currency journals.
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Period Rates Listing Lists defined exchange rates for any accounting
period, including the period-average and period-
end translation rates and revaluation rates. This
information is also available online.

Foreign Currency Listings
Name Description

Daily Conversion Rates
Listing

Lists the daily conversion rates defined for a
specific foreign currency and accounting period.
This information is also available online.

Historical Rates Listing Lists defined historical translation rates and
amounts. This information is also available
online.

Reporting on Foreign CurrenciesReporting on Foreign Currencies

Review the conversion rates defined for any
accounting period using standard listings requested
from the Submit Requests window.

Review the conversion rates defined for any
accounting period using standard listings requested
from the Submit Requests window.
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This lesson covered the following topics:
• Entering journals in any currency
• Viewing journal amounts and account balances in

entered and converted currencies
• Running reports in any currency

This lesson covered the following topics:
• Entering journals in any currency
• Viewing journal amounts and account balances in

entered and converted currencies
• Running reports in any currency
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Practice 2 OverviewPractice 2 Overview

Practice contents:
• Entering a foreign currency journal entry
• Reviewing foreign currency accounting

information by using foreign currency standard
reports

Scenario
• You need to enter and review a foreign currency

journal entry to capture consulting revenue and
the resulting receivable in Oraclian dollars.

Practice contents:
• Entering a foreign currency journal entry
• Reviewing foreign currency accounting

information by using foreign currency standard
reports

Scenario
• You need to enter and review a foreign currency

journal entry to capture consulting revenue and
the resulting receivable in Oraclian dollars.

Step 1: Creating a Journal Batch Using a Foreign Currency
1. Create a journal batch named <Unique Identifier> Consulting Revenues for

the latest open period. Use your initials or the two-digit terminal number for
the unique identifier.

2. Name the journal entry Consulting Revenues and enter Accrual for the journal
category. Choose the <Unique Identifier> OCL currency defined in the last
practice, Practice 1.

3. Enter the appropriate conversion date and the conversion rate time <Unique
Identifier> Private.

4. Enter the following journal lines.
• Debit the Accounts Receivable account 01-000-1210-xxxx-000 for

360,000 Oraclian dollars.
• Credit the Consulting Revenue account 01-430-4130-xxxx-000 for

360,000 Oraclian dollars.
• Replace xxxx with your unique subaccount segment.
• View the conversion results in the scrolling region.

Note: that Oracle General Ledger displays your journal amounts entered in
Oraclian dollars and converted to U.S. dollars using the rate you defined.

Step 2: Posting and Reviewing Your Batch
Approve, then post your journal batch and review the posted account
balances online.

Step 3: Running a Foreign Currency Journals Report
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Run a Foreign Currency Journals Report for currency code <Unique Identifier>
OCL and the latest open accounting period. Choose the Line Item type and the
posting status.
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Step 1 Solution
1. Navigate to the Enter Journals window.

(N) Journals > Enter
2. Select New Batch and enter your batch name in the Batch field. Accept the

default latest open period in the Period field.
3. Select Journals to open the Journals window.
4. Enter the journal entry name in the Journal field.
5. Use the list of values to select Accrual in the Category field.
6. Use the list of values to select <Unique Identifier> OCL in the Currency

field.
7. Enter the date in the latest open period.
8. Use the list of values to enter your conversion rate type in the Type field.
9. On one line, debit the Accounts Receivable account 01-000-1210-xxxx-000

for 360,000 Oraclian dollars.
10. On the next line, credit the Consulting Revenue account 01-430-4130-xxxx-

000 for 360,000 Oraclian dollars..
11. View the conversion results in the scrolling region.
Step 2 Solution
1. Select More Actions > Post to post your batch.
2. Navigate to the Concurrent Manager and view your requests:

• Select View > Requests and select your batch.
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• Click Refresh Data in the Concurrent Manager until the posting is
completed.

3. Navigate to the Account Inquiry window.
(N) Inquiry > Account

4. In both the From and To Accounting Period fields accept the default latest
open period

5. In the Currency field, use the list of values to enter <Unique Identifier>
OCL.

6. Query the range of accounts 01-000-1210-xxxx-000 to 01-430-4130-xxxx-
000, replacing xxxx with your unique identifier.

7. Select Show Balances to view account balances.
Step 3 Solution
1. Navigate to the Submit Request window.

(N) Reports > Request > Standard
2. Select a Single Report.
3. Use the list of values to select Report in the type field and to select Journals–

Foreign Currency (132 Char) in the Name field.
4. In the Parameters list of values, select Line Item in the Type field, Posted in

the Posting Status field, <Unique Identifier> OCL in the Currency field.. Skip
the remaining fields.

5. Click the OK button and submit your request. Note your concurrent request
ID number.

6. Navigate to the Concurrent Manager and view your requests:
Select View > Requests and select your report.

7. Click Refresh Data in the Concurrent Manager until the report is completed.
8. When the process complete, select the View Output button to view your report

online.
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• Overview of translation and revaluation
• Defining foreign currencies and conversion rates
• Creating foreign currency journals
• Revaluing foreign currency balances
• Translating foreign currency balances

• Overview of translation and revaluation
• Defining foreign currencies and conversion rates
• Creating foreign currency journals
• Revaluing foreign currency balances
• Translating foreign currency balances
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After completing this lesson, you should be able to
do the following:
• Define revaluation rates
• Run revaluation and record unrealized

gains/losses
• Reverse revaluation journals

After completing this lesson, you should be able to
do the following:
• Define revaluation rates
• Run revaluation and record unrealized

gains/losses
• Reverse revaluation journals

For more information, see:
(Help) Oracle Applications Help > Oracle Financial Applications >
Oracle General Ledger > Multi Currency > Revaluing Balances
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Overview of Revaluing BalancesOverview of Revaluing Balances

Revalue account balances to reflect the change in the
foreign currency rate from the date a transaction is
entered and the reporting date. The revaluation
process posts the change in the converted balances
to the Unrealized Gain/Loss Account.

Revalue account balances to reflect the change in the
foreign currency rate from the date a transaction is
entered and the reporting date. The revaluation
process posts the change in the converted balances
to the Unrealized Gain/Loss Account.

Original U.S. ReceivableOriginal U.S. Receivable
  1000 French francs   1000 French francs 
      550 U.S. dollars      550 U.S. dollars

ChicagoChicagoParisParis

Revalued U.S. ReceivableRevalued U.S. Receivable
 1000 French francs  1000 French francs 
    600 U.S. dollars    600 U.S. dollars

USD Unrealized Gain
     50 U.S. dollars
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• You can revalue balance sheet accounts that are
denominated in a foreign currency in accordance
with SFAS 52 (U.S.).

• Revaluation reflects changes in conversion rates
between the date of journal entry and the date of
receipt/ payment of the foreign currency amount.

• General Ledger posts the change in converted
balances against the unrealized gain/loss account
you specify.

• You can revalue a single account or ranges of
accounts.

• You can revalue balance sheet accounts that are
denominated in a foreign currency in accordance
with SFAS 52 (U.S.).

• Revaluation reflects changes in conversion rates
between the date of journal entry and the date of
receipt/ payment of the foreign currency amount.

• General Ledger posts the change in converted
balances against the unrealized gain/loss account
you specify.

• You can revalue a single account or ranges of
accounts.
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When you run revaluation, General Ledger:
• Creates a revaluation batch containing a separate

journal entry for each revalued foreign currency.
• Creates the revaluation adjustments in your

functional currency.
• Automatically defines the reversal period as the

next accounting period.

When you run revaluation, General Ledger:
• Creates a revaluation batch containing a separate

journal entry for each revalued foreign currency.
• Creates the revaluation adjustments in your

functional currency.
• Automatically defines the reversal period as the

next accounting period.
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Revaluation PrerequisitesRevaluation Prerequisites

Before you run revaluations, you should do the
following:
Before you run revaluations, you should do the
following:

• Define an unrealized gain/loss account
• Define a revaluation rate for each currency for

each period for which you want to run revaluation

• Define an unrealized gain/loss account
• Define a revaluation rate for each currency for

each period for which you want to run revaluation
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• PTD Revaluation for Income Statement Accounts
– You can specify whether you want to revalue

income statement accounts using the period-
to-date (PTD) or year-to-date (YTD) balances.

– Revaluing the PTD balances creates weighted
average YTD balances with average period
rates, and produces more accurate results in
compliance with SFAS No. 52 standards.

– PTD revaluation produces separate journal
entries to revalue balance sheet accounts and
income statement accounts.

• PTD Revaluation for Income Statement Accounts
– You can specify whether you want to revalue

income statement accounts using the period-
to-date (PTD) or year-to-date (YTD) balances.

– Revaluing the PTD balances creates weighted
average YTD balances with average period
rates, and produces more accurate results in
compliance with SFAS No. 52 standards.

– PTD revaluation produces separate journal
entries to revalue balance sheet accounts and
income statement accounts.
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Steps to Revalue Account BalancesSteps to Revalue Account Balances

1. Navigate to the Revalue Balances window.
2. Enter the accounting period for the revaluation.
3. Enter the Unrealized Gain/Loss Account.
4. Select the Currency Option:

– Single currency: a specific foreign currency
– EURO+EMU: all currencies whose currency

derivation is euro, EMU, and Interim EMU
– All currencies: all foreign currencies

For all currencies, General Ledger revalues each
foreign currency only if a period rate exists for the
currency and period.

1. Navigate to the Revalue Balances window.
2. Enter the accounting period for the revaluation.
3. Enter the Unrealized Gain/Loss Account.
4. Select the Currency Option:

– Single currency: a specific foreign currency
– EURO+EMU: all currencies whose currency

derivation is euro, EMU, and Interim EMU
– All currencies: all foreign currencies

For all currencies, General Ledger revalues each
foreign currency only if a period rate exists for the
currency and period.

(N) Currency > Revaluation(N) Currency > Revaluation
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6. If you choose Single currency, enter the currency.
In addition, you may need to enter a Rate.

7. Enter an Account Low and High for each range of
accounts to revalue.
– If the profile option: GL:Revaluation

AutoQuery Last Run Range is set to Yes, the
Revalue Ranges automatically displays the GL
account number ranges last used.

– You can use these ranges and proceed with
the revaluation, or you can delete the record
and enter new account number ranges.

6. If you choose Single currency, enter the currency.
In addition, you may need to enter a Rate.

7. Enter an Account Low and High for each range of
accounts to revalue.
– If the profile option: GL:Revaluation

AutoQuery Last Run Range is set to Yes, the
Revalue Ranges automatically displays the GL
account number ranges last used.

– You can use these ranges and proceed with
the revaluation, or you can delete the record
and enter new account number ranges.
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Steps to Revalue Account BalancesSteps to Revalue Account Balances

8. Select Revalue.
– General Ledger launches a concurrent

process.
9. The Revaluation Report is automatically

generated. Review the status of your account
revaluation.

10.Post the revaluation journal batch.
MRC: When you post a revaluation journal in your
primary set of books, it is converted to the
reporting sets of books.

8. Select Revalue.
– General Ledger launches a concurrent

process.
9. The Revaluation Report is automatically

generated. Review the status of your account
revaluation.

10.Post the revaluation journal batch.
MRC: When you post a revaluation journal in your
primary set of books, it is converted to the
reporting sets of books.
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Currency
Option

Description

Single Revalue one specific foreign currency.
EURO+EMU Revalue all currencies with EURO,

EMU, and interim EMU derivation
All currencies Revalue all foreign currencies

You can select the following currency options:You can select the following currency options:
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Currency
Derivation

Description

Other Currencies are revalued using the rate
defined in the Revalue Balances window.

EURO
EMU
Fixed EMU

Currencies are revalued using fixed
conversion rate.

Interim EMU Currencies are revalued as follows for the
following currency options:
� Other – rate defined in Revalue

Balances window
� Euro, EMU, Interim EMU – fixed

conversion rate
� All Currencies – rate defined in Revalue

Balances window
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Currency Derivation of Functional
Currency

Currency Derivation of Functional
Currency

Currency
Option

Other Euro or EMU Interim EMU

Single Revalues standard
balances
denominated in the
selected currency
using the specified
rate.

Revalues standard
balances for euro,
EMU, and Interim
EMU using fixed
conversion rate.
Other currencies
are revalued using
the rate for the
currency and
period.

Revalues standard
balances for euro,
EMU, and Interim
EMU using fixed
conversion rate.
Other currencies
are revalued using
the rate for the
currency and
period.

EURO+EMU Revalues standard
balances for euro,
EMU, or Interim
EMU currencies
using the rate for
the currency and
period.

Revalues standard
balances for euro,
EMU, and Interim
EMU using fixed
conversion rate.

Revalues standard
balances for euro,
EMU, and Interim
EMU using fixed
conversion rate.

Currency Derivation
• Other: National currencies of EMU member states are treated as having a

currency derivation of Other for periods preceding their effective starting
date in the European Monetary Union.

• EMU: Regarding Period Rates, National currencies of EMU member
states for all full periods following the effective starting date are
considered to have a currency derivation of EMU.

• Interim EMU
– Period Rates Note: National currencies of EMU member states for

the effective starting period are considered to have a currency
derivation of Interim EMU.

– Note: Applies only when the effective starting date is not the first
day of the period. Also, the currency derivation is only in effect for
the first period. It becomes EMU for all subsequent periods.
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Currency Derivation of Functional
Currency

Currency Derivation of Functional
Currency

Currency
Option

Other Euro or EMU Interim EMU

All Revalues all
standard balances
denominated in a
currency other than
the functional
currency using the
rate for the currency
and period.

Euro or EMU
currencies are not
revalued. Other
currencies are
revalued using the
rate for the currency
and period. Interim
EMU currencies are
revalued using in
the fixed conversion
rate.

Revalues all
standard balances
denominated in a
currency other than
the functional
currency using the
rate for the currency
and period.
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Continuing the Revaluation CycleContinuing the Revaluation Cycle

Revalue Foreign
Currency Balances.

Reverse Revaluation
Journals.

 Yes Yes

Post to Post to UnrealizedUnrealized
Gain/Loss AccountGain/Loss Account

NoNo

Collect foreign 
currency receivable.

Post to Post to RealizedRealized
Gain/Loss AccountGain/Loss Account

Is the
foreign currency
receivable still

unpaid?
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Generated Revaluation Journal EntriesGenerated Revaluation Journal Entries

GL Account
Type

Primary Journal
Line

Offset Journal Line

Asset Target Asset
Account

Selected Gain/Loss
Account

Liability Target Liability
Account

Selected Gain/Loss
Account

Revenue Target Revenue
Account

Cumulative Translation
Adjustment Account

Expense Target Expense
Account

Cumulative Translation
Adjustment Account

Capital No entry No entry
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Posting Unrealized Gains and LossesPosting Unrealized Gains and Losses

• You post the difference between the conversion
amount at the time of the original transaction and
the conversion amount (at the updated revaluation
rate) at the end of the current accounting period.

• If the functional dollar balance (of the revalued
receivable) is higher than the originally converted
functional dollar amount, you record the difference
as an unrealized gain.

• If the revalued amount is lower than the original,
you record the difference as an unrealized loss.

• You post the difference between the conversion
amount at the time of the original transaction and
the conversion amount (at the updated revaluation
rate) at the end of the current accounting period.

• If the functional dollar balance (of the revalued
receivable) is higher than the originally converted
functional dollar amount, you record the difference
as an unrealized gain.

• If the revalued amount is lower than the original,
you record the difference as an unrealized loss.
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Reversing Revaluation JournalsReversing Revaluation Journals

• After reporting on revalued balances, reverse the
revaluation journals and restore the account
balances to the original functional currency (FC)
amounts.

• After reporting on revalued balances, reverse the
revaluation journals and restore the account
balances to the original functional currency (FC)
amounts.

Dr.  Foreign Receivables……10,000 FC
Cr.      Unrealized Gain/Loss Account……....10,000 FC

Create and Post ReversalCreate and Post Reversal

Dr.  Unrealized Gain/Loss Account…...10,000 FC
Cr.         Foreign Receivables…..………………......10,000 FC

Revaluation Journal EntryRevaluation Journal Entry
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Posting Realized Gains and LossesPosting Realized Gains and Losses

• When a foreign receivable is paid, you post the
difference between the conversion amount at the
time of the original transaction and when the
receivable is settled to the Realized Gain/Loss
account.

• NOTE: Because you always reverse your
revaluation journals, prior revaluations have no
effect on the amount posted.

• When a foreign receivable is paid, you post the
difference between the conversion amount at the
time of the original transaction and when the
receivable is settled to the Realized Gain/Loss
account.

• NOTE: Because you always reverse your
revaluation journals, prior revaluations have no
effect on the amount posted.
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SummarySummary

This lesson covered the following topics:
• Defining revaluation rates
• Running revaluation and recording unrealized

gains and losses
• Reversing revaluation journals

This lesson covered the following topics:
• Defining revaluation rates
• Running revaluation and recording unrealized

gains and losses
• Reversing revaluation journals
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Practice 3 OverviewPractice 3 Overview

Practice contents:
• Defining a revaluation rate
• Running revaluation
Scenario

You possess an outstanding receivable in Oraclian
dollars and you want to print accurate accounting
reports for the latest open period. Define the
revaluation rate and run revaluation for the
affected account balance.

Practice contents:
• Defining a revaluation rate
• Running revaluation
Scenario

You possess an outstanding receivable in Oraclian
dollars and you want to print accurate accounting
reports for the latest open period. Define the
revaluation rate and run revaluation for the
affected account balance.

Your instructor will demonstrate this practice for you.
Step 1

• Enter rates for actual balances for the latest open period.
•  Enter <Unique Identifier> OCL as the To Currency. Note that if you have

not previously defined and enabled the Oraclian dollar, you must do so
prior to completing this practice. Be sure to use your initials or the two-
digit terminal number for the unique identifier.

• Enter 0.85 as the Period-Average Rate (Revaluation uses only the
revaluation rate, but the period-average rate is required when defining
period rates for foreign currencies.).

• Skip the Period-End Rate and enter a Revaluation Rate of 1.1494. Note
that Oracle General Ledger calculates the period-end rate as the reciprocal
of the revaluation rate, or 0.87.

Step 2
• Run revaluation for the latest open period and currency <Unique

Identifier> OCL.
• Specify 01.740.7864.xxxx.000 as the Unrealized Gain/Loss account.

Replace xxxx with your unique subaccount number.
Step 3

• Review and post the revalued journal to update account balances. Note
that Oracle General Ledger named the batch Revalues<Period> <Date>
<Time>.
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• The journal entry has the foreign currency as the currency and the journal
will show a zero balance. Note that the converted amounts are nonzero.
This is correct—Do not delete the batch!
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Step 1 Solution
1. Navigate to the Period Rates window.

(N) Setup > Currencies > Rates > Period
2. Accept the default USD in the From Currency field. Enter <Unique

Identifier> OCL in the To Currency field.
3. Select Actual in the Balance type field, and the latest open period in the

Period field.
4. Enter 0.85 in the Average field.
5. Skip the End field and enter 1.1494 in the Revaluation field.
6. Save your work and and note your concurrent request ID.
Step 2 Solution
1. Navigate to the Revalue Balances window.
2. (N) Currency > Revaluation
3. Enter the latest open period in the Period field and <Unique Identifier> OCL

in the Currency field.
4. Specify 01.740.7864.xxxx.000 as the Unrealized Gain/Loss account.
5. Enter the Rate 1.1494.
6. Enter balance sheet accounts only (do not enter any P&L account).
7. Save your work and note your concurrent request ID.
Step 3 Solution
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1. When your concurrent process completes, navigate to the Post Journals
window.

(N) Journals > Post
2. Locate your batch and select it for posting.
3. Save your work and note your concurrent request ID.
4. After the journal has posted, select View Output and review the journal.
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• Overview of translation and revaluation
• Defining foreign currencies and conversion rates
• Creating foreign currency journals
• Revaluing foreign currency balances
• Translating foreign currency balances

• Overview of translation and revaluation
• Defining foreign currencies and conversion rates
• Creating foreign currency journals
• Revaluing foreign currency balances
• Translating foreign currency balances
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ObjectivesObjectives

After completing this lesson, you should be able to
do the following:
• Describe the purpose of the Cumulative

Adjustment Account
• Define historical rates
• Translate account balances into any currency
• Describe how Multiple Reporting Currencies (MRC)

handles translation

After completing this lesson, you should be able to
do the following:
• Describe the purpose of the Cumulative

Adjustment Account
• Define historical rates
• Translate account balances into any currency
• Describe how Multiple Reporting Currencies (MRC)

handles translation

For more information, see:
(Help) Oracle Applications Help > Oracle Financial Applications >
Oracle General Ledger > Multi Currency > Translating Balances
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Overview of Translating Foreign Currency
Balances

Overview of Translating Foreign Currency
Balances

Oracle General Ledger allows translation of actual or
budget balances from the functional currency into
any reporting currency.
• Oracle General Ledger multiplies your functional

currency account balances by the average,
periodic, or historical rate you define.

• Running translation does not create journals for
any functional currency account balance.

• Running translation adds lines to the
GL_BALANCES table to store balances in the
desired currency so that you can view and report
on account balances in any foreign currency.

Oracle General Ledger allows translation of actual or
budget balances from the functional currency into
any reporting currency.
• Oracle General Ledger multiplies your functional

currency account balances by the average,
periodic, or historical rate you define.

• Running translation does not create journals for
any functional currency account balance.

• Running translation adds lines to the
GL_BALANCES table to store balances in the
desired currency so that you can view and report
on account balances in any foreign currency.

For more information, see:
(Help) Oracle Applications Help > Oracle Financial Applications >
Oracle General Ledger > Multi Currency > Translating Balances >
Overview
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Translating BalancesTranslating Balances

Oracle General Ledger translates functional currency
balances to a foreign currency based on rates you
define.

Oracle General Ledger translates functional currency
balances to a foreign currency based on rates you
define.

 

• Translated actuals

• Translated budgets

Foreign
currency

• Actual balances

• Budget balances

Functional
currency

Euro

Rate = 1.25Rate = 1.25

Dollar

Translate Actual and Budget Balances
You can translate your actual and budget account balances from your functional
currency to another currency.

Average Balance Processing
If you have average balance processing enabled, you can translate average
balances as well as standard balances. When you translate average balances,
General Ledger uses averages of different rates, depending on whether the
system is translating a nonhistorical account or a historical account

Euro Currency
If you want to report financial results in euro, you can use General Ledger’s
translation feature to translate your account balances from your functional
currency to euro.
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Choosing Standard Translation or
Multiple Reporting Currencies

Choosing Standard Translation or
Multiple Reporting Currencies

Standard Translation
• Amounts translated

at the account
balances level

• For consolidation
needs

• Period or historical
rates used to
translate balances

MRC Translation
• Amounts

automatically
converted at the
transactions level

• For monthly foreign
currency reporting

• Daily rates used to
translate amounts

• Allows inquiry and
reporting of reporting
currencies directly
from subledgers

Translation
General Ledger’s translation feature is used to translate amounts from your
functional currency at the account balances level. Use standard translation if
you only need balances for reporting.
If you use MRC and have properly initialized your reporting set of books’
balances you can report directly from your reporting sets of books without
running Translation. Use MRC if you need transaction level detail for reporting.

Automatic Translation with MRC
Oracle General Ledger’s Multiple Reporting Currencies (MRC) feature is not
intended as a replacement for General Ledger’s translation feature.
However, if you are using MRC, you do not need to run translation (except
when you initialize balances in your reporting sets of books). MRC converts
amounts from your functional currency to a reporting currency at the
transactions level.
Note: Use General Ledger’s standard translation feature instead of MRC if you
only need to translate financial statements for consolidation purposes.
If you use MRC and need to report budget amounts in your reporting currency,
you must translate the budget amounts in your primary books, then consolidate
the translated balances to your reporting books.
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Cumulative Translation Adjustment
Account

Cumulative Translation Adjustment
Account

• Amount is adjusted to balance translated accounts
• For multiple companies or balancing entities in a

set of books, adjustment is made for each entity
• Not used for budget balance translations

• Amount is adjusted to balance translated accounts
• For multiple companies or balancing entities in a

set of books, adjustment is made for each entity
• Not used for budget balance translations

Use the Cumulative Translation Adjustment account
to capture the differences of amounts that are
translated using different rates.

Use the Cumulative Translation Adjustment account
to capture the differences of amounts that are
translated using different rates.

Purpose of the Cumulative Translation Account
When you translate your actual balances into another currency, differences will
exist due to the different translation rates that are used such as Period-End
versus Period-Average versus Historical. General Ledger automatically captures
the net difference in the Cumulative Translation Adjustment account.
You assign a Cumulative Translation Adjustment (CTA) account when you
create a set of books. You can set the account type to Owner’s Equity to create a
translation adjustment on your balance sheet or, if you are using remeasurement,
based on U.S. FASB 52, you can set it to Revenue or Expense to create a
translation gain/loss on your income statement.

Balancing Multiple Companies
If you have multiple companies or balancing entities within a set of books,
General Ledger automatically creates a translation adjustment account for each
company or balancing entity.
Note: No balancing adjustments are made when you translate budget balances
because budgets do not need to balance. If you want to balance your budgets,
you must prepare a separate manual journal entry.
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Terms You Should KnowTerms You Should Know

Period end rate: The daily rate on the last day of
your period

   (Used for Asset and Liability 
accounts)

Period average The average of your daily rates
rate:     throughout your period
   (Used for Revenue and Expense

accounts)
Historical rate:     A weighted average rate for 

transactions that occur at 
different times
(Used for Equity accounts)
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Defining Historical RatesDefining Historical Rates
Historical Rates
• You should define a historical rate before running

translation to avoid having to retranslate your
balances using that rate.

• For certain long-term accounts, you can stabilize
the translated balances by defining fixed historical
rates.

• If you use currencies of countries in highly
inflationary economies, use historical rates to
remeasure specific historical account balances in
accordance with U.S. FASB 8.

Historical Rates
• You should define a historical rate before running

translation to avoid having to retranslate your
balances using that rate.

• For certain long-term accounts, you can stabilize
the translated balances by defining fixed historical
rates.

• If you use currencies of countries in highly
inflationary economies, use historical rates to
remeasure specific historical account balances in
accordance with U.S. FASB 8.

For more information, see:
(Help) Oracle Applications Help > Oracle Financial Applications >
Oracle General Ledger > Multi Currency > Translating Balances >
Notes on Translation with Historical Rates and Amounts
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Historical and Nonhistorical AccountsHistorical and Nonhistorical Accounts

• When you translate average balances, General
Ledger uses averages of different rates,
depending on whether the system is translating a
nonhistorical account or a historical account:
– Nonhistorical Accounts: Uses averages of

daily rates for the rate type specified in the Set
of Books window.

– Historical Accounts: Uses a weighted average
of the historical rates across the number of
periods in the specified range being
translated.

• When you translate average balances, General
Ledger uses averages of different rates,
depending on whether the system is translating a
nonhistorical account or a historical account:
– Nonhistorical Accounts: Uses averages of

daily rates for the rate type specified in the Set
of Books window.

– Historical Accounts: Uses a weighted average
of the historical rates across the number of
periods in the specified range being
translated.



Copyright © Oracle Corporation, 2000. All rights reserved.

Accounting for Foreign and Multiple Currencies
Chapter 24 - Page 100

Translation Rules

Copyright © Oracle Corporation, 2001. All rights reserved.
®

Translation RulesTranslation Rules

Account Type Translation Rule

Revenue and Expense Period-to-Date (PTD) Rule

Assets and Liabilities Year-to-Date (YTD) Rule

YTD (xlt) = Rate X YTD (func)

(xlt) = translated  currency (xlt) = translated  currency 

(func) = functional currency(func) = functional currency

PTD (xlt) = Rate X PTD (func)

For more information, see:
(Help) Oracle Applications Help > Oracle Financial Applications >
Oracle General Ledger > Multi Currency > Translating Balances >
Notes on Translating Owner’s Equity Accounts

General Ledger uses one of two translation rules: Period-to-Date (for Revenue
and Expense accounts) or Year-to-Date (for Asset and Liability accounts). You
can choose to use either of these rules to translate owners’ equity. If you do not
choose a rule, Period-to-Date will be assigned.
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Translating BalancesTranslating Balances

Account Type Balance/Rate Used in Translation

Revenue and Expense

Cumulative balance at Period
End RateAssets and Liabilities

Period balances at Period
Average Rates

Cumulative balance at Period End
Rate unless Historical Rates are
defined for these accounts

Equity
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How to Choose the Translation Rule for
Owners’ Equity Accounts

How to Choose the Translation Rule for
Owners’ Equity Accounts

• Review the setting for the profile option GL:
Owners Equity Translation Rule.
– PTD: Owners’ equity is translated using the

Period-to-Date rule.
– YTD: Owners’ equity is translated using the

Year-to-Date rule.
• NOTE: If you do not maintain historical rates in

your set of books, General Ledger creates them
for each period for which you translate your
owners’ equity accounts, using period-average
rates (if you use the PTD rule) or period-end rates
(if you use the YTD rule).

• Review the setting for the profile option GL:
Owners Equity Translation Rule.
– PTD: Owners’ equity is translated using the

Period-to-Date rule.
– YTD: Owners’ equity is translated using the

Year-to-Date rule.
• NOTE: If you do not maintain historical rates in

your set of books, General Ledger creates them
for each period for which you translate your
owners’ equity accounts, using period-average
rates (if you use the PTD rule) or period-end rates
(if you use the YTD rule).
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Translating Historical AmountsTranslating Historical Amounts

• For accounts using historical rates/amounts you
can use either:
– The amount you provide
– Historical rate times the account balance

• If the profile is set to use PTD amounts, then the
translated balance is the [PTD balance] x [this
month’s historical rate] + [prior month’s YTD
translated amount]

• For accounts using historical rates/amounts you
can use either:
– The amount you provide
– Historical rate times the account balance

• If the profile is set to use PTD amounts, then the
translated balance is the [PTD balance] x [this
month’s historical rate] + [prior month’s YTD
translated amount]
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Steps to Enter Historical RatesSteps to Enter Historical Rates
(N) Setup > Currencies > Rates > Historical
1. Open the Historical Rates window.
2. Enter the Target Currency. It can be any foreign

currency.
3. Enter the Period and the Account to which the

historical rate applies.
4. Enter either Rate or Amount.

– If you enter a rate, Oracle General Ledger
multiplies the functional currency balance of
your account by this rate.

– If you enter an amount, Oracle General Ledger
uses that amount for translation.

(N) Setup > Currencies > Rates > Historical
1. Open the Historical Rates window.
2. Enter the Target Currency. It can be any foreign

currency.
3. Enter the Period and the Account to which the

historical rate applies.
4. Enter either Rate or Amount.

– If you enter a rate, Oracle General Ledger
multiplies the functional currency balance of
your account by this rate.

– If you enter an amount, Oracle General Ledger
uses that amount for translation.
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Steps to Enter Historical RatesSteps to Enter Historical Rates
5. Assign Historical as the Rate Type.
6. Save your work.

– Oracle General Ledger runs a concurrent
process to assign historical rates to the
accounts.

• NOTE:
– You can enter historical rates for a range of

accounts by selecting Assign by Ranges,
then enter an account Low and High.

– The Weighted Average Rate Type is used
for dual currency processing.

5. Assign Historical as the Rate Type.
6. Save your work.

– Oracle General Ledger runs a concurrent
process to assign historical rates to the
accounts.

• NOTE:
– You can enter historical rates for a range of

accounts by selecting Assign by Ranges,
then enter an account Low and High.

– The Weighted Average Rate Type is used
for dual currency processing.
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Steps to Translate Account Balances to a
Foreign Currency

Steps to Translate Account Balances to a
Foreign Currency

(N) Currency > Translation
1. Open the Translate Balances window. The

Functional Currency for your set of books is
shown as the currency you are translating.

2. Select Actual or Budget for the Balance Type to
translate.

3. Select All or enter a single Balancing Segment
Value.

4. Enter any enabled currency (other than your
functional currency) as the Target Currency.

5. Enter the Period name.

(N) Currency > Translation
1. Open the Translate Balances window. The

Functional Currency for your set of books is
shown as the currency you are translating.

2. Select Actual or Budget for the Balance Type to
translate.

3. Select All or enter a single Balancing Segment
Value.

4. Enter any enabled currency (other than your
functional currency) as the Target Currency.

5. Enter the Period name.
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Steps to Translate Account Balances to a Foreign
Currency
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Steps to Translate Account Balances to a
Foreign Currency

Steps to Translate Account Balances to a
Foreign Currency

6. If you are translating budget amounts, enter the
Source and Target budget.
– Do not translate more than one source budget

into the Target budget for which you want to
calculate translated account balances.

– You can translate one source budget into more
than one target budget.

7. Select Translate to translate account balances.

6. If you are translating budget amounts, enter the
Source and Target budget.
– Do not translate more than one source budget

into the Target budget for which you want to
calculate translated account balances.

– You can translate one source budget into more
than one target budget.

7. Select Translate to translate account balances.
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Reviewing Translated BalancesReviewing Translated Balances

• Perform online inquiries on translated balances for
any account in a set of books. Specify the
translation currency in the Account Inquiry
window.

• Run the Translation Trial Balance Report which
lists account balances and period activity after
running translation.

• Perform online inquiries on translated balances for
any account in a set of books. Specify the
translation currency in the Account Inquiry
window.

• Run the Translation Trial Balance Report which
lists account balances and period activity after
running translation.
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SummarySummary

This lesson covered the following topics:
• Using the Cumulative Translation Account to

balance translated amounts
• Describing the difference between standard

translation and translation with Multiple Reporting
Currencies

• Defining historical rates in the Historical Rates
window

• Translating account balances into any currency
and reviewing your translation results

This lesson covered the following topics:
• Using the Cumulative Translation Account to

balance translated amounts
• Describing the difference between standard

translation and translation with Multiple Reporting
Currencies

• Defining historical rates in the Historical Rates
window

• Translating account balances into any currency
and reviewing your translation results
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Practice 4 OverviewPractice 4 Overview

Practice contents:
• Entering historical rates
• Translating actual balances
Scenario
• The VP of Finance wants you to define an

historical rate and use the appropriate rates to
translate all balances into Oraclian dollars.

Practice contents:
• Entering historical rates
• Translating actual balances
Scenario
• The VP of Finance wants you to define an

historical rate and use the appropriate rates to
translate all balances into Oraclian dollars.

Instructions
Step 1

Enter a historical rate of 0.92 for account 01-000-3310-xxxx-000.
Step 2

Translate actual balances for company 01 for the latest open period.
• Enter <Unique Identifier> OCL as the To Currency.
• If you have not previously defined and enabled the Oraclian dollar, do so

now. Be certain to use your initials or two-digit terminal number for the
unique identifier.

• Verify that Oracle General Ledger runs a concurrent process to translate
account balances into Oraclian dollars.

Step 3
Run a Translation Trial Balance Report to view the results of your translation.
Select the <Unique Identifier> OCL currency and the latest open period.
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Step 1 Solution
1. Navigate to the Historical Rates window.

(N) Setup > Currencies > Rates > Historical
2. Enter <Unique Identifier> OCL in the Target Currency field.
3. Enter the latest open period in the Period field, the account above in the

Account field, and 0.92 in the Rate field. Leave the Amount field blank.
4. Accept the default Historical in the Rate Type field and save your work.
Step 2 Solution
1. Navigate to the Translate Balances window.

(N) Currency > Translation
2. Select Actual in the Balance Type field, leave the All box clear, and enter 01

in the Balancing Segment Value field.
3. Use the list of values to enter <Unique Identifier> OCL in the Target

Currency field.
4. Select the latest open period in the Period field.
5. Save your work and note your concurrent request ID.
Step 3 Solution
1. Navigate to the Submit Requests window.
2. (N) Reports > Request > Standard
3. Select Single Request.
4. Use the list of values to select Trial Balance–Translation in the Name field.
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5. In the Parameters list of values window, enter 01 as Low and High values.
6. Use the list of values to enter <Unique Identifier> OCL in the Currency field

and the latest open period in the Period field.
7. Save your work and note your concurrent request ID.
8. Navigate to the Concurrent Manager and after the report is completed, review

it online.
• View > Requests
• After the report is completed, select View Output.



Copyright © Oracle Corporation, 2000. All rights reserved.

Accounting for Foreign and Multiple Currencies
Chapter 24 - Page 113

Working with Multiple Currencies Review

Copyright © Oracle Corporation, 2001. All rights reserved.
®

Working with Multiple Currencies ReviewWorking with Multiple Currencies Review
Update DailyUpdate Daily
Conversion RatesConversion Rates

Enter invoice

Translate ForeignTranslate Foreign
Currency AccountCurrency Account
BalancesBalances

Revalue Asset and
Liability Accounts

1 USD = 7.1 BEF
1 USD = 20 ITL
1 USD = 1.5 AUD

1 USD = 7.1 BEF
1 USD = 20 ITL
1 USD = 1.5 AUD Enter, Import and PostEnter, Import and Post

Foreign Currency JE’sForeign Currency JE’s

Review Entered,Review Entered,
Converted, andConverted, and
Translated CurrencyTranslated Currency
BalancesBalances

PostPost
RevaluationRevaluation
JournalsJournals

JE 126
Foreign
Currency
____ ____
____ ____
____  _____

JE 125
Foreign
Currency
____ ____
____ ____
____  __ __

JE 126
Foreign
Currency
____ ____
____ ____
____  __ ___

JE 125
DR. AR   1000
CR.    GAIN/LOSS 1000
DR. AP    500
CR    GAIN/LOSS    500

Run Foreign Currency TrialRun Foreign Currency Trial
Balance ReportsBalance Reports  andand
Produce Foreign CurrencyProduce Foreign Currency
Financial StatementsFinancial Statements

• Update your daily conversion rates daily.
• Enter, import, and post foreign currency journals.
• Revalue asset and liability accounts whose balances are denominated in a

foreign currency.
• Post the revaluation journal batch to adjust your unrealized gain/loss

account for exchange rate fluctuations.
• Translate account balances before consolidating sets of books with

different functional currencies, or to report account balances in an
alternate currency.

• Review entered, converted, and translated currency balances.
• Run foreign currency Trial Balance reports.
• Produce foreign currency financial statements
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This module covered the following topics:
• Defining currencies, period rates, and conversion

rates for all types of currencies, including the EMU
currencies

• Entering foreign currency journals
• Running Revaluation
• Translating foreign currency balances

This module covered the following topics:
• Defining currencies, period rates, and conversion

rates for all types of currencies, including the EMU
currencies

• Entering foreign currency journals
• Running Revaluation
• Translating foreign currency balances
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R11i Using Multiple Reporting Currencies
(MRC)

R11i Using Multiple Reporting Currencies
(MRC)

Oracle General LedgerOracle General Ledger
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After completing this module, you should be able to:
• Explain the basic theory of MRC
• Describe the MRC life cycle, including:

– Planning for and preparing to implement MRC
– Setting up MRC
– Performing recurring MRC related activities in

General Ledger

After completing this module, you should be able to:
• Explain the basic theory of MRC
• Describe the MRC life cycle, including:

– Planning for and preparing to implement MRC
– Setting up MRC
– Performing recurring MRC related activities in

General Ledger
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AgendaAgenda

• Overview of MRC
• Understanding primary vs. reporting sets of books
• Converting at a transaction level
• Inquiring and reporting transactions and balances
• Working with the euro
• Determining your installation type
• Planning your MRC implementation
• Determining MRC starting dates
• Completing General Ledger setup steps
• Performing standard GL activities

• Overview of MRC
• Understanding primary vs. reporting sets of books
• Converting at a transaction level
• Inquiring and reporting transactions and balances
• Working with the euro
• Determining your installation type
• Planning your MRC implementation
• Determining MRC starting dates
• Completing General Ledger setup steps
• Performing standard GL activities
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• Inquiring and reporting transactions and balances
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• Overview of MRC
• Understanding primary vs. reporting sets of books
• Converting at a transaction level
• Inquiring and reporting transactions and balances
• Working with the euro
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• Planning your MRC implementation
• Determining MRC starting dates
• Completing General Ledger setup steps
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• What is MRC?
• Reporting balances and transactions in multiple

functional currencies
• Products supporting MRC
• When do you use MRC?

• What is MRC?
• Reporting balances and transactions in multiple

functional currencies
• Products supporting MRC
• When do you use MRC?
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• What is MRC?
• Reporting balances and transactions in multiple
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• When do you use MRC?

• What is MRC?
• Reporting balances and transactions in multiple

functional currencies
• Products supporting MRC
• When do you use MRC?
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What is MRC?What is MRC?

A set of unique features in Oracle Applications
that allow organizations to report and maintain
accounting records:
– at the transaction level
– in more than one functional currency

MRC benefits those organizations that must
routinely report their transactions and financial
results in multiple currencies, other than their
primary functional currency.

A set of unique features in Oracle Applications
that allow organizations to report and maintain
accounting records:
– at the transaction level
– in more than one functional currency

MRC benefits those organizations that must
routinely report their transactions and financial
results in multiple currencies, other than their
primary functional currency.
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Business SolutionsBusiness Solutions

• Transitioning to the euro
• Supporting operations in countries with highly

inflationary economies
• Supporting corporate exchange rates
• Reporting to management globally

• Transitioning to the euro
• Supporting operations in countries with highly

inflationary economies
• Supporting corporate exchange rates
• Reporting to management globally
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• What is MRC?
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• Products supporting MRC
• When do you use MRC?

• What is MRC?
• Reporting balances and transactions in multiple

functional currencies
• Products supporting MRC
• When do you use MRC?
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Reporting Balances and Transactions in
Multiple Functional Currencies

Reporting Balances and Transactions in
Multiple Functional Currencies

• Perform online inquiries and generate reports, with
GL account balances stated in reporting
currencies, without first translating primary
functional currency amounts

• Perform online inquiries and generate reports of
detail subledger transactions, with amounts stated
in reporting currencies (no translation necessary)

• Build custom FSG reports with amounts stated in
reporting currencies

• Consolidate subsidiary reporting currency
account balances to the parent set of books

• Perform online inquiries and generate reports, with
GL account balances stated in reporting
currencies, without first translating primary
functional currency amounts

• Perform online inquiries and generate reports of
detail subledger transactions, with amounts stated
in reporting currencies (no translation necessary)

• Build custom FSG reports with amounts stated in
reporting currencies

• Consolidate subsidiary reporting currency
account balances to the parent set of books
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• Products supporting MRC
• When do you use MRC?
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• Oracle General Ledger
• Oracle Receivables
• Oracle Payables
• Oracle Projects
• Oracle Assets
• Oracle Purchasing
• Oracle Global Accounting Engine

• Oracle General Ledger
• Oracle Receivables
• Oracle Payables
• Oracle Projects
• Oracle Assets
• Oracle Purchasing
• Oracle Global Accounting Engine
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functional currencies
• Products supporting MRC
• When do you use MRC?
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When Do You Use MRC?When Do You Use MRC?

• When your organization must regularly and
routinely support statutory and legal reporting of
both transactions and GL account balances in
multiple reporting currencies, other than the
primary functional currency

• When any of these conditions exist:
– operate in a country that is part of the

European Economic and Monetary Union
– operate in a country whose unstable currency

makes it unsuitable for managing your
business

– need to report in a common functional
currency other than the transaction currency
or your primary functional currency

• When your organization must regularly and
routinely support statutory and legal reporting of
both transactions and GL account balances in
multiple reporting currencies, other than the
primary functional currency

• When any of these conditions exist:
– operate in a country that is part of the

European Economic and Monetary Union
– operate in a country whose unstable currency

makes it unsuitable for managing your
business

– need to report in a common functional
currency other than the transaction currency
or your primary functional currency
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• Overview of MRC
• Understanding primary vs. reporting sets of books
• Converting at a transaction level
• Inquiring and reporting transactions and balances
• Working with the euro
• Determining your installation type
• Planning your MRC implementation
• Determining MRC starting dates
• Completing General Ledger setup steps
• Performing standard GL activities

• Overview of MRC
• Understanding primary vs. reporting sets of books
• Converting at a transaction level
• Inquiring and reporting transactions and balances
• Working with the euro
• Determining your installation type
• Planning your MRC implementation
• Determining MRC starting dates
• Completing General Ledger setup steps
• Performing standard GL activities
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Multiple Sets of Books
Primary and Reporting
Multiple Sets of Books
Primary and Reporting

• One primary set of books (PSOB)
– Uses your primary functional currency

• One or more reporting sets of books (RSOB)
– Each using a reporting functional currency
– Each assigned to the primary set of books

• One primary set of books (PSOB)
– Uses your primary functional currency

• One or more reporting sets of books (RSOB)
– Each using a reporting functional currency
– Each assigned to the primary set of books
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Transaction ProcessingTransaction Processing

Primary SetPrimary Set
of Booksof Books

ReportingReporting
Sets ofSets of
BooksBooks

MRC Conversion

Reporting and InquiryReporting and Inquiry
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Multiple Sets of BooksMultiple Sets of Books

Primary SOB

Account 
structure

Accounting 
calendar

Reporting sets of books share the same accountReporting sets of books share the same account
structure and accounting calendar as the primary setstructure and accounting calendar as the primary set

of books.of books.

dollar yen

euro pound
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Amounts are converted to reporting currencies:
• in subledgers, when transactions are entered
• in General Ledger, when journals are posted

Conversion:
• occurs automatically
• is made from the transaction currency to reporting

currency
• follows special requirements for euro and national

currency units (NCU) of EMU participating
countries

Amounts are converted to reporting currencies:
• in subledgers, when transactions are entered
• in General Ledger, when journals are posted

Conversion:
• occurs automatically
• is made from the transaction currency to reporting

currency
• follows special requirements for euro and national

currency units (NCU) of EMU participating
countries
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Inquiring and Reporting
Transactions and Balances

Inquiring and Reporting
Transactions and Balances

subledgerGL
Reporting Reporting 

Set of BooksSet of Books

Inquire onInquire on
InvoiceInvoice

Inquire onInquire on
Journal orJournal or
BalanceBalance

Amounts DisplayedAmounts Displayed
in Reporting Currencyin Reporting Currency
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Inquiring and Reporting
Transactions and Balances

Inquiring and Reporting
Transactions and Balances

subledgerGL
Reporting Reporting 

Set of BooksSet of Books

Run StandardRun Standard
ReportsReports

Amounts ShownAmounts Shown
in Reporting Currencyin Reporting Currency

Run StandardRun Standard
ReportsReports
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Inquiring and Reporting
Transactions and Balances

Inquiring and Reporting
Transactions and Balances

RSOBPSOB

Comparative Report Showing Primary CurrencyComparative Report Showing Primary Currency
Amounts vs. Reporting Currency AmountsAmounts vs. Reporting Currency Amounts

FSG
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Implementing MRC positions your organization to
begin converting to the euro at will and provides
these immediate benefits:
– dual visibility at the transaction level --

amounts expressed in euro or your national
currency unit (NCU)

– accounting in euro and NCU
– choice of reporting in euro or NCU
– first step to adopting the euro as your primary

functional currency (1-2-3 EFC)
– BASDA certified

Implementing MRC positions your organization to
begin converting to the euro at will and provides
these immediate benefits:
– dual visibility at the transaction level --

amounts expressed in euro or your national
currency unit (NCU)

– accounting in euro and NCU
– choice of reporting in euro or NCU
– first step to adopting the euro as your primary

functional currency (1-2-3 EFC)
– BASDA certified
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Working with the Euro:
Considerations

Working with the Euro:
Considerations

• Transactions upgrade utilities
• Euro migration utilities
• Transactions upgrade utilities
• Euro migration utilities
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Determining Your Installation TypeDetermining Your Installation Type

• Fresh Install — New customers who install Oracle
Applications for the first time and enable MRC

• Upgrade Scenario One — Existing customers who
enable MRC for new set of books or operating unit

• Upgrade Scenario Two — Existing customers who
enable MRC for an existing set of books or
operating unit with open and/or reversible
transactions in subledgers
Installation type determines your planning effort
and whether you need to run the transactions
upgrade utilities

• Fresh Install — New customers who install Oracle
Applications for the first time and enable MRC

• Upgrade Scenario One — Existing customers who
enable MRC for new set of books or operating unit

• Upgrade Scenario Two — Existing customers who
enable MRC for an existing set of books or
operating unit with open and/or reversible
transactions in subledgers
Installation type determines your planning effort
and whether you need to run the transactions
upgrade utilities
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Planning Your MRC ImplementationPlanning Your MRC Implementation

• Effort varies by installation type
– Fresh Install & Upgrade Scenario One:

moderate planning and preparation effort
– Upgrade scenario two:  extensive planning,

preparation, and coordination effort

• Important consideration for all installation types
– Choosing your MRC starting dates

• Effort varies by installation type
– Fresh Install & Upgrade Scenario One:

moderate planning and preparation effort
– Upgrade scenario two:  extensive planning,

preparation, and coordination effort

• Important consideration for all installation types
– Choosing your MRC starting dates
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• First MRC Date / First MRC Period
• From Date
• First MRC Date / First MRC Period
• From Date
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• The First MRC Date is the first day of the First
MRC Period.

• First MRC Period is:
– the first period for which you want to use MRC

to convert transactions to your reporting
currencies

– the period in which beginning account
balances are initialized in reporting sets of
books

• The First MRC Date is the first day of the First
MRC Period.

• First MRC Period is:
– the first period for which you want to use MRC

to convert transactions to your reporting
currencies

– the period in which beginning account
balances are initialized in reporting sets of
books
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First MRC Date/Period GuidelinesFirst MRC Date/Period Guidelines

• Consider choosing the first day of your fiscal year
since:
– all balance types are fully synchronized on this

date
– you won’t need to work with partial year

balances in reporting sets of books
• Should be first period of a quarter to ensure

correct QTD balances
• Choose first day of fiscal year if using average

balance processing in General Ledger
• (Upgrade Scenario Two)  First future-enterable

period, or first never-opened period in General
Ledger for the primary set of books

• Consider choosing the first day of your fiscal year
since:
– all balance types are fully synchronized on this

date
– you won’t need to work with partial year

balances in reporting sets of books
• Should be first period of a quarter to ensure

correct QTD balances
• Choose first day of fiscal year if using average

balance processing in General Ledger
• (Upgrade Scenario Two)  First future-enterable

period, or first never-opened period in General
Ledger for the primary set of books
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From DateFrom Date

• The first date for which MRC will start converting
new transactions to reporting currencies

• MRC compares the From Date to the transaction
date for GL, AP, and AR.

If From Date  <=  Trx Date then Convert
• MRC compares the From Date to the entered date

for Purchasing.
If From Date  <=  Entered Date then Convert

• Set manually for GL, AP, AR, and Purchasing
• Set automatically for Assets and Projects (No

comparison made -- MRC either “on” or “off”)

• The first date for which MRC will start converting
new transactions to reporting currencies

• MRC compares the From Date to the transaction
date for GL, AP, and AR.

If From Date  <=  Trx Date then Convert
• MRC compares the From Date to the entered date

for Purchasing.
If From Date  <=  Entered Date then Convert

• Set manually for GL, AP, AR, and Purchasing
• Set automatically for Assets and Projects (No

comparison made -- MRC either “on” or “off”)



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Using Multiple Reporting Currencies (MRC)
Chapter 25 - Page 38

Agenda

Copyright © Oracle Corporation, 2001. All rights reserved.
®

AgendaAgenda

• Overview of MRC
• Understanding primary vs. reporting sets of books
• Converting at a transaction level
• Inquiring and reporting transactions and balances
• Working with the euro
• Determining your installation type
• Planning your MRC implementation
• Determining MRC starting dates
• Completing General Ledger setup steps
• Performing standard GL activities

• Overview of MRC
• Understanding primary vs. reporting sets of books
• Converting at a transaction level
• Inquiring and reporting transactions and balances
• Working with the euro
• Determining your installation type
• Planning your MRC implementation
• Determining MRC starting dates
• Completing General Ledger setup steps
• Performing standard GL activities
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Completing GL Setup StepsCompleting GL Setup Steps

• Step 1: Enable or define primary set of books
(PSOB)

• Step 2: Enable and/or define reporting currencies
• Step 3: Define reporting sets of books (RSOB)
• Step 4: Assign RSOB to PSOB
• Step 5: Define conversion options for each

application
• Step 6: Define GL conversion rules
• Step 7: Define reporting responsibilities
• Step 8: Assign RSOB to reporting responsibilities

• Step 1: Enable or define primary set of books
(PSOB)

• Step 2: Enable and/or define reporting currencies
• Step 3: Define reporting sets of books (RSOB)
• Step 4: Assign RSOB to PSOB
• Step 5: Define conversion options for each

application
• Step 6: Define GL conversion rules
• Step 7: Define reporting responsibilities
• Step 8: Assign RSOB to reporting responsibilities
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Completing GL Setup StepsCompleting GL Setup Steps

• Step 9: Open initial period in RSOB
• Step 10: Initialize account balances in new PSOB

– Journal Import is recommended method
– Use automatic posting
– Journal source and category used for Journal

Import should be included in your GL
Conversion Rules (Step 6)

• Step 11: Open the First MRC Period in all sets of
books

• Step 9: Open initial period in RSOB
• Step 10: Initialize account balances in new PSOB

– Journal Import is recommended method
– Use automatic posting
– Journal source and category used for Journal

Import should be included in your GL
Conversion Rules (Step 6)

• Step 11: Open the First MRC Period in all sets of
books
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• Overview of MRC
• Understanding primary vs. reporting sets of books
• Converting at a transaction level
• Inquiring and reporting transactions and balances
• Working with the euro
• Determining your installation type
• Planning your MRC implementation
• Determining MRC starting dates
• Completing General Ledger setup steps
• Performing standard GL activities

• Overview of MRC
• Understanding primary vs. reporting sets of books
• Converting at a transaction level
• Inquiring and reporting transactions and balances
• Working with the euro
• Determining your installation type
• Planning your MRC implementation
• Determining MRC starting dates
• Completing General Ledger setup steps
• Performing standard GL activities
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Performing Standard GL ActivitiesPerforming Standard GL Activities

• Opening periods
• Entering and posting journals
• Reversing journals
• Approving journals
• Performing account inquiries in reporting sets of

books
• Sequence numbers
• Entering budgets
• Encumbrances and Budgetary Control

• Opening periods
• Entering and posting journals
• Reversing journals
• Approving journals
• Performing account inquiries in reporting sets of

books
• Sequence numbers
• Entering budgets
• Encumbrances and Budgetary Control



Copyright © Oracle Corporation, 2000. All rights reserved.

R11i Using Multiple Reporting Currencies (MRC)
Chapter 25 - Page 43

Performing Standard GL Activities

Copyright © Oracle Corporation, 2001. All rights reserved.
®

Performing Standard GL ActivitiesPerforming Standard GL Activities

• Revaluation
• Translation and Consolidation
• Mass Maintenance

It is important that you complete MRC-related
activities in the correct order, for:
– Period-begin tasks
– Day-to-day tasks
– Period-end tasks

• Revaluation
• Translation and Consolidation
• Mass Maintenance

It is important that you complete MRC-related
activities in the correct order, for:
– Period-begin tasks
– Day-to-day tasks
– Period-end tasks
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SummarySummary

In this course, you should have learned how to:
• Explain the basic theory of MRC
• Describe the MRC life cycle, including:

– Planning for and preparing to implement MRC
– Setting up MRC
– Performing recurring MRC related activities in

General Ledger

In this course, you should have learned how to:
• Explain the basic theory of MRC
• Describe the MRC life cycle, including:

– Planning for and preparing to implement MRC
– Setting up MRC
– Performing recurring MRC related activities in

General Ledger
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